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PREFACE 
 
The Volpe National Transportation Systems Center (Volpe Center) of the United States 
Department of Transportation’s Research and Innovative Technology Administration has 
developed a modeling system to assist the National Highway Traffic Safety Administration 
(NHTSA) in the evaluation of potential new Corporate Average Fuel Economy (CAFE) 
standards.  Given externally-developed inputs, the modeling system estimates how 
manufacturers could apply additional fuel-saving technologies in response to new CAFE 
standards, and estimates how doing so would, relative to a given baseline scenario, increase 
vehicle costs, reduce national fuel consumption and carbon dioxide emissions, and result in other 
effects and benefits to society.  The modeling system can also be used to estimate the stringency 
at which an attribute-based CAFE standard satisfies various criteria.  For example, the system 
can estimate the stringency that produces a specified average required fuel economy level, or that 
maximizes net benefits to society. 
 
This report documents the design and function of the CAFE Model as of March 16, 2015; 
specifies the content, structure, and meaning of inputs and outputs; and provides instructions for 
the installation and use of the modeling system. 
 
The authors of this report are Mark Shaulov, Kevin Green, Ryan Harrington, Joe Mergel, Donald 
Pickrell, Ryan Keefe, and John Van Schalkwyk. 
 
The authors acknowledge the technical contributions of individuals who have been involved in 
guiding recent changes to the modeling system, including Ken Katz, Gregory Powell, Jim 
Tamm, and Lixin Zhao of NHTSA.  The authors further acknowledge former DOT staff who 
participated in the development of earlier versions of the modeling system, including Gregory 
Ayres, Phil Gorney, Kristina Lopez-Bernal, José Mantilla, Arthur Rypinski, and Kenneth 
William. 
 
The authors further acknowledge the technical contributions of individuals who have reviewed 
detailed results of the model (and/or earlier versions of the model) and/or provided specific 
suggestions regarding the model’s design.  Among these individuals are Steve Plotkin and 
Michael Wang of the Department of Energy’s Argonne National Laboratory, Jeff Alson, William 
Charmley, Ben Ellies, David Haugen, Ari Kahan, Richard Rykowski, and Todd Sherwood of the 
U.S. Environmental Protection Agency (EPA), Gary Rogers of FEV Engine Technology, Inc., 
David Boggs, Anrico Casadei, Scott Ellsworth, and Sandy Stojkovski of Ricardo, Inc., Jamie 
Hulan of Transport Canada, and Jonathan Rubin of the University of Maine. 
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Chapter One Introduction 
 
The Energy Policy and Conservation Act (EPCA), as amended by the Energy Independence and 
Security Act of 2007 (EISA), requires the National Highway Traffic Safety Administration 
(NHTSA), an agency within the U.S. Department of Transportation (DOT), to promulgate and 
enforce Corporate Average Fuel Economy (CAFE) standards. NHTSA has been administering 
these standards since 1975. 
 
The Volpe National Transportation Systems Center (Volpe Center) provided technical support to 
the Department in connection with the establishment of the CAFE program in the 1970s, and has 
continued to provide such support since that time. The Volpe Center is a Federal fee-for-service 
organization within DOT's Research and Innovative Technology Administration (RITA). 
 
In 2002, the Volpe Center began developing a new modeling system to support NHTSA’s 
analysis of options for future CAFE standards. Objectives included, but were not limited to, the 
following: the ability to utilize detailed projections of light vehicle fleets to be produced for sale 
in the United States, the ability to efficiently estimate how manufacturers could apply available 
technologies in response to CAFE standards, the ability to quickly evaluate various options for 
future CAFE standards, and the ability to estimate a range of outcomes (in particular, changes in 
fuel consumption and emissions) resulting from such standards. 
 
Since 2002, the Volpe Center has made many changes to this modeling system. Some changes 
were made in response to comments submitted to NHTSA in connection with CAFE 
rulemakings, and in response to a formal peer review of the system. Some changes were made 
based on observations by NHTSA and Volpe Center technical staff. As NHTSA began 
evaluating attribute-based CAFE standards (i.e., standards under which CAFE requirements 
depend on the mix of vehicles produced for U.S. sale), significant changes were made to enable 
evaluation of such standards. At the same time, the system was expanded to provide the ability to 
perform uncertainty analysis by randomly varying many inputs. Later, the system was further 
expanded to provide automated statistical calibration of attribute-based standards, through 
implementation of Monte Carlo techniques, as well as automated estimation of stringency levels 
that meet specified characteristics (such as maximizing estimated net benefits to society). In 
2007, NHTSA and Volpe Center staff worked with technical staff of the U.S. Environmental 
Protection Agency (EPA) on major changes to the range of fuel-saving technologies 
accommodated by the model, as well as the logical pathways for applying such technologies.  In 
2008, NHTSA and Volpe Center staff collaborated on further revisions, particularly with respect 
to the representation of available fuel-saving technologies, support for the reexamination of 
which was provided by Ricardo, Inc. 
 
In support of the 2010 rulemaking, a multi-year technology application feature was introduced 
into the modeling system.  Additionally, for the 2011 rulemaking, a feature to evaluate voluntary 
overcompliance has been added as well. 
 
In 2014, the system was adapted and expanded to allow NHTSA and Volpe Center staff to 
perform analysis in support of the medium duty rulemaking. As such, a new regulatory class, 
covering class 2b and class 3 pickups and vans, was introduced into the modeling system. 
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Although the revised model is capable of evaluating regulatory classes from prior modeling 
systems, the current revision is best suited for the medium duty analysis. Furthermore, to better 
illustrate the behavior of the industry, a feature allowing technologies to be inherited between 
vehicle platforms, engines, and transmissions has been reintroduced into the modeling system as 
the primary mode of operation. 
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Chapter Two System Design 
 
Section 1 Overall Structure 
 
The basic design of the CAFE Model developed by the Volpe Center is as follows: The system 
first estimates how manufacturers might respond to a given CAFE scenario, and from that the 
system estimates what impact that response will have on fuel consumption, emissions, and 
economic externalities. A CAFE scenario involves specification of the form, or shape, of the 
standards (e.g., flat standards, linear or logistic attribute-based standards, scope of passenger and 
nonpassenger regulatory classes), and stringency of the CAFE standard in each model year to be 
analyzed. 
 
Manufacturer compliance simulation and effects estimation encompass numerous subsidiary 
elements. Compliance simulation begins with a detailed initial forecast, provided by the user, of 
the vehicle models offered for sale during the simulation period. The compliance simulation then 
attempts to bring each manufacturer into compliance with CAFE standards defined in an input 
file developed by the user; for example, CAFE standards that increase in stringency by 4 percent 
per year for 5 consecutive years, and so forth. The model sequentially applies various 
technologies to different vehicle models in each manufacturer’s product line in order to simulate 
how a manufacturer might make progress toward compliance with CAFE standards. Subject to a 
variety of user-controlled constraints, the model applies technologies based on their relative cost-
effectiveness, as determined by several input assumptions regarding the cost and effectiveness of 
each technology, the cost of CAFE-related civil penalties, and the value of avoided fuel 
expenses. For a given manufacturer, the compliance simulation algorithm applies technologies 
either until the manufacturer achieves compliance, or until the manufacturer exhausts all 
available technologies, or, if the manufacturer is assumed to be willing to pay civil penalties, 
until paying civil penalties becomes more cost-effective than increasing vehicle fuel economy. 
The user may disable the civil penalty paying option for manufacturers expected to be unwilling 
to pay them, thus effectively “forcing” the manufacturer to add additional technology even once 
it might otherwise be preferable to pay penalties (considering the cost to add further technology 
as compared to the estimated value of the resultant saved fuel). At this stage, the system assigns 
an incurred technology cost and updated fuel economy to each vehicle model, as well as any 
civil penalties incurred by each manufacturer. 
 
This point marks the system’s transition between compliance simulation and effects calculations. 
At the conclusion of the compliance simulation for a given model year, the system contains a 
new fleet of vehicles with new prices, fuel types (e.g., diesel, electricity), fuel economy values, 
and curb weights that have all been updated to reflect the application of technologies in response 
to CAFE requirements. For each vehicle model in this fleet, the system then estimates the 
following: lifetime travel, fuel consumption, and carbon dioxide and criteria pollutant emissions. 
After aggregating model-specific results, the system estimates the magnitude of various 
economic externalities related to vehicular travel (e.g., noise) and energy consumption (e.g., the 
economic costs of short-term increases in petroleum prices). 
 
Different categorization schemes are relevant to different types of effects. For example, while a 
fully disaggregated fleet is retained for purposes of compliance simulation, vehicles are grouped 
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by type of fuel and regulatory or vehicle class for the energy, carbon dioxide, criteria pollutant, 
and fatalities calculations. The system may be expanded in the future to represent CAFE-induced 
market responses (i.e., mix shifting), in which case such calculations would group vehicles by 
market segment.  Therefore, this system uses model-by-model categorization and accounting 
when calculating most effects, and aggregates results only as required for efficient reporting. 
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Section 2 CAFE Compliance Simulation 
 
S2.1 Compliance Simulation Algorithm 
 
Each time the modeling system is used, it evaluates one or more CAFE scenarios. Each of these 
scenarios is defined in the “scenarios” input file described in Section A.4 of Appendix A. Each 
scenario describes an overall CAFE program in terms of the program’s coverage, applicability of 
multi-fuel vehicles, the structure and stringency of the standards applicable to passenger and 
nonpassenger automobiles, as well as other miscellaneous settings that may have an impact on 
compliance. The system is normally used to examine and compare at least two scenarios. The 
first scenario is identified as the baseline scenario, usually defined as the world in the absence of 
new CAFE standards (which itself can be considered in a variety of ways), providing results to 
which results for any other scenarios are compared. Although many scenarios can be examined 
with each run of the model, for simplicity in this overview, we will only describe one scenario 
occurring in one model year. 
 
The compliance simulation applies technology to each manufacturer’s product line based on the 
CAFE program described by the current scenario and the assumed willingness of each 
manufacturer to pay civil penalties rather than complying with the program. The first step in this 
process involves definition of the fleet’s initial state—that is, the volumes, prices, and attributes 
of all vehicles as projected without knowledge of future CAFE standards—during the study 
period, which can cover one or more consecutive model years (MYs). The second step involves 
evaluating the applicability of each available technology to each vehicle model, engine, and 
transmission in the fleet. The third and final step involves the repeated application of 
technologies to specific vehicle models, engines, and transmissions in each manufacturer’s fleet. 
For a given manufacturer, this step terminates when CAFE standards have been achieved or all 
available technologies have been exhausted. Alternatively, if the user specifies that some or all 
manufacturers should be considered willing to pay civil penalties for noncompliance, this step 
terminates when it would be less expensive to pay such penalties than to continue applying 
technology. Furthermore, if the system has been configured to evaluate voluntary 
overcompliance, this step would not terminate until all cost-effective solutions, for all 
manufacturers, were applied, beyond what is necessary to meet the CAFE standard. 
 
S2.1.1 Initial State of the Fleet 
 
The fleet’s initial state is developed using information contained in the vehicle models, engine, 
and transmission worksheets described in Section A.1 of Appendix A. The set of worksheets 
uses identification codes to link vehicle models to appropriate engines and transmissions.  Figure 
1 provides a simplified example illustrating the basic structure and interrelationship of these 
three worksheets, focusing primarily on structurally important inputs. These identification codes 
make it possible to account for the use of specific engines or transmissions across multiple 
vehicle models. They also help the compliance simulation algorithm to realistically “carry over” 
technologies between model years. 
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Figure 1. Basic Structure of Input File Defining the Fleet’s Initial State 

MY11 MY12 MY11 MY12

1 Veh1 20.95 11,516 10,963 27,500 28,875 1 2

2 Veh2 21.78 93,383 97,767 23,000 24,150 1 3

3 Veh3 18.33 46,880 49,367 31,250 32,813 2 4

4 Veh4 22.02 65,054 68,505 24,250 25,463 3 3

5 Veh5 18.51 21,843 25,838 31,500 33,075 4 4

1 Eng1 G 6 3.5 2

2 Eng2 G 8 4 2

3 Eng3 G 6 3.5 4

4 Eng4 G 8 4 4

1 M5 C 5 M

2 A4 T 4 A

3 A5 T 5 A

4 A6 T 6 A

Engine Worksheet

Trn
ID

Name Type Gears Control

Transmission Worksheet

Name
Eng
ID

Valves per
Cylinder

DisplacementCylFuel

Veh
ID

Sales MSRP

Vehicle Models Worksheet

Transmission
Code

Engine
Code

FEModel
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S2.2 Vehicle Technology Application within the CAFE Model 
 
Vehicle technologies are a set of possible improvements available for the vehicle fleet. The 
vehicle technologies, referred to below simply as ‘technologies’, are defined by the user in the 
technology input file for the model (see Section A.2 in Appendix A). As a part of the definition 
for each technology there is an associated cost for the technology, an improvement factor (in 
terms of percent reduction of fuel consumption), the introduction year for the technology, 
whether it is applicable to a given class of vehicle, grouping (by technology group – engine, 
transmission, etc.), and phase-in parameters (the amount of fleet penetration allowed in a given 
year). Also defined in the technology inputs file are cost and improvement synergies. 
 
Having defined the fleet’s initial state, the system applies technologies to each manufacturer’s 
fleet based on the CAFE program for the current model year. The set of technologies 
accommodated by the model is discussed in the Preliminary Regulatory Impact Analysis (PRIA) 
for the 2021-2025 Notice of Proposed Rulemaking (NPRM) regarding CAFE standards for class 
2b/3 trucks produced for sale in the United States in model years 2021-20251. 
 
As discussed in the PRIA, the set of technologies, and the methods for considering their 
application, include those discussed in the 2017-2025 final rule documentation2, albeit with 
updated fuel efficiency effectiveness estimates, as well as newly defined technologies for the 
2021-2025 timeframe.  The technologies discussed in 2012-2016 final rule were based on a 2002 
National Academy of Sciences report.3  That study estimated that the applicability of different 
technologies would vary based on vehicle type. Since the publication of the 2002 NAS study, 
NHTSA and EPA have agreed on technology-related estimates extending through MY2025, 
based on a range of newer studies and research, and NHTSA has developed corresponding inputs 
for use in the CAFE model.  The development of these technology estimates is discussed in the 
preamble to the proposed rule, and in the supporting technical support document and regulatory 
impact analysis.  Although the model now represents a wider range of technologies than the 2002 
NAS study, and uses different logical sequences for considering their addition to manufacturers’ 
fleets, the model retains the ability for differentiation based on vehicle type. 
 
  

                                                 
1 Available at http://www.nhtsa.gov/fuel-economy. 
2 75 FR 25324 (May 7, 2010). 
3 National Research Council, ‘‘Effectiveness and Impact of Corporate Average Fuel Economy (CAFE) Standards,’’ 
National Academy Press, Washington, DC (2002).  Available at 
http://www.nap.edu/openbook.php?isbn=0309076013 (last accessed Nov. 13, 2011). 
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S2.2.1 Vehicle Technology Class 
 
The CAFE model uses fourteen technology classes as shown in Table 1: 
 

Table 1. CAFE Technology Vehicle Classes 
Class Description 
Subcompact PC Subcompact passenger car. 
Subcompact Perf PC Subcompact performance oriented passenger car 
Compact PC Compact passenger car 
Compact Perf PC Compact performance oriented passenger car 
Midsize PC Midsized passenger car 
Midsize Perf PC Midsized performance oriented passenger car 
Large PC Large passenger car 
Large Perf PC Large performance oriented passenger car 
Minivan LT Minivans 
Small LT Small sport utility vehicles and pickups 
Midsize LT Midsize sport utility vehicles and pickups 
Large LT Large sport utility vehicles and pickups 
Truck 2b/3 Class 2b and class 3 pickups 
Van 2b/3 Class 2b and class 3 cargo vans 

 
S2.2.2 Technology Groups 
 
The CAFE Model organizes technologies into groups, which allows the model to seek the next 
“best” technology application in any of these groups.4 There are eight technology groups 
defined: engine, diesel engine, transmission, electrical accessory, mass reduction, low rolling 
resistance tires, dynamic load reduction, and aerodynamic load reduction. The table below lists 
the technologies represented by the system, and the grouping we have applied to enable the 
system to follow a logical incremental path within any given group without being unnecessarily 
prevented from considering technologies in other groups. This “parallel path” approach is 
discussed below. 
 

Table 2. Technology Group Assignments 
Technology Group Group Members5

Vehicle Engine 
Technology Group 
(EngMod) 

Low Friction Lubricants - Level 1 (LUB1) 
Engine Friction Reduction - Level 1 (EFR1) 
Low Friction Lubricants and Engine Friction Reduction - Level 2 (LUB2_EFR2) 
Variable Valve Timing (VVT) 

 VVT - Coupled Cam Phasing on SOHC (CCPS) 
 VVT - Intake Cam Phasing (ICP) 
 VVT - Dual Cam Phasing (DCP) 

                                                 
4 Within the context of the compliance simulation, “best” is defined from the manufacturers’ perspective.  The 
system assumes that the manufacturer will seek to progress through the technology decision trees in a manner that 
minimizes effective costs, which include (a) vehicle price increases associated with added technologies, (b) 
reductions in civil penalties owed for noncompliance with CAFE standards, and (c) the value vehicle purchasers are 
estimated to place on fuel economy. 
5 Some technologies were evaluated during the initial development of the modeling system; however, they were later 
excluded from analysis. These technologies appear grayed out in the table. Additionally, technologies from previous 
rulemakings, which are represented within the system, but not applicable to this analysis, are grayed out as well. 
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Cylinder Deactivation 
 Cylinder Deactivation on SOHC (DEACS) 
 Cylinder Deactivation on DOHC (DEACD) 
 Cylinder Deactivation on OHV (DEACO) 

Variable Valve Lift & Timing 
 Discrete Variable Valve Lift (DVVL) on SOHC (DVVLS) 
 Discrete Variable Valve Lift (DVVL) on DOHC (DVVLD) 
 Continuously Variable Valve Lift (CVVL) (CVVL) 
 Variable Valve Actuation - CCP and DVVL on OHV (VVA) 

Stoichiometric Gasoline Direct Injection (GDI) (SGDI) 
Stoichiometric Gasoline Direct Injection (GDI) on OHV (SGDIO) 
Turbocharging and Downsizing - Level 1 (18 bar BMEP) (TRBDS1) 
Stoichiometric Exhaust Gas Recirculation (SEGR) 
Downspeeding (DWNSP) 
Turbocharging and Downsizing - Level 2 (24 bar BMEP) (TRBDS2) 
Cooled Exhaust Gas Recirculation (EGR) - Level 1 (24 bar BMEP) (CEGR1) 

  
Cooled Exhaust Gas Recirculation (EGR) - Level 2 (27 bar BMEP) (CEGR2) 
Miller Cycle (MILLER) 
Lean Burn GDI (LGDI) 
CNG (CNG) 
LNG (LNG) 
LPG (LPG) 

  
Vehicle Diesel Engine 
Technology Group 
(DslMod) 

Diesel (DSL) 
Diesel Turbo Efficiency (DTURB) 
Diesel Engine Friction Reduction (EFRD) 
Diesel Downsizing (DDOWN) 

Vehicle Transmission 
Technology Group 
(TrMod) 

6-Speed Manual/Improved Internals (6MAN) 
High Efficiency Gearbox (Manual) (HETRANSM) 
Improved Auto. Trans. Controls/Externals (IATC) 
6-Speed Trans with Improved Internals (NAUTO) 
6-speed Dual Clutch Transmission (DCT) 
8-Speed Trans (Auto or DCT) (8SPD) 
High Efficiency Gearbox (Auto or DCT) (HETRANS) 
Shift Optimizer (SHFTOPT) 

Electrical Accessory 
Technology Group 
(ELEC) 
Includes Hybrid Technologies 

Electric Power Steering (EPS) 
Improved Accessories - Level 1 (IACC1) 
Improved Accessories - Level 2 (IACC2) 
12V Micro-Hybrid (MHEV) 
Integrated Starter Generator (ISG) 
Strong Hybrid - Level 1 (SHEV1) 
Conversion from SHEV1 to SHEV2 (SHEV1_2) 
Strong Hybrid - Level 2 (SHEV2) 
Plug-in Hybrid - 30 mi range (PHEV1) 
Plug-in Hybrid (PHEV2) 
Electric Vehicle (Early Adopter) - 75 mile range (EV1) 
Electric Vehicle (Early Adopter) - 100 mile range (EV2) 
Electric Vehicle (Early Adopter) - 150 mile range (EV3) 
Electric Vehicle (Broad Market) - 150 mile range (EV4) 
Fuel Cell Vehicle (FCV) 

Mass Reduction 
Technology Group 
(MSM) 

Mass Reduction - Level 1 (MR1) 
Mass Reduction - Level 2 (MR2) 
Mass Reduction - Level 3 (MR3) 
Mass Reduction - Level 4 (MR4) 
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Mass Reduction - Level 5 (MR5) 
Low Rolling Resistance Tires 
Technology Group 
(ROLL) 

Low Rolling Resistance Tires - Level 1 (ROLL1) 
Low Rolling Resistance Tires - Level 2 (ROLL2) 
Low Rolling Resistance Tires - Level 3 (ROLL3) 

Dynamic Load Reduction 
Technology Group 
(DLR) 

Low Drag Brakes (LDB) 
Secondary Axle Disconnect (SAX) 

Aerodynamic Reduction 
Technology Group 
(AERO) 

Aero Drag Reduction, Level 1 (AERO1) 
Aero Drag Reduction, Level 2 (AERO2) 

 
Input estimates for each of these technologies are specified in the technologies input file, and are 
specific to each of the CAFE technology vehicle classes, as shown in the following table. Table 3 
lists some of the key input assumptions specified in this file7. 
 

Table 3. Technology Input Assumptions 
Input Definition 
Applicable If the technology is available for applicability. 
Year Available/Retired First and last model year the technology is available for applicability. 

Technology Type 
Technology group of which the technology is a member, as shown in Table 2 
above. 

FC Fuel consumption improvement estimate of the technology. 
  

Primary Fuel Share 
Assumed percentage of miles driven by the vehicle on the primary fuel after 
being converted to a PHEV. 

Off-Cycle Credit PC 
Amount of off-cycle credit that the vehicles regulated as passenger automobiles 
incur as a result of applying the technology. 

Off-Cycle Credit LT 
Amount of off-cycle credit that the vehicles regulated as light trucks incur as a 
result of applying the technology. 

Cost Table Fully learned-out table of costs by model year8 (in 2009 dollars). 
Delta Weight (%) Percentage by which the vehicle's weight changes after technology is applied. 

 
Among other things, the technology input assumptions define applicability, cost, fuel 
consumption reduction factors, as well as the technology group of which the technology is a 
member. 
 
S2.2.3 Technology Availability 
 
The technology input assumptions provide two methods of defining technology availability. 
First, the Applicability field determines whether the technology is generally available for 
application on a particular class of vehicle. If this field is set to TRUE, the technology may be 
considered for application by the modeling system; otherwise, the technology will be 
unavailable. 
 
If Applicability is set to TRUE, the Year Available and Year Retired fields from the input 
assumptions are further considered in determining the technology’s availability. Together, these 

                                                 
7 Additional technology assumptions are further discussed in Section A.2 of Appendix A. 
8 Because mass reduction is applied as a percentage of curb weight, the corresponding cost estimates are in dollars 
per pound of incremental change in curb weight. 
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two fields define a range of model years during which the technology may be applied. If the year 
being evaluated by the CAFE Model is prior to the setting in the Year Available field or after the 
Year Retired field, then the technology will be unavailable for the particular class of vehicle. 
 
Besides those mentioned, additional technology applicability factors are considered by the 
modeling system. For example, there are controls for individual vehicles, engines, or 
transmissions in the market data file that can override the controls here (see Sections A.1.2, 
A.1.3, and A.1.4 in Appendix A). There are also dynamic considerations made while the model 
is running based on vehicle configuration (e.g., cylinder deactivation is not applied to vehicles 
with manual transmissions), as well as technology combination factors (e.g., DVVLD is 
incompatible with CVVL). Additionally, technology phase-in caps may limit the availability of 
technologies if a particular penetration rate is reached for a vehicle’s manufacturer. 
 
S2.2.4 Technology Fuel Consumption Reduction Factors 
 
The technology input assumptions define the fuel consumption reduction factor FC. The FC 
value is defined on a gallons-per-mile basis and represents a percent reduction in fuel 
consumption. The formula to find the increase in fuel economy (miles-per-gallon) of a vehicle 
with fuel consumption reduction factors from one or more technologies is: 
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  (1) 

 
where FEorig is the original fuel economy for the vehicle, FCReduction0,1,…n are the fuel 
consumption reduction factors attributed to 0-th to n-th technologies, and FEnew is the resulting 
fuel economy for the same vehicle. 
 
For some technologies, the modeling system converts a vehicle or a vehicle’s engine from 
operating on one type of fuel to another. For example, application of Compressed Natural Gas 
(CNG) technology converts a vehicle from gasoline operation to CNG operation. In such a case, 
the aforementioned equation still applies, however, the FEnew value is assigned to the vehicle’s 
new fuel type, while the fuel economy on the original fuel is discarded. 
 
Moreover, whenever the modeling system converts a vehicle model to a Plug-In Hybrid/Electric 
Vehicle (PHEV), that vehicle is assumed to operate simultaneously on its primary fuel (either 
gasoline or diesel) as well as on electricity. In this case, the FC field only influences the 
conversion from primary fuel to electricity, where the FEnew value is assigned to vehicle’s fuel 
economy on electricity, while the fuel economy on the primary fuel remains unchanged.9 For 
PHEVs, the Primary Fuel Share field specifies the assumed amount of miles driven by the 
vehicle in gasoline-only or diesel-only operation. The vehicle’s overall rated fuel economy is 

                                                 
9 When being converted to a Plug-In Hybrid, the vehicle’s fuel economy while operating on gasoline may 
potentially increase due to improvements in regenerative breaking associated with a bigger battery. Presently, 
however, the modeling system assumes that no such improvement exist. 
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then defined as the average of the fuel economy on its primary fuel and the fuel economy on 
electricity, weighted by the fuel shares.10 
 
When the system further improves the vehicle, converting it from a PHEV to a pure electric 
vehicle (EV), the primary fuel component is removed, while the electric-operated portion 
remains. As such, given the PHEV’s significantly higher fuel economy on electricity, the 
vehicle’s overall fuel economy for an EV also increases. For this reason, the fuel consumption 
improvement for EV technology should typically be set at zero. Otherwise, the FC field should 
represent the additional improvements to the electric motor. 
 
Lastly, for non-liquid fuel types, such as CNG and electricity, the FC improvement and the 
resulting FEnew are assumed to be specified in gasoline gallon equivalents of energy use. 
 
S2.2.5 Technology Cost Tables 
 
The technology input assumptions provide a fully “learned-out” table of year-by-year technology 
costs, as specified by the Cost Table field. 
 
Some technology costs have a cost basis associated with them. For instance, for mass reduction 
technologies, the technology input costs must be multiplied by the reduction of vehicle curb 
weight, in pounds, to get the full cost of applying the technology. Similarly some engine 
technologies have costs determined on a per-cylinder or per-bank (configuration) basis. The 
cylinder-based technologies include EFR1, LUB2_EFR2, DVVLS, DVVLD, CVVL, SGDI, and 
SGDIO; while the configuration-based technologies include CCPS, ICP, DCP, and VVA. 
 
Along with the base Cost Table, the input assumptions also define the Maintenance Cost Table 
and the Repair Cost Table. Both of these tables are specified for each model year and account for 
the learning effect, wherever applicable. The former identifies the changes in the amount buyers 
are expected to pay for maintaining a new vehicle11, while the latter identifies the increases in 
non-warranty repair costs attributed to application of additional technology. Additionally, the 
input assumptions include the Stranded Capital Table, which associates a penalty cost for each 
technology that is replaced (or superseded) prior to fully amortizing the initial investment 
associated with that technology. 
 
Further discussion of the technology cost input assumptions can be found in Section A.2 of 
Appendix A. 
 
S2.2.6 Technology Synergies 
 

                                                 
10 The overall fuel economy for PHEVs is the rated value achieved by the vehicle assuming on-road operation 
specified by the Primary Fuel Share field. For compliance purposes, the vehicle’s overall fuel economy is 
determined by the Multi-Fuel and the PHEV Share parameters defined in the scenarios input file. The scenarios 
input file is further discussed in Section A.4 of Appendix A. 
11 The maintenance costs may lead to increases in cost to consumers, such as for advanced diesel engines, or in cost 
saving to consumers, such as for of electric vehicles.  In the case of electric vehicles, the cost savings result from 
avoiding traditional vehicle maintenance such as engine oil changes. 
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Technology synergies exist when the combination of two technologies yields a fuel consumption 
reduction which differs from the value that would be derived directly from equation (1). The 
synergy value may be positive (i.e., increased reduction of fuel consumption) or negative 
(decreased reduction of fuel consumption). Along with the fuel consumption synergies, the 
modeling system also defines cost synergies to ensure correct cost accounting as it proceeds 
down the decision trees. In both cases, synergies are additive and are applied prior to evaluating 
the combined effect of multiple technologies. 
 
The technology input assumptions provide separate tables for fuel consumption synergies and for 
cost synergies. In both tables, each new row defines a synergy relationship between two 
technologies, for each of the technology classes specified in Table 1. In some cases, a synergy 
relationship may apply to one technology class, but not to the other. When this occurs, a value of 
zero is used to indicate that no synergy exists for the specific class. 
 
The layout of the synergy table in the technology input file is further discussed in Section A.2.1 
of Appendix A. 
 
S2.2.7 Technology Applicability and Backfill 
 
The modeling system determines the applicability of each technology to each vehicle model, 
engine, and transmission using the combination of technology input assumptions as well as the 
technology applicability settings defined for each vehicle, engine and transmission in the market 
data file. As discussed in Section S2.2.3 above, the technology input assumptions determine the 
general availability of a technology to a particular class of vehicles, while the applicability 
setting in the market data file determines if the technology is available for application on a 
specific vehicle model.12 Since the modeling system relies heavily on the technology 
applicability settings, these sections must accurately and completely represent the initial state of 
each vehicle, engine, and transmission in order to avoid potential modeling errors. 
 
In some cases, technologies may be bypassed because they are not cost-effective. If the modeling 
system applies a technology that resides later in the sequence, it will ‘backfill’ anything that was 
previously skipped in order to fully account for technology costs and improvements, each of 
which are specified on an incremental basis. This backfill, however, will not occur if a 
technology is not applicable to the vehicle. In the case where the backfill operation requires 
backtracking through branches in the sequence, the modeling system will first resolve any 
engineering constraints and limitations, as well as applicability issues to determine whether the 
branch still exists. If there is still a branch, the system will follow the technology path that would 
result in lower overall costs.13 
 
 

                                                 
12 The technology applicability section is described in Sections A.1.2, A.1.3, and A.1.4 of Appendix A. 
13 Given the complexity associated with having to evaluate the effectiveness of backfilled branches (due to its 
recursive nature), and considering the extremely rare situations where such branches occur, the modeling system 
does not attempt to evaluate the full cost-effectiveness of a technology for the purposes of picking a backfill path.  
Instead, the system simply determines the path to follow based on lower costs.  However, once a backfill path is 
chosen, the model does evaluate the full cost-effectiveness of all technologies in that path. 
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S2.2.8 Application of Mass Reduction Technology 
 
When the modeling system evaluates application of mass reduction technology, the fuel 
consumption reduction factor, as defined in the preceding section, is adjusted to represent the 
realized compliance benefit associated with the regulatory binning of vehicle test weights. For 
light-duty vehicles, test weight (TW) is derived from the loaded vehicle weight (LVW), which is 
computed as vehicle curb weight (CW) plus 300 pounds, whereas for class 2b/3 vehicles, test 
weight is based on the adjusted loaded vehicle weight (ALVW), computed as the average of 
gross vehicle weight rating (GVWR) and curb weight. Test weight values are then rounded, 
resulting in TW “bins” as follows: 
 

LVW or ALVW ≤ 4,000 lb.:  TW rounded to nearest 125 lb. 
4000 lb. < LVW or ALVW ≤ 5,500 lb.:  TW rounded to nearest 250 lb. 
LVW or ALVW > 5,500 lb.:  TW rounded to nearest 500 lb. 

 
The calculation of vehicle test weight may be generalized by the following formula: 
 
 

ܹܶ ൌ ܺܣܯ ൬1000, ඄
ܹ
ܴ
െ 0.5ඈ ൈ ܴ൰ (2) 

 
Here, W refers to the LVW or ALVW, depending on vehicle class, and R is the rounding factor 
equivalent to 125, 250, or 500 lbs. as defined above. 
 
Taking into account the rounding of test weight, the new fuel consumption reduction factor, 
specific to mass reduction technology, becomes: 
 
 

௥௢௨௡ௗ௘ௗ_்ௐܥܨ ൌ ∆ܹܶ ൈ
௨௡௥௢௨௡ௗ௘ௗ_்ௐܥܨ

ܹܥ∆
 (3) 

 
Where: 
 

∆CW = % change in curb weight (obtained from model input), 
∆TW = % change in test weight (calculated), 
FCunrounded_TW = % change in fuel consumption (from model input), without TW 
rounding, and 
FCrounded_TW = % change in fuel consumption (calculated), with TW rounding. 

 
While the value for ∆CW is obtained directly from the model inputs, the value for ∆TW is 
calculated from vehicle’s initial CW, vehicle’s CW prior to application of mass reduction 
technology, and vehicle’s CW after application of mass reduction technology. Computation of 
vehicle test weights (or, likewise, prior and future knowledge of TWs) at multiple stages is 
required, since the model inputs define ∆CW as incremental percent changes calculated from the 
vehicle’s initial CW and applicable to the vehicle’s present CW. That is: 
 
ܥ  ேܹாௐ ൌ ܹܥ െ ܥ ூܹேூ்ூ஺௅ ൈ ܹܥ∆ (4) 
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Hence, for each of the CW values, an appropriate TW value is obtained, with the ∆TW taking the 
following form: 
 
 

∆ܹܶ ൌ
ܹܶ െ ܶ ேܹாௐ

ܶ ூܹேூ்ூ஺௅
 (5) 

 
On occasion, application of mass reduction technology may not yield a substantial decrease in 
CW necessary to push a vehicle into a new TW bin. For example, if a vehicle’s present CW 
places it on the far edge of its TW bin, even larger amounts of weight reduction may not be 
enough to produce a CW that would move it into a new bin. As such, ∆TW and FCrounded_TW 
become zero, consequently leading to no compliance benefit being realized on a vehicle. 
Conversely, if a vehicle starts with a CW that places it on the other side of its TW bin, even a 
small reduction in mass may lead to a new test weight. This leads to a higher calculated ∆TW 
value, ultimately inflating FCrounded_TW and resulting in a high compliance benefit. 
 
In addition to augmenting the fuel consumption reduction factor, application of mass reduction 
technology may also have an influence on the vehicle’s new payload and towing capacity by way 
of adjusting the vehicle’s GVWR and gross combined weight rating (GCWR) values. The degree 
by which GVWR and GCWR are affected is controlled in the scenarios input file through the 
“Payload Return” and “Towing Return” parameters. The calculation of new GVWR and GCWR 
are represented by the following formulas: 
 
 

ோௐܴܹܸܩ ൌ MINቆ
ܴܹܸܩ െ ݊ݎݑݐܴ݁݀ܽ݋݈ݕܽܲ ൈ ሺܹܥ െ ܥ ேܹாௐሻ,

ܥ ேܹாௐ ∗ ൫ீ௏ௐோ
஼ௐ ൯

ெ஺௑

ቇ (6) 

 
 

ோௐܴܹܥܩ ൌ MINቆ
ܴܹܥܩ െ ݊ݎݑݐܴ݁݃݊݅ݓ݋ܶ ൈ ሺܴܹܸܩ െ ,ோௐሻܴܹܸܩ

ோௐܴܹܸܩ ∗ ൫ீ஼ௐோ
ீ௏ௐோ൯ெ஺௑

ቇ (7) 

 
Where: 
 

CW and CWNEW = vehicle’s curb weight prior to and following application of mass 
reduction technology 
GVWR and GVWRNEW = vehicle’s GVWR prior to and following application of mass 
reduction technology 
GCWR and GCWRNEW = vehicle’s GCWR prior to and following application of mass 
reduction technology 
PayloadReturn = % of CW reduction returned to payload capacity 
TowingReturn = % of GVWR reduction returned to towing capacity 
൫ಸೇೈೃ

಴ೈ
൯
ெ஺௑

 = limiting factor, defined for each input vehicle, preventing GVWR from 

increasing beyond levels observed among the majority of similar vehicles 
൫ಸ಴ೈೃ
ಸೇೈೃ

൯
ெ஺௑

 = limiting factor, defined for each input vehicle, preventing GCWR from 

increasing beyond levels observed among the majority of similar vehicles 
 
Since the current version of the model is tailored for analysis of class 2b and class 3 pickups and 
vans, the GVWRNEW is further capped to prevent decreasing below 8501 lbs. Additionally for 
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class 2b/3 vehicles, given that TW is a derivative of the ALVW, application of mass reduction 
technology, and any subsequent effect on vehicle payload, further reflects on the resultant fuel 
consumption reduction factor. 
 
S2.2.9 Technology Sequencing and Branching 
 
The sequence of applying technology works in the following way: Within each group, the 
technology sequence of application proceeds as shown in the technology input file. There are 
some points where the sequence path can branch onto a different course, as discussed below. The 
groups are independent of each other, although there may be some interactions. 
 
S2.2.9.1 Sequencing and Branching within a Technology Group 
 
Within each technology group, the choice of technologies that can be applied may vary from 
vehicle to vehicle based on the baseline configuration of the vehicle or on the previous 
application of technologies. Both the engine and transmission technology groups have optional 
paths. The choice of which path depends upon a variety of factors, which include the vehicle 
class, the vehicle configuration, technology override settings for that vehicle, previous 
applications of technology, technology availability (year available), and phase-in restrictions. 
When left with a choice of two or more technologies, cost-effectiveness is used to choose the 
technology to apply. 
 
S2.2.9.2 Bypassing a Technology 
 
In cases where a technology is already installed in the baseline vehicle configuration or is 
unavailable for other reasons (e.g., it is not compatible with this vehicle class), that technology is 
simply bypassed in the technology path. For example, if engine friction reduction has previously 
been installed, the next available engine technology after low-cost lubricants on a vehicle with 
overhead valves (OHV) is cylinder deactivation. 
 
Branching within a technology group sequence occurs for the following reasons: 1) normal 
branch where there are two or more different (and mutually incompatible) technology choices – 
the model can choose one or another path; 2) limitations of technology choice based on vehicle 
configuration; 3) combination of both. 
 
An example of normal branching is DVVLD and CVVL in the engine technology group. 
 
An example of the limitations would be within the engine technology group, as shown in Figure 
2, below, where there is a separate path for vehicles with overhead valves (OHV) engines, single 
overhead cam engines (SOHC), and for engines with dual overhead cams (DOHC). Likewise, as 
shown in Figure 3 further down, the transmission technology group follows two distinct paths – 
one for manual transmissions and another for automatics. 
 
S2.2.9.3 Engine Technology Sequencing and Branching 
 
The engine technology sequence, shown in Figure 2, consists of two primary paths, one used for 
gasoline engines, and the other for diesel engines. The gasoline sequence is further subdivided 
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into three paths: single overhead cam (SOHC); dual overhead cam (DOHC); and overhead valve 
(OHV). The technology applicability settings in the market data file aid the modeling system in 
determining which of the paths the system will follow for a given vehicle model. An additional 
branch, between DVVLD and CVVL technologies, exists within the DOHC branch. The model 
chooses which path to follow based on availability for the specific vehicle and the vehicle 
technology class, the technology phase-in constraints, and the technology cost-effectiveness. 
 
Toward the completion of the gasoline engine technology sequence, the system encounters 
another branch, which culminates in a choice between conversion to LGDI engine, following a 
dieselization path, or following a strong hybrid path. Additionally, at the end of the dieselization 
sequence, the system will follow a strong hybrid path as well. The path that the model chooses is, 
again, based on availability for the specific vehicle and the vehicle technology class, the 
technology phase-in constraints, and the technology cost-effectiveness. 
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Figure 2. Engine Technology Group Technology Sequence 

 
 
S2.2.9.4 Transmission Technology Sequencing 
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The MDHD transmission technology sequence, shown in Figure 3, contains 8-speed automatic 
transmissions as an advance available to vehicles with automatic transmissions with fewer than 8 
forward speeds. 
 

 
Figure 3. Transmission, Electrification/Accessory, and Hybrid Technology Decision Tree  

 
 
S2.2.9.5 Electrical Accessory & Strong Hybrid Technology Sequencing 
 
The electrical accessory technology sequence has no branches, as shown in Figure 3. The 
technologies on the electrical accessory path can be applied to a vehicle any time, provided they 
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meet engineering and phase-in constraints. However, the technologies in the strong hybrid path 
(i.e., strong hybrids, plug-in hybrids and electric vehicles) can only be applied once the engine 
and transmission paths have been fully applied (excluding lean-burn direct injection). 
Furthermore, if a strong hybrid technology is applied before exhausting the electrification path, 
any preceding electrification technologies will be backfilled. Thus the engine, transmission, and 
(to a certain extent) electrification technologies are considered “enablers” that must be installed 
on a vehicle prior to the application of the strong hybrid technologies. 
 
S2.2.9.6 Vehicle (Other) Technology Sequencing 
 
The rest of the technology sequences (mass reduction, low rolling resistance tires, dynamic load 
reduction, and aerodynamic load reduction), shown in Figure 4, have no branches. However, 
with the exception of dynamic load reduction technologies, before the modeling system is able to 
apply a technology appearing later on the decision tree, the preceding technologies must be 
applied to a vehicle. 
 

 
 

Figure 4.  Vehicle Technology Decision Tree 
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S2.3 Compliance Simulation Loop 
 
Having determined the applicability of each technology to each vehicle model, engine, and/or 
transmission, the compliance simulation algorithm begins the process of applying technologies 
based on the CAFE standards applicable during the current model year. This involves repeatedly 
evaluating the degree of noncompliance, identifying the “best next” (as described above) 
technology available on each of the parallel technology paths mentioned above, and applying the 
best of these. Figure 5 gives an overview of the process. If, considering all regulatory classes, the 
manufacturer owes no CAFE civil penalties, then the algorithm applies no technologies beyond 
any carried over from the previous model year, because the manufacturer is already in 
compliance with the standard. If the manufacturer does owe CAFE civil penalties, then the 
algorithm first finds the best next applicable technology in each of the technology groups (e.g., 
engine technologies), and applies the same criterion to select the best among these. If this 
manufacturer is assumed to be unwilling to pay CAFE civil penalties (or, equivalently, if the user 
has set the system to exclude the possibility of paying civil penalties as long as some technology 
can still be applied), then the algorithm applies the technology to the affected vehicles. If the 
manufacturer is assumed to be willing to pay CAFE civil penalties and applying this technology 
would have a lower “effective cost” (discussed below) than simply paying penalties, then the 
algorithm also applies the technology. In either case, the algorithm then reevaluates the 
manufacturer’s degree of noncompliance. If, however, the manufacturer is assumed to be willing 
to pay CAFE civil penalties and doing so would be less expensive than applying the best next 
technology, then the algorithm stops applying technology to this manufacturer’s products. After, 
this process is repeated for each manufacturer. It is then repeated again for each modeling year. 
Once all modeling years have been processed, the compliance simulation algorithm concludes. 
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Figure 5. Compliance Simulation Algorithm 

 
Whether or not the manufacturer is assumed to be willing to pay CAFE penalties, the algorithm 
uses CAFE penalties not only to determine whether compliance has been achieved, but also to 
determine the relative attractiveness of different potential applications of technologies. 
Whenever the algorithm is evaluating the potential application of a technology, it considers the 
effective cost of applying that technology to the group of vehicles in question, and chooses the 
option that yields the lowest effective cost.14 The effective cost is used for evaluating the relative 
attractiveness of different technology applications, not for actual cost accounting. The effective 
cost is defined as the change in total technology costs incurred by the manufacturer plus the 

                                                 
14 Such groups can span regulatory classes. For example, if the algorithm is evaluating a potential upgrade to a given 
engine, that engine might be used by a station wagon, which is regulated as a passenger car, and a minivan, which is 
regulated as a light truck. If the manufacturer’s passenger car fleet complies with the corresponding standard, the 
algorithm accounts for the fact that upgrading this engine will incur costs and realize fuel savings for both of these 
vehicle models, but will only yield reductions of CAFE fines for the light truck fleet. 
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change in CAFE penalties incurred by the manufacturer minus the value of any reduction of fuel 
consumed by vehicles sold by the manufacturer. The calculation can span multiple modeling 
years. If the candidate technology was enabled for application in a previous year and not used, 
then it can remain as a candidate to be applied and then carried forward to the current model 
year. The impact of the technology application in each of these years is summed to obtain the 
effective cost. 
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ൌ ෍
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൫࢐ࡺ൯࢏
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(8)  

 
where PresentMY is the current modeling year, BaseMY is the first year of the potential 
application of the technology (can be less than or equal to PresentMY), ΔTECHCOST is simply 
the product of the unit cost of the technology, WELFARELOSSi is the loss of value to the 
consumer resulting from the reduction in travel range of electric vehicles, and the total sales (Nj) 
of the affected cohort of vehicles (j) for all years involved in the candidate technology 
application. The value of the reduction in fuel consumption achieved by applying the technology 
in question to all vehicles i in cohort j is calculated as follows:15 
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(9) 

 
where (SURVv)i is the probability that vehicle i of a given vintage v will remain in service, (MIv)i 
is the average number of miles driven in a year by vehicle i at a given vintage v, 
VMTGROWTHMY+v is the growth factor to apply to the base miles driven in the current model 
year MY at the given vintage v, FT is the fuel type the vehicle operates on (gasoline, e85, diesel, 
or electricity), (FEFT)i and (FE'FT)i are the vehicle’s fuel economy for a specific fuel type prior to 
and after the pending application of technology, (FSFT)i and (FS'FT)i are the vehicle’s assumed 
share of operating on a specific fuel type prior to and after the pending application of technology, 
GAPFT is the relative difference between on-road and laboratory fuel economy for a specific fuel 
type, Ni is the sales volume for vehicle model i in the current model year MY, (PRICEFT)MY is the 
price of the specific fuel type in year MY, and PB is a “payback period”, or number of years in 
the future the consumer is assumed to take into account when considering fuel savings. As 
discussed in Section A.3 of Appendix A, (SURVv)i, (MIv)i, VMTGROWTHMY+v, (PRICEFT)MY, and 
GAPFT are all specified in the parameters input file, while the values for PB are specified in the 
market data input file (see Section A.1.1 in Appendix A). 

                                                 
15 This is not necessarily the actual value of the fuel savings, but rather the increase in vehicle price the manufacturer 
is assumed to expect to be able impose without losing sales. 
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In equation (8), FINE is the change in total CAFE penalties (i.e., accounting for all regulatory 
classes in the current CAFE scenario and model year). Typically, FINE is negative because 
applying a technology would increase CAFE.16 FINE is calculated by evaluating the following 
before and after the pending technology application, and taking the difference between the 
results: 

 
 

ܧܰܫܨ ൌ െ݇ி෍MINሺܫܦܧܴܥ ஼ܶ ൅ ܫܶܫܦܧܴܥ ஼ܰ െ ܷܱܶܫܦܧܴܥ ஼ܶ, 0ሻ
஼

 (10) 

 
Here, kF is in dollars per one credit of shortfall (e.g., $5.5/credit) and specified in the scenarios 
input file. 
 
Within each regulatory class C, the amount of CAFE credit created (noncompliance causes credit 
creation to be negative, which implies the use of CAFE credits or the payment of CAFE 
penalties) is calculated by taking the difference between the CAFE level achieved by the class 
and the standard applicable to the class, and multiplying the result by the number of vehicles in 
that class. Taking into account attribute-based CAFE standards, for light duty regulatory classes, 
this is expressed as follows: 

 
 

ܫܦܧܴܥ ஼ܶ ൌ ሾROUNDሺܧܨܣܥ஼ሺࢂ஼ሻ, 1ሻ െ ஼ሻሿࢂ஼ሺܦܶܵ ൈ ஼ܰ ൈ 10 
(11) 

 
while for the class 2b and class 3 regulatory classes, credits are computed as: 
 

ܫܦܧܴܥ  ஼ܶ ൌ ൤
100

஼ሻࢂ஼ሺܦܶܵ
െ ROUND൬

100
஼ሻࢂ஼ሺܧܨܣܥ

, 2൰൨ ൈ ஼ܰ ൈ 100 (12) 

 
where VC is a vector containing all vehicle models in regulatory class C, CAFEC(VC) is the 
CAFE level for regulatory class C, STDC(VC) is a function defining the standard applicable to 
regulatory class C, and NC is the total sales volume for regulatory class C. 
 
Additionally, in Equation (10) above, CREDITINC is the amount of CAFE credit transferred into 
regulatory class C from another compliance category, while CREDITOUTC is the amount of 
CAFE credit transferred out of regulatory class C into another compliance category. 
 
Figure 6 gives an overview of the logic the algorithm follows in order to identify the best next 
technology application for each technology group. 
 
Within a given technology group, the algorithm considers technologies in the order in which they 
appear. If the phase-in limit for a given technology has been reached, the algorithm proceeds to 
the next technology. If not, the algorithm determines whether or not the technology remains 
applicable to any sets of vehicles, evaluates the effective cost of applying the technology to each 
such set, and identifies the application that would yield the lowest effective cost. 

                                                 
16 Exceptions can occur, for example, if mass reduction is applied under a CAFE system in which attribute standards 
are weight-based rather than footprint-based. 
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As shown in Figure 6, the algorithm repeats this process for each technology group, and then 
selects the technology application yielding the lowest effective cost. As discussed above, the 
algorithm operates subject to expectations of the willingness of each manufacturer to pay fines. 
COSTeff is determined, as above, by equations (8), (9), and (10), irrespective of the 
manufacturer’s willingness to pay fines. 
 
At the end of each year in the model year loop, the vehicle/technologies combinations that can be 
candidates for application in multi-year processing are identified. 
 

 
Figure 6. Determination of "Best Next" Technology Application 
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Chapter Three Calculation of Effects 
 
This chapter describes the way the CAFE modeling system estimates the effects of potential new 
CAFE standards on energy use, as well as on emissions of greenhouse gases and other air 
pollutants.  These effects are caused by improvements in the fuel economy of individual vehicle 
models that manufacturers make in response to the implosion of higher CAFE standards.  This 
section also describes how these energy use and environmental impacts are translated into 
estimates of economic benefits or costs, and identifies which of these economic impacts are 
borne privately by vehicle owners and by society as a whole. 
 
The effects on energy use and emissions from tightening or reforming CAFE standards are 
estimated separately for each individual vehicle model and vintage (or model year) over its 
expected life span in the U.S. vehicle fleet.  A vehicle model’s life span extends from the initial 
model year when it is produced and sold, through the year when vehicles produced during that 
model year have reached the maximum age assumed in the CAFE model.17  Each of the effects 
of raising CAFE standards is measured by the difference in the value of a variable – such as total 
gallons of fuel consumed by a vehicle model and vintage over its lifetime – with its baseline fuel 
economy level, and its estimated fuel economy if that model were instead required to comply 
with a stricter CAFE standard.  A vehicle model’s baseline fuel economy level is usually (but not 
necessarily) defined as the level of fuel economy it would be expected to have if the CAFE 
standard currently in effect for its vehicle class remained in effect for the future model year when 
it is produced. 
 
Although these effects are calculated for individual vehicle models, vintages, and future calendar 
years over their respective lifetimes, they are typically reported at the aggregate level for all 
vehicle models in a CAFE regulatory class produced during each model year affected by a 
proposed standard.  Cumulative impacts for each CAFE regulatory class and model year over its 
expected life span are reported both in undiscounted terms and as their present value discounted 
to the calendar year defined within the parameters input file. 
 
  

                                                 
17 We adopt the simplifications that vehicle model years and calendar years are identical, and that all vehicles 
produced during a model year are sold and placed into service during the corresponding calendar year. 
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Section 1 Vehicle Production and Lifetimes 
 
The forecast number of new vehicles of a specific model k produced and sold during a given 
model year MY is: 
 

 , ,k MY MY k MYn N P (13) 

 
Where NMY denotes total sales of all models produced during that model year, and Pk,MY is the 
proportion of total production and sales during that model year that is accounted for by model k.  
 
The number of vehicles of a specific model and model year (or vintage) that remains in service 
during each subsequent calendar year is calculated by multiplying the number originally 
produced by estimates (model inputs) of the proportion expected to remain in service at each age 
up to an assumed maximum lifetime.  Thus the number of vehicles of model k produced during 
model year MY that remain in use during a future calendar year t, or nk,MY,t, is: 
 
 

, , , ,k MY t k MY k an n s (14) 

 
where sk,a denotes the proportion of vehicles of model k expected to remain in use at the age a 
that vehicles produced during model year MY will have reached during calendar year t.  The age 
of a vehicle model produced in model year MY during calendar year t is defined as: 
 
 a = t – MY.18 (15) 

 
The CAFE model currently accommodates different schedules of survival rates by vehicle age 
for varying vehicle classes, where class 1/2a light trucks are further separated into vans, SUVs, 
and pickups, as reported in Section A.3.1 of Appendix A.  Based on analysis of recent 
registration data, the maximum ages of passenger automobiles and light and medium duty trucks 
are estimated to be 30 years and 37 years, respectively.19 
 
Each vehicle model k produced during a model year MY is designated as operating on a specific 
fuel type or employing a specific technology; all units of that model produced during a model 
year are assumed to be of the same fuel or technology type.  The CAFE model currently 
recognizes five fuel or technology types: gasoline, diesel, flexible-fuel vehicles (or FFVs, which 
are capable of operating on gasoline or on gasoline blended with up to 85% ethanol), plug-in 
hybrid electric vehicles (or PHEVs, which can operate on either gasoline or electricity generated 
off-board and stored in on-board batteries), and electric vehicles (or EVs, which operate only on 

                                                 
18 We define a vehicle’s age to be 0 during the year when it is produced and sold; that is, when t=MY.  Thus, for 
example, a model year 2005 vehicle is defined to be 10 years old during calendar year 2015.  Because we do not 
attempt to forecast changes in the proportion of vehicles produced during future model years that are expected to 
survive to each age, a vehicle’s age depends only on the difference between its model year (MY) and the calendar 
year (t) for which these calculations are performed, and not on their specific values. 
19 These are defined as the ages when the number of vehicles of a model year that remain in service has declined to 
fewer than 2% of those originally produced. 
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electricity generated off-board and stored in on-board batteries).20  The fractions of total mileage 
for which FFVs operate on gasoline and ethanol-blend fuels, and the fractions of total mileage 
for which PHEVs operate on gasoline and stored electricity, are inputs to the model. 
 
  

                                                 
20 The system is also capable of handling additional fuel or technology types (namely, CNG, LNG, and LPG), 
provided the accompanying input assumptions are available to the model. 
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Section 2 Vehicle Use and Total Lifetime Mileage 
 
The CAFE model employs the widely-documented relationship between vehicle age and 
declining average vehicle use to estimate the number of miles that individual vehicle models are 
driven annually and in total over their expected lifetimes.  Separate schedules of average annual 
miles driven by age of vehicle were developed for passenger automobiles, light trucks (class 1 
and 2a), and medium duty trucks (class 2b and 3), where light trucks are further separated into 
vans, SUVs, and pickups, as reported in Section A.3.1 of Appendix A.  For passenger 
automobiles and light trucks, the initial estimates of the relationship between vehicle age and 
average annual miles driven were tabulated from the sample of approximately 140,000 
households included in the 2009 National Household Travel Survey (NHTS).21  For class 2b/3 
trucks, these initial estimates were derived from a combination of the 2009 NHTS and the 2002 
Vehicle In Use Survey (VIUS). 
 
Two adjustments are applied to these mileage schedules to forecast the average number of miles 
that vehicles produced during future model years will be driven each year over their expected 
lifetimes.  First, the estimates of annual miles driven by passenger cars and light trucks during 
2008 are adjusted to reflect assumed future growth in average vehicle use.22  The average 
number of miles driven by cars and light trucks of all ages is assumed to grow by 0.5% per year 
from 2008 on.  For class 2b/3 trucks, however, this adjustment does not apply. 
 
Second, the estimates of average annual miles driven by cars and light trucks of each age derived 
from the NHTS (and adjusted for expected future growth as described above) are further adjusted 
by applying the estimated elasticity of vehicle use with respect to fuel cost per mile to the 
difference in inflation-adjusted gasoline price per gallon between calendar year 2008 (for 
passenger cars and light trucks) or 2013 (for class 2b/3 trucks) and each subsequent calendar 
year.  This adjustment employs actual gasoline prices for the years 2009-2013, forecasts for 
2014-2040 reported in the U.S. Energy Information Administration’s Annual Energy Outlook 
2014, and extrapolations of gasoline prices beyond the year 2040 developed by EPA.23  This 
adjustment assumes an elasticity of annual vehicle use with respect to fuel cost per mile of -0.10, 
corresponding to a fuel economy rebound effect of 10%. 
 
Thus the average number of miles driven by surviving vehicles of model k and model year MY 
during calendar year t, or mk,MY,t , is given by: 
 

                                                 
21 For a description of the survey and methods for estimating annual vehicle use, see 2009 National Household 
Travel Survey User’s Guide, Version 3, January 2004, available at 
http://nhts.ornl.gov/2001/usersguide/UsersGuide.pdf (last accessed November 30, 2011). 
22 Increases in the average number of miles cars and trucks are driven each year have been an important source of 
historical growth in total car and light truck use, and are expected to represent an important source of future growth 
in total light-duty vehicle travel as well. 
23 See U.S. Energy Information Administration, Annual Energy Outlook 2011, Reference Case, “Petroleum Product 
Prices,” available at http://www.eia.gov/oiaf/aeo/tablebrowser/#release=AEO2011&subject=0-AEO2011&table=12-
AEO2011&region=0-0&cases=ref2011-d020911a (last accessed November 30, 2011). 
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where mtype,t-MY,MY' is the average annual mileage for a car or truck that was of age t-MY during 
the VMT base year (2008 for car or class 1/2a truck, or 2013 for class 2b/3 truck), r is the rate of 
growth in average annual miles per vehicle beginning in 2008 or 2013, t-MY' is the number of 
years that have elapsed between the base year and calendar year t, m,cpm is the elasticity of 
annual vehicle use with respect to fuel cost per mile, Ck,MY,t is fuel cost per mile during year t for 
a car or truck model k, and Ck,t-MY,MY' is fuel cost per mile for a car or truck that was of age t-MY 
during the base year. 
 
The value of fuel cost per mile for vehicle model k of model year MY during each year t of its 
expected lifetime, denoted Ck,MY,t,CAFE in equation (16), depends on both the price per gallon of 
gasoline during year t and the actual fuel economy model k achieves in on-road driving.  
Specifically, 
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where Pt is the inflation-adjusted price per gallon of gasoline forecast for year t, and mpgk,MY,CAFE 
is the rated fuel economy that model k achieves for model year MY with the assumed CAFE 
standard in effect.  Each model’s rated fuel economy is assumed to be determined during the 
model year when it is produced, and to remain fixed throughout its lifetime.  However, its actual 
on-road fuel economy is assumed to fall short of that rating by the on-road fuel economy “gap” 
(a model input, currently assumed to be 20% for gasoline, diesel, and ethanol-85 fuel types, and 
30% for electricity fuel type).  Furthermore, the on-road fuel economy of electric vehicles, as 
well as the electricity fuel economy component of plug-in hybrid/electric vehicles, is further 
reduced by the petroleum equivalency factor. 
 
Equations (16) and (17) together indicate that the average number of miles that surviving 
vehicles of a model k and model year MY are driven during each year t of their lifetimes depends 
on their fuel economy.  The fuel economy that each vehicle model is projected to achieve can 
differ between the baseline market forecast for model year MY, which assumes that the CAFE 
standard prevailing during the previous model year would be extended to apply to model year 
MY, and any alternative CAFE standard that is considered for model year MY. 
 
As a consequence, the average number of miles that vehicles of model k and model year MY are 
driven during year t will also differ between the baseline market forecast and an alternative 
CAFE standard, depending on whether its manufacturer elects to increase that model’s fuel 
economy as part of its strategy to comply with the alternative standard.  This difference reflects 
the fuel economy rebound effect, which occurs because buyers of new vehicles respond to the 
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reduction in their operating costs that results from their higher fuel economy by driving slightly 
more.24 
 
The total number of miles driven by all vehicles of a specific model and vintage (model year) 
during each calendar year they remain in the fleet is then calculated by multiplying the 
appropriate estimate of annual miles driven per vehicle by the number of vehicles of that model 
year remaining in service during that year.  Thus the total miles driven during year t by the 
surviving vehicles of model k that were originally produced during model year MY, denoted 
Mk,MY,t,CAFE, is calculated as: 
 
 

CAFEtMYktMYkCAFEtMYk mnM ,,,,,,,,  (18) 

 
where mk,MY,t,CAFE is as defined above. 
 
  

                                                 
24 Average annual vehicle use under both the baseline market forecast of fuel economy and a higher CAFE standard 
are calculated by reference to the schedules of average annual mileage by age derived from the 2001 NHTS, as 
equations (16) and (17) indicate.  Thus the difference between a model’s annual use under those two scenarios 
differs slightly from the estimate that would have resulted from first calculating annual use under the baseline 
market forecast of MPG from the 2001 NHTS, and then adding the increase in use estimated by applying the 
rebound effect to the reduction in fuel cost per mile resulting from the increase in its fuel economy between the 
baseline forecast and a higher CAFE standard. 
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Section 3 Fuel Consumption and Savings 
 
Fuel consumption by vehicles of each model and vintage during a future year depends on the 
total mileage that the surviving vehicles are driven during that year, as well as on the fuel 
efficiency they obtain in actual driving.  As indicated previously, the fuel economy levels that 
new vehicles achieve in real-world driving falls significantly short of the rated fuel economy 
levels that are used to assess manufacturers’ compliance with CAFE standards. 
 
The number of gallons of each type of fuel (or gasoline gallon equivalents of fuel energy, in the 
case of electricity) consumed by vehicles of model k and model year MY during year t, denoted 
gk,MY,t,fuel, is calculated from: 
 
 

 fuelfuelCAFEMYk

fuelCAFEMYkCAFEtMYk
fuelCAFEtMYk gapmpg

sm
g




1,,,

,,,,,,
,,,,  (19) 

 
where sk,MY,CAFE,fuel is the share of miles that model k produced in model year MY operates on 
each type of fuel, mpgk,MY,CAFE,fuel is its fuel economy in miles per gallon (or miles per gasoline 
gallon equivalent, in the case of electricity) on each type of fuel, and gapfuel (a model input) 
indicates the proportional difference between the fuel economy of vehicles using that fuel as 
measured for CAFE purposes and their actual on-road fuel economy.25 
 
The CAFE model estimates use of eight different types of fuel energy: gasoline, diesel, E85 
(blend of 85% ethanol and 15% gasoline), B20 (blend of 20% biodiesel and 80% petrodiesel), 
electricity, hydrogen, CNG, LNG, and LPG.  However, only gasoline, diesel, E85, and electricity 
are presently used for analysis.  Dedicated gasoline, diesel, and electric vehicle models will each 
have mileage shares of 100% for the fuel they are designed to utilize, and 0% mileage shares for 
all other fuels.  FFVs are currently assumed to operate on E85 for 1% of their annual mileage 
each year over their lifetimes, while PHEVs are assumed to operate on electricity for 50% of 
their annual mileage and on gasoline for the remaining 50%.  These values are inputs to the 
CAFE model, and can be adjusted by the user. 
 
As equation (19) indicates, many of the factors determining a vehicle model’s consumption of 
different fuels can vary depending on the CAFE standard that is in effect during the model year it 
is produced.  Specifically, the shares of miles for which it operates on different fuels, its fuel 
economy when using each different fuel, and as discussed previously, its average annual mileage 
can each differ between the baseline market forecast and any alternative CAFE level that the 
model is used to analyze.  These differences occur because manufacturers will increase the fuel 
economy of some models in response to increases in CAFE standards from their baseline level, 
and may convert some gasoline-powered models to diesel, FFVs, or PHEVs. 
 
Total use of each type of fuel during year t by all vehicles in use that were originally produced 
during a single model year is the sum of fuel consumed by the surviving vehicles of each model 
operating on that type of fuel.  Denoting this quantity GMY,t,CAFE,fuel, it is computed as: 
                                                 
25 We assume that a vehicle’s fuel economy is constant over its lifetime, and that the test versus on-road fuel 
economy gap for each fuel is identical for all vehicle types and ages using that fuel. 
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 

k
fuelCAFEtMYkfuelCAFEtMY gG ,,,,,,,  (20) 

 
Similarly, total consumption of each type of fuel by all vehicle models produced during a model 
year over their expected lifetimes, denoted GMY,CAFE,fuel, is given by: 
 
 

t k
fuelCAFEtMYkfuelCAFEMY gG ,,,,,,  (21) 

 
As with annual consumption of different types of fuels by individual vehicle models, total annual 
consumption of each fuel by all vehicle models will differ depending on the CAFE standard that 
prevailed during the model year when they were originally produced.  The change in fuel use 
that results from imposing a different CAFE standard is always measured relative to expected 
fuel use with some baseline or comparison standard in effect. 
 
The usual assumption employed in the CAFE model is that the baseline fuel economy levels for 
vehicles produced during a future model year would be those that manufacturers would provide 
if the most recently adopted standard were extended to apply to future model years.  Thus for 
example, the baseline fuel economy levels projected for vehicles produced during model years 
2017-25 are estimated under the assumption that the recently-adopted CAFE standards for model 
year 2016 cars and light trucks would be extended to apply to model years 2017-25.  Estimated 
fuel consumption with the 2016 CAFE standard assumed to remain in effect for model years 
after 2016 provides the baseline for measuring reductions in fuel use expected to result from 
adopting higher CAFE standards for model years 2017-25. 
 
The change in total consumption of each fuel type during year t from imposing a higher CAFE 
standard for model year MY than that assumed to be in effect under the baseline forecast is given 
by: 
 
 

fuelBASEtMYfuelCAFEtMYfuelCAFEtMY GGG ,,,,,,,,,   (22) 

 
Similarly, the savings in total consumption of each type of fuel by all vehicle models produced 
during a model year over their expected lifetimes is computed as: 
 
  

t
fuelBASEtMY

t
fuelCAFEtMYfuelCAFEMY GGG ,,,,,,,,  (23) 

 
In addition, the model calculates corresponding energy consumption (in quadrillion British 
thermal units, or Quads) total energy consumption attributable to each fuel (and to electricity), 
reporting these quantities on a total and incremental basis.  
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Section 4 Greenhouse Gas Emissions 
 
Fuel savings from imposing stricter CAFE standards will result in lower emissions of carbon 
dioxide (CO2), the primary greenhouse gas emitted during the refining, distribution, and 
combustion of transportation fuels.26  Lower fuel consumption reduces carbon dioxide emissions 
directly, because the largest source of these emissions from transportation activity is fuel use by 
internal combustion engines.  The CAFE model calculates CO2 emissions from vehicle operation 
by multiplying the number of gallons of fuel consumed by the carbon content per gallon of fuel, 
and then applying the ratio of carbon dioxide emissions generated per unit of carbon consumed 
during the combustion process.27 
 
Emissions of carbon dioxide resulting from fuel consumption by all vehicle models produced in 
model year MY during year t, denoted CO2veh

MY,t,CAFE, are calculated from their consumption of 
each fuel type as: 
 
   








fuel
fuelfuelfuelCAFEtMYCAFEtMY

veh CdGCO
12

44
2 ,,,,,  (24) 

 
where dfuel is the mass density of a fuel (measured in grams per gallon), Cfuel is the fraction of 
each fuel’s mass that represents carbon, and (44/12) is the ratio of the molecular weight of 
carbon dioxide to that of elemental carbon.  This ratio measures the mass of carbon dioxide that 
is produced by complete combustion of mass of carbon contained in each gallon of fuel.  
Vehicles operating on electricity are assumed to generate no CO2 emissions during vehicle use. 
   
As with the model’s calculations of fuel consumption, estimates of annual CO2 emissions from 
fuel use are summed over the calendar years that cars and light trucks produced during each 
model year are projected to remain in use to obtain estimates of lifetime emissions. Specifically, 
lifetime CO2 emissions from fuel consumption by cars or light trucks produced during model 
year MY are given by: 
 
 

t
CAFEtMYCAFEMY

veh COCO ,,, 22  (25) 

 
where t ranges from MY to MY plus the maximum age of a car or truck. 
 
By reducing the volume of fuel consumed, raising CAFE standards will also affect carbon 
dioxide emissions from refining and distributing liquid fuels, as well as from generating 
electricity.  Carbon dioxide emissions occur during the production of petroleum-based fuels as a 

                                                 
26 Carbon dioxide emissions account for more than 97% of total greenhouse gas emissions from the refining and use 
of transportation fuels; see U.S. Environmental Protection Agency, Draft Inventory of GHG Emissions and Sinks 
(1990-1999), Tables ES-1 and ES-4, http://www.epa.gov/globalwarming/publications/emissions/us2001/energy.pdf. 
27 The carbon content of gasoline used in the CAFE model is a weighted average of those for different types of 
gasoline in use.  Although the model does not explicitly account for incomplete conversion of carbon to carbon 
dioxide, input values specifying carbon content can be adjusted accordingly (i.e., reduced to 99-99.5% of actual 
carbon content). 
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result of energy use for petroleum extraction, transportation, storage, and refining, as well as 
during storage and distribution of refined fuel.  Producing the chemical feedstocks or agricultural 
products from which non-petroleum fuels such as ethanol are derived also entails energy use and 
generates CO2 emissions, as does refining, storing, and distributing those fuels.  Generating 
electricity for use by PHEVs and EVs using fossil energy sources such as coal or natural gas also 
produces CO2 emissions. 
 
The CAFE model calculates reductions in carbon dioxide emissions from each stage of liquid 
fuel production and distribution using estimates of emissions in each stage of these processes per 
unit of fuel energy supplied.  These estimates are converted to a per-gallon basis using the 
energy content per gallon of gasoline, diesel, and ethanol, and multiplied by the volume of each 
fuel consumed to estimate total carbon dioxide emissions from fuel production and distribution.  
Emissions from generating electricity are estimated from electricity consumption by PHEVs and 
EVs together with average CO2 emissions per unit of energy generated, assuming the U.S. 
average mix of fuel sources and transmission distances. 
 
Total CO2 emissions from producing and distributing fuel consumed by vehicles of model year 
MY during year t of their lifetimes, denoted CO2ref

MY,t,CAFE, is given by: 
 
   

fuel

fuel
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f

fuelCAFEtMYCAFEtMY
ref COCOCOGCO 2222 ,,,,,  (26) 

 
where CO2f

fuel represents carbon dioxide emissions from feedstock production or extraction per 
gallon of each type of fuel, CO2r

fuel represents emissions per gallon of each type of fuel refined, 
and CO2d

fuel represents carbon dioxide emissions per gallon from transportation, storage, and 
distribution of liquid fuels.  For electricity, the sum of these three emission rates is replaced by a 
single rate, CO2 emissions per gasoline gallon equivalent of electrical energy generated.  This 
rate depends on the mix of fuels that is assumed to be used for generating electricity, and can be 
adjusted by the model user. 
 
Annual CO2 emissions generated by fuel production and distribution are then summed over the 
lifetimes of automobiles and light trucks produced during each model year: 
 
 

t
CAFETMYCAFEMY

ref COCO ,,, 22  (27) 

 
where t again ranges from MY to (MY+30) for cars or (MY+37) for trucks.   
 
Finally, CO2 emissions from fuel consumption are combined with emissions generated during 
the fuel supply process to yield total CO2 emissions from fuel production and consumption by 
vehicles produced during a model year over their expected lifetimes.  Total lifetime emissions 
attributable to cars or trucks produced during model year MY are: 
 
 CAFEMY

ref
CAFEMY

veh
CAFEMY

tot COCOCO ,,, 222   (28) 
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The presence of the CAFE subscript on total emissions indicates that these depend on the 
specific CAFE standard in effect, because that standard affects the fuel economy of individual 
vehicle models and their lifetime total fuel consumption.  The change in CO2 emissions expected 
to result from imposing a new CAFE standard for that model year is calculated as the difference 
in total lifetime emissions of cars or light trucks produced in that model year with the new 
standard in effect, and their total emissions with the baseline CAFE standard in effect: 
 
 BASEMY

tot
CAFEMY

tot
CAFEMY

tot COCOCO ,,, 222   (29) 

 
Because imposing a higher CAFE standard reduces fuel consumption over the lifetimes of 
vehicles produced during the model years it affects, and CO2 emissions are a direct product of 
the volume of fuel produced and consumed, imposing a higher CAFE standard also reduces their 
lifetime CO2 emissions. 
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Section 5 Air Pollutant Emissions 
 
Stricter CAFE standards can result in higher or lower emissions of criteria air pollutants, by-
products of fuel combustion that are also emitted during the production and distribution of fuel.  
Criteria pollutants that are emitted in significant quantities by light-duty motor vehicles include 
carbon monoxide, various hydrocarbon compounds, nitrogen oxides, sulfur dioxide, and fine 
particulate matter. 
 
The increased use of vehicle models with improved fuel economy that occurs through the fuel 
economy rebound effect causes increased emissions of most criteria pollutants, since federal 
standards regulate permissible emissions of these pollutants on a per-mile basis.28  In contrast, 
reductions in the volume of fuel consumed that result from requiring higher fuel economy cause 
emissions of criteria pollutants during fuel production and distribution to decline.  The net 
change in total emissions of each criteria pollutant that results from imposing a higher CAFE 
standard depends on the relative magnitudes of changes in emissions from vehicle use and from 
fuel refining and distribution. 
 
The CAFE model calculates emissions of most criteria pollutants resulting from vehicle 
operation by multiplying the number of miles driven by vehicles of a model year during each 
year they remain in service by per-mile emission rates for each pollutant, which are derived from 
EPA’s Motor Vehicle Emissions Simulator (MOVES).  These emission rates differ among 
passenger cars, light trucks, and class 2b/3 trucks operating on different fuel types; PHEVs when 
operating on electricity and EVs are assumed to generate no emissions of criteria air pollutants 
during vehicle use. 
 
Total emissions of a criteria pollutant from the use of cars or trucks produced during model year 
MY during year t of their lifetimes, denoted Eveh

MY,t, are thus: 
 
  

fuel k
fuelMYtkfuelCAFEMYkCAFEtMYkCAFEtMY

veh esME ,,,,,,,,,,  (30) 

 
where, as in equation (19) above, Mk,MY,t,CAFE is total miles driven during year t by vehicles of 
model k originally produced during model year MY, and sk,MY,CAFE,fuel is the share of those miles 
that model k operates on each type of fuel.29 
 
In equation (30), ek,t-MY,fuel is the per-mile rate at which vehicles of model k emit a criteria air 
pollutant during year t when using each type of fuel.  These emission rates can depend on a 
vehicle model’s age and accumulated mileage, and during year t, vehicles produced during 
model year MY will have reached age (t-MY).30  Emission rates from vehicle use also depend on 
                                                 
28 The exception is sulfur dioxide, which is estimated from the sulfur content of each type of fuel using a procedure 
exactly analogous to the estimation of CO2 emissions from the carbon content of each fuel type. 
29 As in equation (19), the CAFE subscript on s indicates that the type of fuel on which a vehicle model produced 
during a specific model year operates can depend on the CAFE standard in effect for that model year.  
30 The emission rates derived from MOVES are projected to be identical for all model years after 2011, and to 
remain constant over those vehicles’ lifetimes. 
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fuel type, although vehicles using electricity are assumed to produce no emissions during their 
operation. 
 
As with fuel use and CO2 emissions, annual emissions of each criteria air pollutant are summed 
over the future years that vehicle models originally produced during each model year are 
expected to be in service, in order to produce estimates of their total lifetime emissions: 
 
 

t

CAFEtMY
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where as usual, t begins at a value of MY and increases to MY plus the maximum lifetimes 
assumed for automobiles and light trucks. 
 
Emissions of criteria air pollutants that occur during fuel refining and distribution are estimated 
by applying emission factors for each pollutant per gallon of fuel refined to the total volumes of 
gasoline, diesel, and ethanol projected to be consumed during future years.  Emissions from 
generating electricity used by PHEVs and EVs are calculated using emission factors for each 
criteria air pollutant per unit of electricity generated.  In contrast to CO2 emissions, which are 
included regardless of where petroleum extraction and fuel refining occur throughout the world, 
only domestic emissions of criteria air pollutants are included. 
 
Thus emissions of each criteria air pollutant from producing and distributing the fuel consumed 
by cars or light trucks of model year MY during year t of their lifetimes, denoted Eref

MY,t,CAFE, are: 
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where ef

fuel, e
r
fuel, and ed

fuel are emissions of a criteria air pollutant per gallon of fuel supplied that 
occur during feedstock production or extraction, fuel refining, and transportation, storage, and 
distribution of refined fuel.  Because different fuels utilize different feedstocks, refining 
processes, and distribution networks, each of these factors can differ by type of fuel.  The 
parameter rfuel indicates the fraction of each type of fuel that is refined domestically (using either 
domestically-produced or imported feedstocks), while ffuel indicates fraction of domestic refining 
that utilizes domestically-produced feedstocks. 
 
For vehicles operating on electricity, the bracketed expression in equation (32) is replaced by a 
single factor measuring criteria pollutant emissions per gasoline gallon equivalent of electricity 
generated.  As with CO2 emissions, the values of these emission factors for each criteria air 
pollutant depend on the fuel mix assumed to be used for generating electricity, and can be 
adjusted accordingly by the model user.  All electricity consumed by PHEVs and EVs is 
assumed to be generated domestically. 
 
Emissions of each criteria pollutant attributable to producing and distributing the fuel consumed 
by cars or light trucks initially produced during model year MY over their lifetimes are: 
 
 
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Finally, total emissions of each criteria pollutant over the lifetimes of cars or light trucks of 
model year MY are the sum of emissions that occur as a result of their lifetime use, and emissions 
from producing and distributing the fuel they consume over their lifetimes: 
 
 CAFEMY

ref
CAFEMY

veh
CAFEMY

tot EEE ,,,   (34) 

 
Again, the presence of the CAFE subscript in equation (34) indicates that vehicles’ lifetime 
emissions depend on the CAFE standard in effect during the model year they are produced, 
through its effect on their fuel economy, usage, and fuel consumption. 
 
As a consequence, total lifetime emissions of each criteria air pollutant by cars and light trucks 
produced during future model years will differ between the baseline CAFE standard and any 
alternative standard that is specified.  The model calculates the effect of imposing a higher CAFE 
standard on emissions of criteria air pollutants as the difference between lifetime emissions by 
cars and light trucks produced during each model year it would affect, and those vehicles’ 
emissions under the baseline CAFE standard: 
 
 BASEMY

tot
CAFEMY
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tot EEE ,,,   (35) 
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Section 6 Vehicle Safety Effects 
 
As discussed in Section 2 above, vehicle miles traveled may increase due to the fuel economy 
rebound effect, resulting from improvements in vehicle fuel efficiency and cost of fuel, as well 
as the assumed future growth in average vehicle use. Increases in total lifetime mileage increase 
exposure to vehicle crashes, including those that result in fatalities.  Consequently, the modeling 
system computes total fatalities attributed to vehicle use for vehicles of model year MY, 
belonging to safety class SC and weight threshold T as: 
 
 

்,ெ௒,ௌ஼ܨ ൌ
ܯܸ ெܶ௒,ௌ஼,்

1݁9
ൈ ்,ௌ஼ܧܵܣܤ ൈ ܸܵܯܨ ௌܵ஼,் (36) 

 
Where, VMTMY,SC,T is the lifetime vehicle miles traveled for vehicles of model year MY within a 
safety class SC and weight threshold T, BASESC,T is the measure of base fatalities per billion 
miles for vehicles within a safety class SC and weight threshold T, and FMVSSSC,T is an 
adjustment for new Federal Motor Vehicle Safety Standards (FMVSS) for vehicles within a 
safety class SC and weight threshold T.  The FMVSSSC,T adjustment in equation (36) above is 
employed to account for the fact that vehicles involved in future crashes will be certified to more 
stringent safety standards than those involved with past crashes upon which the base rates of 
involvement in fatal crashes were estimated. 
 
Since the use of mass reducing technology is present within the model, safety impacts may also 
be observed whenever a vehicle’s base weight decreases.  Thus, in addition to computing total 
fatalities related to vehicle use, the modeling system also estimates changes in fatalities due to 
reduction in vehicle’s curb weight.  These changes are computed for vehicles of model year MY, 
belonging to safety class SC and weight threshold T as: 
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Where, VMTMY,SC,T, BASESC,T, and FMVSSSC,T are as defined for equation (36) above, ∆CW is the 
amount by which the vehicle’s curb weight decreases, and EffectSC,T is the percentage by which 
fatalities change for every 100 lbs. that a vehicle’s curb weight is reduced for vehicles within a 
safety class SC and weight threshold T.  Equation (37) is applied directly as long as the vehicle’s 
initial and final curb weights place it within the same weight threshold.  In the event that mass 
reduction causes the vehicle to cross the threshold boundary, equation (37) is applied in two 
steps, where a portion of the ∆CW reduced (up to the threshold boundary) uses the EffectMY,SC,T, 
BASESC,T, and FMVSSSC,T coefficients from the vehicle’s initial weight threshold, and a portion 
of the ∆CW reduced (beyond the threshold boundary) uses the coefficients from the vehicle’s 
new weight threshold. 
 
The total fatalities attributed to vehicle use and vehicle weight change for vehicles of model year 
MY, belonging to safety class SC and weight threshold T are, hence, defined as the sum of the 
two components: 
 
்,ெ௒,ௌ஼ܨ 

்௢௧௔௟ ൌ ்,ெ௒,ௌ஼ܨ ൅ ்,ெ௒,ௌ஼ܨ
∆஼ௐ  (38) 



DRAFT 

41 

 
Lastly, total fatalities occurring within the industry in model year MY are accumulated across all 
vehicles belonging to safety classes SC and weight thresholds T as: 
 
ெ௒ܨ 
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 (39) 

 
The safety classes, weight thresholds, EffSC,CW, FMVSSSC,CW and BASESC,CW variables are derived 
from Dr. Chuck Kahane’s 2012 study and are specified as inputs to the model, defined in the 
parameters input file.31 
 
In addition to using inputs to estimate the future involvement of modeled vehicles in crashes 
involving fatalities, the model also applies inputs defining other accident-related externalities 
estimated on a dollar per mile basis, as discussed below in S7.1.7.  

                                                 
31 Kahane, C. J. (2012). “Relationships Between Fatality Risk, Mass, and Footprint in Model Year 2000-2007 
Passenger Cars and LTVs – Final Report,” DOT HS 811-665 is in NHTSA-2010-0131-0336 and will also be in 
docket NHTSA-2010-0152. You can access the docket at http://www.regulations.gov/ by typing ‘NHTSA-
20100152’ where it says “enter keyword or ID” and then clicking on “search.” 



DRAFT 

42 

Section 7 Private versus Social Costs and Benefits 
 
Improving the fuel efficiency of new vehicles produces a wide range of benefits and costs, many 
of which affect buyers of those vehicles directly.  Depending upon how manufacturers attempt to 
recoup the costs they incur for improving the fuel efficiency of selected models, buyers are likely 
to face higher prices for some – and perhaps even most – new vehicle models.  Purchasers of 
models whose fuel economy is improved benefit from the resulting savings in the cost of fuel 
their vehicles consume, from any increase in the range they can travel before needing to refuel, 
and from the added driving they do as a result of the rebound effect.  Depending on the 
technology manufacturers use to improve fuel economy and its consequences for vehicle power 
and weight, these benefits may be partly offset by a slight decline in the performance of some 
new models. 
 
At the same time, the reduction in fuel production and use resulting from improved fuel economy 
produces certain additional benefits and costs to society as a whole.  Potential social benefits 
from reduced fuel use include any value that society or the U.S. economy attaches to saving fuel 
over and above its private value to new vehicle buyers, lower emissions of air pollutants and 
greenhouse gases generated from fuel production, distribution, and consumption, and reduced 
economic costs associated with U.S. imports of crude petroleum and refined fuel.  By causing 
some additional driving through the rebound effect, improving fuel economy can also increase a 
variety of social costs, including the economic value of health effects and property damages 
caused by increased air pollution, the value of time delays to motorists from added traffic 
congestion, added costs of injuries and property damage resulting from more frequent traffic 
accidents, and economic costs from higher levels of traffic noise. 
 
The following sections discuss how each of these benefits and costs can result from improving 
the fuel economy of new vehicles, the factors affecting their likely magnitudes, and how their 
values are commonly measured or estimated.  Section A.3 of Appendix A provides examples of 
specific unit economic values and other parameters used to estimate the aggregate value of these 
various benefits and costs, and explains how these sample values were derived. 
 
S7.1 Benefits and Costs to New Vehicle Buyers 
 
S7.1.1 Increases in New Vehicle Prices 
 
Depending upon how manufacturers attempt to recover the costs they incur in complying with 
CAFE regulations, purchase prices for some new models are likely to increase.  Because we 
assume that manufacturers fully recover all costs they incur for installing fuel economy 
technologies to comply with CAFE in the form of higher prices for some models, the total 
increase in vehicle sales prices has already been accounted for in estimating technology costs to 
manufacturers.  Nevertheless, the total value of these price increases represent a cost of CAFE 
regulation from the viewpoint of buyers of vehicle models whose prices rise. 
 
In addition to increases in the prices paid by buyers who elect to purchase these models even at 
the higher price points, higher prices result in losses in welfare or consumer surplus to buyers 
who decide to purchase different models instead.  These losses are extremely complex to 
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estimate if prices change for a large number of models, and in any case are likely to be small 
even in total.  Thus we do not attempt to estimate their value. 
 
S7.1.2 The Value of Fuel Savings 
 
The CAFE modeling system estimates the economic value of fuel savings to buyers of new 
vehicle models whose fuel economy is improved by applying the forecast (an input to the model) 
of future retail fuel prices to each year’s estimated fuel savings for those models.  The annual 
fuel savings for a model during each year of its lifetime in the vehicle fleet is multiplied by the 
number of those initially sold that are expected to remain in use during that year to determine the 
total annual value of fuel savings to buyers of that model. 
 
The forecast retail price of fuel per gallon – including federal and average state fuel and other 
taxes – during that year is used to estimate the value of these fuel savings as viewed from the 
perspective of their buyers.  Based on evidence from previous studies of consumer purchases of 
automobiles and durable appliances, we assume that new vehicle buyers value these savings over 
the approximate number of years (an input to the model) they expect to own a new vehicle, and 
that they discount these expected savings to the year in which they purchase new vehicles. 
 
S7.1.3 Benefits from Additional Driving 
 
The rebound effect also results in additional benefits to new vehicle buyers in the form of 
consumer surplus from the increased driving it produces.  These benefits arise from the value to 
drivers and passengers of the social and economic opportunities made available to them by 
additional traveling.  As evidenced by the fact that they elect to make more frequent or longer 
trips when improved fuel economy reduces the cost of driving, the benefits from this additional 
travel exceed the costs drivers and their passengers incur in making more frequent or longer 
trips.  The amount by which these benefits from additional travel exceed its cost to them – which 
has been reduced by improved fuel economy – represents the increase in consumer surplus 
associated with additional rebound effect driving. 
 
The system estimates the value of these benefits using the conventional approximation of one 
half of the product of the decline in fuel cost per mile driven and the resulting increase in the 
annual number of miles driven.  This value is calculated for each year that a model whose fuel 
economy is improved remains in the fleet, multiplied by the number of vehicles of that model 
expected to remain in use during each year of its lifetime, and discounted to its present value as 
of the year it was purchased.  Given typical input values (e.g., for fuel prices), this benefit is 
relatively small by comparison to most other economic impacts of raising CAFE standards. 
 
S7.1.4 The Value of Extended Refueling Range 
 
Manufacturers’ efforts to improve the fuel economy of selected new vehicle models will also 
increase their driving range per tank of fuel.  By reducing the frequency with which drivers 
typically refuel their vehicles, and by extending the upper limit of the range they can travel 
before requiring refueling, improving fuel economy thus provides some additional benefits to 
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their owners.32  No direct estimates of the value of extended vehicle range are readily available, 
so the CAFE model calculates the reduction in the annual number of required refueling cycles 
that results from improved fuel economy.  The change in required refueling frequency for 
vehicle models with improved fuel economy reflects the increased driving associated with the 
rebound effect, as well as the increased driving range stemming from higher fuel economy. 
 
S7.1.5 Changes in Performance and Utility 
 
The system currently assumes that the costs and effects of fuel-saving technologies reflect the 
application of these technologies in a manner that holds vehicle performance and utility constant.  
Therefore, the system currently does not estimate changes in vehicle performance or utility. 
 
S7.1.6 Social Benefits and Costs from Increased Fuel Economy 
 
S7.1.6.1 The “Social Value” of Fuel Savings 
 
The economic value to society of the annual fuel savings resulting from stricter CAFE standards 
is also assessed by applying estimated future fuel prices to each year’s estimated fuel savings.  
Unlike the value of fuel savings to vehicle buyers themselves, however, the pre-tax price per 
gallon is used in assessing the value of fuel savings to the economy as a whole.  This is because 
reductions in payments of state and federal taxes by purchasers of fuel will be exactly offset by 
reduced spending on the construction and maintenance of streets and highways that fuel taxes are 
mainly used to finance, and thus do not reflect a net savings in resources to the economy. 
 
When estimating the nationwide aggregate economic benefits and costs from CAFE regulation, 
we include this “social” value of fuel savings rather than their private value to vehicle buyers.  In 
computing the social value of fuel savings, we include their annual value over the entire 
expected lifetimes of vehicle models whose fuel economy is improved, reflecting the presumably 
longer-term horizon of society as a whole compared to that of vehicle buyers, who may be 
concerned with fuel savings only over the time they expect to own newly-purchased vehicles. 
 
S7.1.6.2 Economic Benefits from Reduced Petroleum Imports 
 
Importing petroleum into the United States is widely believed to impose significant costs on 
households and businesses that are not reflected in the market price for imported oil, and thus are 
not borne by consumers of refined petroleum products.  These costs include three components: 
(1) higher costs for oil imports resulting from the combined effect of U.S. import demand and 
OPEC market power on the world oil price; (2) the risk of reductions in U.S. economic output 
and disruption of the domestic economy caused by sudden reductions in the supply of imported 
oil; and (3) costs for maintaining a U.S. military presence to secure imported oil supplies from 
unstable regions, and for maintaining the Strategic Petroleum Reserve (SPR) to cushion against 
price increases.  By reducing domestic demand for gasoline, tighter CAFE standards can reduce 
petroleum imports, and thus reduce these social costs to the extent that their magnitude varies 

                                                 
32 If manufacturers instead respond to improved fuel economy by reducing the size of fuel tanks to maintain a 
constant driving range, the resulting savings in costs will presumably be reflected in lower sales prices. 
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with the volume of U.S. oil imports.  Any reduction in their magnitude represents an additional 
category of economic benefits from tighter fuel economy standards. 
 
In this analysis, the reduction in petroleum imports resulting from higher CAFE standards is 
estimated by assuming that the resulting savings in gasoline use during each future year is 
translated directly into a corresponding reduction in the annual volume of U.S. oil imports during 
that same year.  The value to the U.S. economy of reducing petroleum imports – in the form of 
lower crude oil prices and reduced risks of oil supply disruptions – is estimated by applying the 
sum of the previously reported estimates of these benefits to the estimated annual reduction in oil 
imports. 
 
S7.1.6.3 Valuing Changes in Environmental Impacts 
 
The CAFE modeling system estimates the economic value of the net change in emissions of 
criteria pollutants, including carbon monoxide, volatile organic compounds, nitrogen oxides, 
sulfur dioxide, and fine particulates, using estimates of the economic damage costs per ton of 
emissions of each of these pollutants.  As indicated previously, emissions of criteria pollutants 
can rise or fall when fuel economy increases, so the economic costs of these emissions can 
increase or decline in response to higher CAFE standards. 
 
The model estimates changes in damage costs caused by carbon dioxide emissions by 
multiplying the magnitude of the change in emissions by the estimated value of damages per unit 
of emissions. 
 
S7.1.7 Social Costs of Added Driving 
 
In addition to increasing emissions of criteria pollutants, any added driving associated with the 
fuel economy rebound effect may contribute to increased traffic congestion, motor vehicle 
accidents, and highway noise.  Additional vehicle use can contribute to traffic congestion and 
delays partly by increasing recurring congestion on heavily-traveled facilities during peak travel 
periods, depending on how the additional travel is distributed over the day and on where it 
occurs.  Added driving can also increase the frequency of incidents such as collisions and 
disabled vehicles that cause prolonged delays, although the extent to which it actually does do 
will again depend partly on when and where the added travel occurs.  Finally, added vehicle use 
from the rebound effect may also increase traffic noise, which causes inconvenience, irritation, 
and potentially even discomfort to occupants of other vehicles, pedestrians and other bystanders, 
and residents or occupants of surrounding property. 
 
The CAFE modeling system uses estimates of the increases in external costs – that is, the 
marginal social costs – from added congestion, property damages and injuries in traffic 
accidents, and noise levels caused by additional vehicle usage.  It does so by applying estimates 
of the increases in these costs that result from each added mile of travel by different types of 
vehicles (passenger and nonpassenger automobiles) to the increase in the total number of miles 
driven projected to result from the rebound effect. 
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In addition to external costs, the modeling system also computes costs associated with the 
cleanup of fatal crashes, attributed to increases in total miles driven and the application of mass 
reduction technology. 
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Appendix A Model Inputs 
 
The CAFE Model utilizes a set of data files used as input to the analysis.  All input files are 
specified in Microsoft® Excel format and are outline in Table 4 below.  The user can define and 
edit all inputs to the system.  For example, the system does not require market data constructed 
using confidential business information. 
 

Table 4. Input Files 
Input File Contents 

Market Data 
(Manufacturers Worksheet) 

Contains an indexed list of manufacturers available during the study period, along 
with manufacturer’s willingness to pay fines and other manufacturer-specific 
modeling settings. 

Market Data 
(Vehicles Worksheet) 

Contains an indexed list of vehicle models available during the study period, along 
with sales volumes, fuel economy levels, prices, regulatory classification, references 
to specific engines and transmissions used, and settings related to technology 
applicability. 

Market Data 
(Engines Worksheet) 

Contains an indexed list of engines available during the study period, along with 
various engine attributes and settings related to technology applicability. 

Market Data 
(Transmissions Worksheet) 

Contains an indexed list of transmissions available during the study period, along 
with various transmission attributes and settings related to technology applicability. 

Technologies 
Specifies estimates of the availability, cost, and effectiveness of various 
technologies, specific to various vehicle categories. 

Parameters 

Provides inputs used to calculate travel demand, fuel consumption, carbon dioxide 
and criteria pollutant emissions (upstream and downstream), and economic 
externalities related to highway travel and petroleum consumption. Additionally, 
starting with this revision of the model, the parameters input file contains inputs 
necessary for performing fleet analysis for the EIS. 

Scenarios 
Specifies coverage, structure, and stringency of CAFE standards for scenarios to be 
simulated. 
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A.1 Market Data File 
 
The market data file contains four worksheets:  Manufacturers, Vehicles, Engines and 
Transmissions.  Taken together, the manufacturers, vehicle models, engines, and transmissions 
worksheets provide “initial state” historical and/or forecast data for the vehicle fleet.  The 
sections below describe each worksheet in greater detail. 
 
A.1.1 Manufacturers Worksheet 
 
The manufacturers input worksheet contains a list of all manufacturers that produce vehicle 
models offered for sale during the study period.  Each manufacturer has a unique code and is 
represented by a unique manufacturer name.  For each manufacturer, the manufacturer code, 
name, cost allocation strategy, discount rate, payback periods, and willingness to pay CAFE 
fines must all be specified.  Available credits, if applicable, should be expressed in vehicle-mpg 
and is applied directly as a credit (positive or negative) to the CAFE level for the given 
manufacturer in the given model year.  If no available credits are to be specified, a value of zero 
can be used or the cell can be left blank. 
 

Table 5. Manufacturers Worksheet 
Category Column Units Definition/Notes 

G
en

er
al

 

Manufacturer Code integer Unique number assigned to each manufacturer. 
Manufacturer Name text Name of the manufacturer. 

Cost Allocation 
Strategy 

integer 

The cost allocation strategy the manufacturer will use for allocating costs. 
  0 = allocate technology costs on an as-incurred basis 
  1 = distribute technology costs and fines based on the share of aggregate sales revenue
  2 = not used 
  3 = distribute technology costs and fines evenly 

Discount Rate number 
Represents the manufacturer specific discount rate, which factors into the effective cost 
calculation. 

Payback Period number 
The number of years required for an initial investment to be repaid in the form of future 
benefits or cost savings. 

Payback Period 
(After Compliance) 

number The payback period to use after the manufacturer reached compliance. 

Optimize text 
Y = consider the manufacturer during optimization 
N = do not consider the manufacturer during optimization 
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2011 text 
Represents the manufacturer's willingness to pay fines. 
  Y = pay fines instead of applying ineffective technologies 
  N = apply ineffective technologies instead of paying fines 

2012 text 
… 
2029 text 
2030 text 
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) 2011 vehicle-mpg 

Represents the manufacturer's available credits towards CAFE compliance for vehicles 
regulated as Passenger Cars. 

2012 vehicle-mpg 
… 
2029 vehicle-mpg 
2030 vehicle-mpg 

A
va

il
ab

le
 

L
ig

ht
 T

ru
ck

 
C

re
di

ts
 (

m
pg

) 2011 vehicle-mpg 

Represents the manufacturer's available credits towards CAFE compliance for vehicles 
regulated as Light Trucks. 

2012 vehicle-mpg 
… 
2029 vehicle-mpg 
2030 vehicle-mpg 

A
va

il
ab

le
 

L
ig

ht
 T

ru
ck

 
2b

/3
 C

re
di

ts
 

(m
pg

) 

2011 vehicle-mpg 

Represents the manufacturer's available credits towards CAFE compliance for vehicles 
regulated as class 2b/3 Trucks. 

2012 vehicle-mpg 
… 
2029 vehicle-mpg 
2030 vehicle-mpg 

Credits Apply to Baseline text 
Y = apply manufacturer's credits to the baseline scenario 
N = do not apply manufacturer's credits to the baseline scenario 
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A.1.2 Vehicles Worksheet 
 
The vehicles worksheet contains information regarding each vehicle model offered for sale 
during the study period.  Each vehicle model is represented as a single row of input data.  Data in 
Table 6 and Table 7 list the different columns of information specified in the vehicle models file.  
To make the information readable, the Vehicle Models tables are divided into sections. 
 

Table 6. Vehicles Worksheet (1) 
Category Column Units Definition/Notes 
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Vehicle Code integer Unique number assigned to each vehicle. 
Manufacturer text The manufacturer of the vehicle. 
Model text Name of the vehicle model. 
Nameplate text The nameplate of the vehicle. 
Platform text The platform of the vehicle. 
Engine Code integer The engine code of the engine that the vehicle uses. 
Transmission Code integer The transmission code of the transmission that the vehicle uses. 
Origin text D = domestic; I = imported 

F
ue

l 
E
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no

m
y 

Fuel Economy (by 
Fuel Type33) 

number The CAFE fuel economy rating of the vehicle for each fuel type. 

Fuel Share (by Fuel 
Type33) 

number 
The percent share that the vehicle runs on each fuel type.  This value indicates the amount 
of miles driven by the vehicle on each fuel type.  The sum of all fuel shares for any given 
vehicle must add up to one. 

S
al

es
 

MY2010 units 

Vehicle's projected production for sale in the US. 
MY2011 units 

… 
MY2029 units 
MY2030 units 

M
S

R
P

 

MY2010 dollars 

Vehicle's projected average MSRP (sales-weighted, including options). 
MY2011 dollars 

… 
MY2029 dollars 
MY2030 dollars 
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Regulatory Class text 

The regulatory assignment of the vehicle. 
  PC = the vehicle should be regulated as a passenger automobile 
  LT = the vehicle should be regulated as a light truck 
  LT2b3 = the vehicle should be regulated as a class 2b/3 truck 

Technology Class text The technology class of the vehicle. 

Safety Class text 

The safety class assignment of the vehicle. 
  PC = the vehicle belongs to a passenger automobile safety class 
  LT = the vehicle belongs to a light truck/SUV safety class 
  CM = the vehicle belongs to a light CUV/minivan safety class 

V
eh
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le
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Class text Vehicle class. 
Style text Vehicle style. 
Structure text Vehicle structure (ladder or unibody). 

Drive text 
Vehicle drive (A=all-wheel drive, F=front-wheel drive, R=rear-wheel drive, 4=four-wheel 
drive). 

Footprint sq. feet The vehicle footprint; wheelbase times average track width. 

Curb Weight pounds 
Total weight of the vehicle, including batteries, lubricants, and other expendable supplies, 
but excluding the driver, passengers, and other payloads (SAE J1100). 

GVWR pounds Gross Vehicle Weight Rating; weight of loaded vehicle, including passengers and cargo. 

GCWR pounds 
Gross Combined Weight Rating; weight of loaded vehicle, including passengers and cargo, 
as well as the mass of the trailer and cargo in the trailer. 

Max GVWR/CW proportion 
Maximum ratio of GVWR to Curb Weight allowed for the vehicle.  During application of 
mass reduction technology, vehicle's GVWR will be adjusted such that its GVWR/CW 
ratio does not exceed this value. 

Max GCWR/GVWR proportion 
Maximum ratio of GCWR to GVWR allowed for the vehicle.  During application of mass 
reduction technology, vehicle's GVWR will be adjusted such that its GVWR/CW ratio does 
not exceed this value. 

                                                 
33 For each vehicle, fuel economies and fuel shares are reported independently for each of the following fuel types:  
gasoline, E85, diesel, B20, electricity, hydrogen, CNG, LNG, and LPG.  If the vehicle does not use a specific fuel 
type, the associated fuel economy and fuel share values will be zero. 
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Seating (Max) integer 
The number of usable seat belts before folding and removal of seats (where accomplished 
without specific tools). 

Fuel Capacity gallons 
The capacity of the vehicle's fuel tank in gallons of diesel fuel or gasoline; MJ (LHV) of 
other fuels (or chemical battery energy). 

H
yb
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Type of 
Hybrid/Electric 
Vehicle 

text Hybridization type of the vehicle, if any. 

Electric Power number The power rating (equivalent to engine horsepower) for an electric vehicle. 
Electric Range number The range of an electric vehicle, in miles, when operating on a battery. 

P
la
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model 
year 

List of previous and future refresh years of the vehicle, separated by a semicollon. 

Redesign Year 
model 
year 

List of previous and future redesign years of the vehicle, separated by a semicollon. 

Employment Hours 
per Vehicle 

hours Employment hours associated with the production of each vehicle model. 

 
The applicability of technologies considered on a vehicle model basis (as opposed, for example, 
on an engine basis) can be controlled for each vehicle model by using the “Technology 
Applicability” category.  Since the modeling system relies heavily on these settings when 
determining the initial usage and availability of technology to a vehicle, this section must be 
complete and accurate in order to avoid modeling errors. 
 

Table 7. Vehicles Worksheet (2) 
Category Column Units Definition/Notes 
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EPS text 

<blank> = the technology is not used on the vehicle 
USED = the technology is used on the vehicle 
SKIP = the technology is not applicable to the vehicle 

IACC1 text 
IACC2 text 
MHEV text 
ISG text 
SHEV1 text 
SHEV1_2 text 
SHEV2 text 
PHEV1 text 
PHEV2 text 
EV1/EV2/EV3/EV4 text 
FCV text 
MR1/MR2/MR3/MR4/MR5 text 
ROLL1/ROLL2/ROLL3 text 
LDB text 
SAX text 
AERO1 text 
AERO2 text 

 
A.1.3 Engines Worksheet 
 
Similar to the vehicles input sheet, the engines worksheet contains a list of all engines used in 
vehicle models offered for sale during the study period.  For each manufacturer, the engine code 
is a unique number assigned to each such engine.  This code is referenced in the engine code 
field on the vehicles worksheet.  As in the vehicles worksheet, the technology applicability for 
any engine technology must be complete and accurate for any specific engine. 
 

Table 8. Engines Worksheet 
Category Column Units Definition/Notes 

G
en
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Engine Code integer Unique number assigned to each engine. 
Manufacturer text The manufacturer of the engine. 
Configuration text Configuration of the engine. 

Fuel text 
One or more fuel types with which the engine is compatible: 
G = gasoline only; D = diesel only; E85 = ethanol-85 only; G+E85 = 
flex fuel engine, running on gasoline and ethanol-85 
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Engine Oil Viscosity text 
Ratio between the applied shear stress and the rate of shear, which 
measures the resistance of flow of the engine oil (as per SAE Glossary 
of Automotive Terms). 

Cycle text Combustion cycle of the engine. 
Fuel Delivery System text The mechanism that delivers fuel to the engine. 

Aspiration text 
Breathing or induction process of the engine (as per SAE Automotive 
Dictionary). 

Valvetrain Design text 
Design of the total mechanism from camshaft to valve of an engine that 
actuates the lifting and closing of a valve (as per SAE Automotive 
Dictionary). 

Valve Actuation/Timing text Valve opening and closing points in the operating cycle (SAE J604). 

Valve Lift text 
The manner in which the valve is raised during combustion (as per 
SAE Automotive Dictionary). 

Cylinders integer Number of engine cylinders. 
Valves/Cylinder integer Number of valves per cylinder. 
Deactivation text Weighted (FTP+highway) aggregate degree of deactivation. 
Displacement liters Total volume displaced by a piston in a single stroke. 
Max. Horsepower number Maximum horsepower of the engine (horsepower). 
Max. Torque number Maximum torque of the engine (pound-foot). 

C
la
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n

s Engine Size text 

The relative size of the engine, with respect to technology application.  
Allowed values are: 
  SD or Small = a small sized engine 
  MD or Medium = a medium sized engine 
  LD or Large = a large sized engine 
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LUB1 text 

<blank> = the technology is not used on the engine 
USED = the technology is used on the engine 
SKIP = the technology is not applicable to the engine 

EFR1 text 
LUB2_EFR2 text 
CCPS text 
DVVLS text 
DEACS text 
ICP text 
DCP text 
DVVLD text 
CVVL text 
DEACD text 
SGDI text 
DEACO text 
VVA text 
SGDIO text 
TRBDS1 text 
SEGR text 
DWNSP text 
TRBDS2 text 
CEGR1 text 
CEGR2 text 
MILLER text 
LGDI text 
CNG text 
LNG text 
LPG text 
DSL text 
DTURB text 
EFRD text 
DDOWN text 
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A.1.4 Transmissions Worksheet 
 
Similar to the vehicles and engines input sheets, the transmissions worksheet contains a list of all 
transmissions used in vehicle models offered for sale during the study period.  For each 
manufacturer, the transmission code is a unique number assigned to each such transmission.  
This code is referenced in the transmission code field on the vehicles worksheet.  As in the 
vehicles worksheet, the technology applicability for any transmission technology must be 
complete and accurate for any specific transmission. 
 

Table 9. Transmissions Worksheet 
Category Column Units Definition/Notes 

G
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 Transmission Code integer Unique number assigned to each transmission. 
Manufacturer text The manufacturer of the transmission. 
Type text Type of the transmission. 
Number of Forward Gears integer Number of forward gears the transmission has. 
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6MAN text 

<blank> = the technology is not used on the transmission 
USED = the technology is used on the transmission 
SKIP = the technology is not applicable to the transmission 

HETRANSM text 
IATC text 
NAUTO text 
DCT text 
8SPD text 
HETRANS text 
SHFTOPT text 
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A.2 Technologies File 
 
The technologies input file contains assumptions regarding the fuel consumption benefit, cost, 
applicability, and availability of different vehicle, engine, and transmission technologies during 
the study period.  Input assumptions are specific to each of the following vehicle technology 
classes:  subcompact cars, subcompact performance cars, compact cars, compact performance 
cars, midsize cars, midsize performance cars, large cars, large performance cars, minivans, small 
pickups and SUVs, midsize pickups and SUVs, large pickups and SUVs, class 2b/3 pickups, and 
class 2b/3 vans.  Input assumptions that are common among all technology classes are listed on a 
separate technologies definitions tab.  Table 10 shows the contents of a technologies definitions 
tab for all classes while Table 11 shows the contents of the technology assumptions tabs. 
 

Table 10. Technologies Definitions 
Category Column Units Definition/Notes 

G
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Num. integer Unique number assigned to each technology. 
Technology text Name of the technology. 
Abbr. text Abbreviation of the technology. 

TechType text 

The group of a technology: 
  EngMod = the type of the technology is engine modification 
  DslMod = the type of the technology is diesel engine modification 
  TrnMod = the type of the technology is transmission modification 
  ELEC = the type of the technology is electric system improvement 
  MR = the type of the technology is mass reduction 
  ROLL = the type of the technology is rolling resistance tires 
  DLR = the type of the technology is dynamic load reduction 
  AERO = the type of the technology is aerodynamics modification 

O
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Off-Cycle 
Credit PC 

gram per mile 
Amount of off-cycle credit that the vehicles incur as a result of applying the technology.
Specified in grams per mile of CO2 for each regulatory class. 

Off-Cycle 
Credit LT 
Off-Cycle 
Credit LT 2b/3 

P
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PV-1 percentage 

Percentage of the entire fleet to which the technology may be applied. 
PV-2 percentage 

… 
PV-16 percentage 
PV-17 percentage 

 
The technologies are organized into technology groups specified by the TechType column.  Each 
technology group is populated with specific technologies following the sequence specified by the 
“Num.” column.  The modeling system also follows this sequence as it evaluates technologies 
for applicability.  The sequence of engine and transmission technologies may be split to follow 
slightly different paths, based on the original vehicle, engine, or transmission characteristics, or 
depending on which technologies have already been applied to a vehicle.  For example, if the 
original vehicle uses a manual transmission with fewer than six gears, the available technologies 
would be the 6-speed manual transmission and high efficiency gearbox (HETRANSM).  If the 
original vehicle, however, starts out with a 5-speed automatic transmission, the technologies 
applied would follow the following path: IATC, 6-speed automatic transmission (NAUTO), 6-
speed DCT, 8-speed automatic transmission, high efficiency gearbox (HETRANS), and shift 
optimizer (SHFTOPT). 
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Table 11. Technologies Assumptions 
Category Column Units Definition/Notes 

G
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Num. integer Unique number assigned to each technology. 

Abbr. text 

Abbreviation of the technology.  For engine technologies that differ based on the 
relative size of the engine, an "_SD", "_MD", or "_LD" suffix may be used to 
indicate the technology cost and effectiveness values are specified for a small, 
medium, or large engine. 

TechType text The group of a technology. 

A
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y Applicable boolean 
TRUE = the technology is available for applicability in a technology class 
FALSE = the technology is not available for applicability in a technology class 

Year 
Avail. 

model year First year the technology is available for applicability. 

Year 
Retired 

model year Last year the technology is available for applicability. 

M
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s Electric  
Range 

number 
What the range, in miles, of an electric vehicle would be when operating on a 
battery, as a result of applying the technology; applies to PHEV and EV 
technologies only. 

Delta 
Weight (%) 

percentage 
Percentage by which the vehicle's weight changes as a result of applying the 
technology. 

Delta 
Weight (lbs) 

number 
Amount of pounds by which the vehicle's weight changes as a result of applying 
the technology. 

Loss of Value dollars The consumer welfare loss associated with application of the technology. 
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FC percentage Fuel consumption improvement estimate of the technology. 

Primary 
Fuel Share 

percentage 
Percentage of miles the vehicle is expected to travel on the primary fuel after 
applying the technology (applicable when a vehicle is being converted into a 
plug-in HEVs or another form of dual fuel vehicle). 

C
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 Cost 2009 dollars 

Table of learned out cost estimates for the technology, per model year. 
Cost 2010 dollars 

… 
Cost 2024 dollars 
Cost 2030 dollars 

M
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 Maint. 2009 dollars 

Table of learned out maintenance cost estimates for the technology, per model 
year. 

Maint. 2010 dollars 
… 

Maint. 2024 dollars 
Maint. 2030 dollars 

R
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 Repair 2009 dollars 

Table of learned out repair cost estimates for the technology, per model year. 
Repair 2010 dollars 

… 
Repair 2024 dollars 
Repair 2030 dollars 
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SC-1 dollars 

Penalty costs associated with replacing (or superseding) a technology early. 
SC-2 dollars 

… 
SC-9 dollars 
SC-10 dollars 

 
A.2.1 Technology Synergies 
 
Technology synergies occur when the combined effect of two technologies is greater than (or 
less than) the fuel consumption reduction for the two technologies combined.  To support 
synergies, the technology input file has synergy sections for cost and fuel improvements. 
Contents of the synergy tables are shown in Table 12 below. 
 
The synergy table is most commonly used for synergistic interactions in vehicle technologies 
from differing technology groups (e.g., between engine technologies and transmission 
technologies).  Synergies within a technology group are already built into the cost and fuel 
reduction values for the technologies.  Therefore, in-group synergies are not likely to occur, 
unless special circumstances arise, such as branching of technology paths. 
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Table 12. Technology Synergies 
Category Column Units Definition/Notes 
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Type text 

The synergy type relation between two technologies.  The “accounting” 
type indicates that the synergy relation between two technologies is to 
provide accounting adjustments for the decision trees and is the only 
synergy type applied to technology costs.  The “physical” type indicates 
that the synergy relation between two technologies is to address physical 
energy losses. 

Technology A text 

Abbreviation of the first technology in a synergy pair.  For engine 
technologies that differ based on the relative size of the engine, an "_SD", 
"_MD", or "_LD" suffix may be used to indicate the technology synergy 
values are specified for a small, medium, or large engine. 

Technology B text 

Abbreviation of the second technology in a synergy pair.  For engine 
technologies that differ based on the relative size of the engine, an "_SD", 
"_MD", or "_LD" suffix may be used to indicate the technology synergy 
values are specified for a small, medium, or large engine. 
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Subcompact PC 

percentage 
Values to offset the technology cost or fuel consumption when either of 
technology A or B is being applied when the other is already installed. 

Subcompact Perf. PC 
Compact PC 
Compact Perf. PC 
Midsize PC 
Midsize Perf. PC 
Large PC 
Large Perf. PC 
Minivan LT 
Small LT 
Midsize LT 
Large LT 

 Truck 2b3 
 Van 2b3 

 
When a technology is being applied (or is being tested for application), a lookup is performed in 
the “Technology A” and “Technology B” columns of the table.  If found, the vehicle is examined 
to determine if the paired technology (or technologies) have been applied (or are installed as part 
of the base vehicle definition).  If so, the offset value for the applicable vehicle class is obtained, 
summed, and applied to the cost or fuel consumption reduction of the technology being 
examined. 
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A.3 Parameters File 
 
The benefits model parameters file contains a variety of input data and assumptions used to 
estimate various impacts of the simulated response of the industry to CAFE standards.  The file 
contains a series of worksheets, the contents of which are summarized below. 
 
A.3.1 Vehicle Age Data 
 
The Vehicle Age Data worksheet contains age-specific (i.e., vintage-specific) estimates of the 
survival rate and annual accumulated mileage applicable to different vehicle categories. 
 

Table 13. Vehicle Age Data Worksheet 
Category Model Characteristic Units Definition/Notes 
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Survival Rates proportion 
Proportion of original vehicle sales that remain in service by 
vehicle age (year 1 to 30 for cars, 1 to 37 for trucks). 

Miles Driven miles 
Average annual miles driven by surviving vehicles by vehicle 
age (year 1 to 30 for cars, 1 to 37 for trucks). 

 
Separate survival fractions and annual miles driven are used for cars, vans, SUVs, pickups, and 
class 2b/3 trucks.  The survival fractions measure the proportion of vehicles originally produced 
during a model year that remain in service at each age, by which time only a small fraction 
typically remain in service. 
 
A.3.2 Forecast Data 
 
The Forecast Data worksheet contains estimates of future fuel prices, which are used when 
calculating pre-tax fuel outlays and fuel tax revenues. 
 

Table 14. Forecast Data Worksheet 
Category Model Characteristic Units Definition/Notes 
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Retail Fuel Prices 
(low, average, high) 

$/gallon 
2012 $ per gallon, varies by fuel type, forecast by calendar year 
staring with MY-1975. 

Fuel Taxes $/gallon 
2012 $ per gallon, varies by fuel type, forecast by calendar year 
staring with MY-2000. 

 
A.3.3 Fuel Economy Data 
 
The Fuel Economy Data worksheet contains historic and projected fuel economy levels for 
passenger cars and light trucks, for each fuel type (gasoline, diesel, ethanol-85, electricity, and 
hydrogen).  The associated fuel shares are also provided. 
 

Table 15. Fuel Economy Data Worksheet 
Category Model Characteristic Units Definition/Notes 
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Fuel Economy 
(by Fuel Type and Fleet) 

mpg 
Historic and projected fuel economy levels for each 
available fuel type and fleet type. 

Fuel Share 
(by Fuel Type and Fleet) 

percentage 
Historic and projected fuel shares for each available fuel 
type and fleet type. 
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A.3.4 Economic Values 
 
The Economic Values worksheet contains an estimate of the magnitude of the “rebound effect”, 
as well as the rates used to compute the economic value of various direct and indirect impacts of 
CAFE standards, and the discount rate to apply when calculating present value.  As mentioned 
above, the user can define and edit all inputs.  For example, although the economic values in 
Table 16 were obtained from various sources of information, the system does not require that the 
user rely on these sources. 
 

Table 16. Economic Values Worksheet 
Category Model Characteristic Units Definition/Notes 
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Rebound Effect percentage 
Increase in the annual use of vehicle models in response to lower per-mile cost 
of driving a more fuel-efficient vehicle. 

Discount Rate percentage 
Percent rate by which the dollar value of a benefit or cost is reduced when its 
receipt or payment is postponed by one additional year into the future; used for 
calculating socially-valued benefits. 

Base Year for Discounting percentage 

The calendar year to use for "present year" discounting. If a base year value is 
used, social discounting is assumed, with all costs and benefits being 
discounted to that year. If no value is specified, private discounting is implied, 
with all costs and benefits being discounted to the model year being analyzed. 

Annual Growth Rate for 
Average VMT per Vehicle 

various Annual growth rate for average VMT per vehicle. 

Base Year for Average 
Annual Usage Data 

model year Base year for annual growth rate for average VMT per vehicle. 

Growth Rate at Low 
Fuel Price 

percentage Annual growth rate for average VMT per vehicle, when using low fuel prices. 

Growth Rate at Average 
Fuel Price 

percentage 
Annual growth rate for average VMT per vehicle, when using average fuel 
prices. 

Growth Rate at High 
Fuel Price 

percentage Annual growth rate for average VMT per vehicle, when using high fuel prices. 

"Gap" between Test and On-
Road MPG (by Fuel Type) 

percentage 
Difference between a vehicle's EPA fuel economy rating and its actual on-road 
fuel economy. 

Fixed Component of Average 
Refueling Time in Minutes 
(by Fuel Type) 

minutes 
Average refueling time a spent by a consumer refueling the vehicle tank or 
recharging the vehicle electric battery. 

Average Tank Volume 
Refueled 

percentage Average tank volume refilled during a refueling stop. 

Value of Travel Time per 
Vehicle 

$/hour 
Amount that the driver of a vehicle would be willing to pay to reduce the time 
required to make a trip. 

External Costs from 
Additional Vehicle Use Due 
to "Rebound" Effect 

$/vehicle-mile 
Estimates intended to represent costs per vehicle-mile of increased travel 
compared to approximately current levels, assuming current distribution of 
travel by hours of the day and facility types. 

Congestion $/vehicle-mile Congestion component of external costs from additional vehicle use. 
Accidents $/vehicle-mile Accidents component of external costs from additional vehicle use. 
Noise $/vehicle-mile Noise component of external costs from additional vehicle use. 

Ownership and Operating 
Costs   

Taxes & Fees (% of final 
vehicle MSRP) 

percentage 
Average percentage of the vehicle's final MSRP the consumer pays in taxes 
and fees when purchasing a new vehicle. 

Financing (% of final 
vehicle MSRP) 

percentage 
Average percentage of the vehicle's final MSRP the consumer would pay for 
financing a new vehicle. 

Insurance (% of final 
vehicle MSRP) 

percentage 
Average percentage of the vehicle's final MSRP the consumer would pay for 
insuring a new vehicle. 

Relative Value Loss 
(% of final vehicle MSRP, 
pure EVs only) 

percentage 
Average percentage of the vehicle's final MSRP, which translates into relative 
value loss to consumer due to decreased operating life of pure electric vehicles. 

Resale Value percentage 
Average percentage of the vehicle's final MSRP the consumer recoups after 
selling the vehicle. 

Economic Costs of Oil 
Imports   

"Monopsony" Component $/gallon 

Demand cost for imported oil; increasing domestic petroleum demand that is 
met through higher oil imports can cause the world price of oil to rise, and 
conversely that declining imports can reduce the world price of oil; determined 
by a complex set of factors, including the relative importance of U.S. imports 
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in the world oil market and demand to its world price among other participants 
in the international oil market. 

Price Shock Component $/gallon 

Expected value of costs to U.S. economy from reduction in potential output 
resulting from risk of significant increases in world petroleum price; includes 
costs resulting from inefficiencies in resource use caused by incomplete 
adjustments to industry output levels and mixes of production input when 
world oil price changes rapidly. 

Military Security 
Component 

$/gallon 
Costs of taxpayers for maintaining a military presence to secure the supply of 
oil imports from potentially unstable regions of the world and protect the 
nation against their interruption. 

 
A.3.5 Fleet Analysis Values 
 
The Fleet Analysis Values worksheet contains fine tuning parameters for performing fleet 
analysis calculations. The Forecast of Sales contains projected vehicle production for sale in the 
U.S. between model years 2014 and 2064 and is used to estimate additional car and truck fleet 
values, beyond what is available on the Historic Fleet Data worksheet (discussed below). When 
fleet analysis is used, the system evaluates modeling effects for historic and forecast model 
years, producing outputs required for the EIS. 
 

Table 17. Fleet Analysis Values Worksheet 
Category Model Characteristic Units Definition/Notes 
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Fuel Economy Growth Rates 

Baseline Scenario 
(by Fleet Type) 

percentage 
Growth rates used to estimate additional fuel economy 
growth beyond the last model year covered during the 
study period for the baseline scenario. 

Action Alternatives 
(by Fleet Type) 

percentage 
Growth rates used to estimate additional fuel economy 
growth beyond the last model year covered during the 
study period for the action alternatives. 

CAFE Start Year 
(by Fleet Type) 

model year 

The model year when Fuel Economy regulations were 
first introduced. This value is useful when evaluating 
the fuel use and environmental effects assuming the 
absence of CAFE standards.  This value is not used in 
this version of the model. 

Forecast of Sales 
(by Fleet Type) 

units 

The forecast of total industry sales by model year.  
The first model year specified should be immediately 
following the last model year from the Historic Fleet 
Data.  Forecast of Sales are used to scale individual 
vehicle sales, after the last compliance model year, in 
order to evaluate the fuel use and environmental 
effects of future years during Fleet Analysis. 

 
A.3.6 Historic Fleet Data 
 
The Historic Fleet Data worksheet provides historic data of vehicles remaining on the road, 
specified by model year for each vehicle age, for the car, class 1/2a truck, and class 2b/3 truck 
fleets.  The period of years covered is between 1975 and 2013. 
 

Table 18. Historic Fleet Data Worksheet 
Category Model Characteristic Units Definition/Notes 

Historic Fleet Data Fleet Data (by Fleet Type) units 
Historic car and truck fleet data for each fleet type and 
model year, specified by vehicle age. 

 
A.3.7 Safety Values 
 
The Safety Values worksheet contains parameters for estimating additional fatalities resulting 
from decreases in vehicle weight. 
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Table 19. Safety Values Worksheet 

Category Model Characteristic Units Definition/Notes 
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PC Threshold lbs. 
The boundary between small and large weight effects 
by  safety class. 

LT/SUV Threshold lbs. 
CUV/Minivan Threshold lbs. 
Change per 100 lbs. percentage Change per 100 lbs. below the weight threshold. 

Base per billion miles 
 

Base fatalities per billion miles below the weight 
threshold. 

Adjustment for new FMVSS 
 

Adjustment for new FMVSS below the weight 
threshold. 

Monetized Fatalities     
Cost Value dollar Social costs arising from vehicle fatalities. 
Growth Rate percentage Annual growth rate for fatality costs per vehicle. 
Base Year for Annual 

Growth 
model year 

Base year for annual growth rate for fatality costs per 
vehicle. 

 
A.3.8 Credit Trading Values 
 
The Credit Trading Values worksheet contains fine tuning parameters for enabling credit 
transfers and credit carry forward within the model. 
 

Table 20. Credit Trading Values Worksheet 
Category Model Characteristic Units Definition/Notes 
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Credit Trading Options   
Fine Tuning Parameters for using Credit Trading option 
in the model. 

Trade credits between 
manufacturers 

boolean 

Whether to allow credit trading between manufacturers 
within the same compliance category (i.e., regulatory 
class) and model year. 
This option is not supported in this version of the model. 

Transfers credits between 
regulatory classes 

boolean 
Whether to allow credit transfers between regulatory 
class within the same manufacturer and model year. 

Carry credits forward into 
future model years 

boolean 
Whether to allow carrying of credits forward into the 
analysis year from earlier model years within the same 
manufacturer and compliance category. 

Maximum number of years 
to carry forward 

integer Maximum number of model years to look forward. 

Carry credits backward 
into past model years 

boolean 

Whether to allow carrying of credits backward into the 
analysis year from future model years within the same 
manufacturer and compliance category.  This option is 
not supported in this version of the model. 

Maximum number of years 
to carry backward 

integer 
Maximum number of model years to look backward.  
This option is not supported in this version of the model. 

Transfer Caps (mpg) mpg 

Transfer caps corresponding to the maximum amount of 
credits that may be transferred into a compliance 
category for each model year. The cap from the latest 
model year is carried forward for all subsequent years. 

Assumed Lifetime VMT by 
Regulatory Class 

miles 
Assumed lifetime VMT to use when credits are 
transferred between compliance categories. 

 
 
A.3.9 DFS Model Values 
 
This option is not supported in this version of the model. 
 
A.3.10 Fuel Properties 
 
The Fuel Properties worksheet contains estimates of the physical properties of gasoline, diesel, 
and other types of fuels, as well as certain assumptions about the effects of reduced fuel use on 
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different sources of petroleum feedstocks and on imports of refined fuels.  These fuel properties 
and assumptions about the response of petroleum markets to reduced fuel use are used to 
calculate the changes in vehicular carbon dioxide emissions as well as in “upstream” emissions 
(from petroleum extraction and refining and from fuel storage and distribution) that are likely to 
result from reduced motor fuel use. 
 

Table 21. Fuel Properties Worksheet 
Category Model Characteristic Units Definition/Notes 
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Share of Total Assumed 
Fuel Mix 

percentage Estimated share of total fuel consumption by fuel type. 

Energy Density BTU/unit 
Amount of energy stored in a given system or region of 
space per unit volume, specified by fuel type. 

Mass Density grams/unit Mass per unit volume, specified by fuel type. 

Carbon Content 
percentage 
by weight 

Average share of carbon in fuel, specified by fuel type. 

SO-2 Emissions grams/unit Sulfur Oxides emissions rate of gasoline and diesel fuels. 
Fuel Import Assumptions   
Share of Fuel Savings 
Leading to 
Lower Fuel Imports 

percentage 
Assumed value for share of fuel savings leading to lower 
fuel imports. 

Share of Fuel Savings 
Leading to 
Reduced Domestic Fuel 
Refining 

percentage 
Assumed value for share of fuel savings leading to 
reduced domestic fuel refining. 

Share of Reduced Domestic
Refining from Domestic 
Crude 

percentage 
Assumed value for share of reduced domestic refining 
from domestic crude. 

Share of Reduced Domestic
Refining from Imported 
Crude 

percentage 
Assumed value for share of reduced domestic refining 
from imported crude. 

 
A.3.11 Emission Costs 
 
The Emission Costs Worksheet contains emission damage costs arising from various pollutants. 
 

Table 22. Emission Costs Worksheet 
Category Model Characteristic Units Definition/Notes 
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Emission Damage Costs 
Carbon Monoxide $/metric-ton Economic costs arising from Carbon Monoxide damage. 
Volatile Organic 
Compounds 

$/metric-ton 
Economic costs arising from Volatile Organic Compounds 
damage. 

Nitrogen Oxides $/metric-ton Economic costs arising from Nitrous Oxides damage. 
Particulate Matter $/metric-ton Economic costs arising from Particulate Matter damage. 
Sulfur Dioxide $/metric-ton Economic costs arising from Sulfur Oxides damage. 

Methane scalar 
Economic costs arising from Methane damage, specified 
as GWP-scalar of CO-2 Costs. 

Nitrous Oxide scalar 
Economic costs arising from Nitrous Oxide damage, 
specified as GWP-scalar of CO-2 Costs. 

CO-2 Damage 

CO-2 Discount Rates percentage 
Discount rates to apply to low, average, high, or very high 
Carbon Dioxide estimates. 

Cost of CO-2 $/metric ton 
Economic costs arising from Carbon Dioxide damage, by 
calendar year; estimates for low, average, high, or very 
high growth rates are provided. 

 
A.3.12 Upstream Emissions 
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The Upstream Emissions worksheet contains emission factors for greenhouse gas and criteria 
pollutant emissions from petroleum extraction and transportation, and from fuel refining, storage, 
and distribution. 
 

Table 23. Upstream Emissions Worksheet 
Category Model Characteristic Units Definition/Notes 
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 Petroleum Extraction grams/mil BTU 

Total emissions by stage of fuel production and 
distribution from petroleum extraction, specified by 
pollutant and fuel type. 

Petroleum Transportation grams/mil BTU 
Total emissions by stage of fuel production and 
distribution from petroleum transportation, specified 
by pollutant and fuel type. 

Petroleum Refining grams/mil BTU 
Total emissions by stage of fuel production and 
distribution from petroleum refining, specified by 
pollutant and fuel type. 

Fuel TS&D grams/mil BTU 
Total emissions by stage of fuel production and 
distribution from refined fuel transportation, storage, 
and delivery, specified by pollutant and fuel type. 

Subtotals grams/mil BTU 
Subtotals from all stages of fuel production and 
distribution. 

 
A.3.13 Tailpipe Emissions 
 
The Tailpipe Emissions is a set of multiple worksheets that contain vehicular criteria pollutant 
emission factors specified by vehicle age, fuel type, and vehicle class (LDV, LDT1/2a, and 
LDT2b/3), with each worksheet representing a different pollutant. 
 

Table 24. Tailpipe Emissions Worksheet 
Category Model Characteristic Units Definition/Notes 
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Emission Rates 
(by Fuel Type and Fleet) 

grams/mile 

Vehicle operation emission rate for each fuel type and fleet, 
specified for historic and future model years, and for each 
vehicle age.  Emission rates may specified for the following 
fuel types:  Gasoline, Gasoline reformulated, E85, Diesel, 
B20, CNG, LNG, and LPG; and for the following fleets:  
LDV (passenger cars), LDT1/2a (weighted average of class 
1/2a trucks), LDT2b/3 (weighted average of class 2b/3 
trucks), and MDT4/5/6 (weighted average of class 4/5/6 
trucks; this value is not used by the model). 
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A.4 Scenarios File 
 
The scenarios file provides one or more worksheets that begin with “SCEN_” and are identified 
as CAFE program scenarios, which are defined in terms of the design and stringency of the 
CAFE program.  The system numbers these scenarios as 0, 1, 2 …, based on their order of 
appearance.  The first worksheet is assigned to Scenario 0, and is identified as the baseline 
scenario to which all others are compared.  Each scenario defines the CAFE program as it relates 
to the following “regulatory classes”: 
 

Table 25. Regulatory Classes 
Reg. Class Includes 
Passenger Car All passenger automobiles 
Light Truck Class 1 and class 2a trucks 
Light Truck 2b/3 Class 2b and class 3 trucks 

 
The “Regulatory Class” column on the vehicles worksheet discussed above is used to indicate 
whether the vehicle is regulated as a Passenger Car (PC), Light Truck (LT), or Light Truck 2b/3 
(2b3). 
 
Within each scenario worksheet, the specifications for each regulatory class are defined 
separately, using the parameters described in Table 26 below. 
 

Table 26. Scenarios Worksheet 
Category Column Units Definition/Notes 
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n Function integer Functional form to use for computing the vehicle target. 
A - J 
(function coefficients) 

number Coefficients associated with the functional form to use for computing the vehicle target. 

Min (mpg) mpg 
Minimum CAFE standard that each manufacturer must attain, specified as a flat-standard 
in miles/gallon, or 0 if not applicable. 

Min (%) percentage 
Minimum CAFE standard that each manufacturer must attain, specified as a percentage of 
the average requirement under the function-based standard, or 0 if not applicable. 
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Fine Rate number The CAFE fine rate for non-compliance in dollars per one credit of shortfall. 

Multi-Fuel integer 

The applicability of multi-fuel vehicles for compliance calculations (does not apply to 
single-fuel vehicles): 
  0 = only gasoline fuel economy value is considered (gasoline fuel share is assumed to be 
100%); 
  1 = for Gasoline/Ethanol-85 vehicles, only the gasoline fuel economy value is considered 
(gasoline fuel share is assumed to be 100%); for Gasoline/Electricity vehicles, both fuel 
economy values are considered; 
  2 = for Gasoline/Ethanol-85 and Gasoline/Electricity vehicles, both fuel economy values 
are considered. 

FFV Share percentage 

The statutory fuel share to use for compliance for flex-fuel vehicles (FFVs), whenever the 
Multi-Fuel mode is 2. This fuel share applies only to vehicles operating on gasoline and 
ethanol-85 fuel types. If 0 or <blank> is used, the vehicle’s assumed on-road fuel share will 
be used for compliance. 

PHEV Share percentage 

Specifies the statutory fuel share to use for compliance for plug-in hybrid/electric vehicles 
(PHEVs), whenever the Multi-Fuel mode is either 1 or 2. This fuel share applies only to 
vehicles operating on gasoline and electricity fuel types. If 0 or <blank> is used, the 
vehicle’s assumed on-road fuel share will be used for compliance. 

Include AC boolean 

Whether to include adjustments for improvements in air conditioning (AC adjustments) for 
compliance and effects calculations: 
  TRUE = include AC credits for compliance and effects calculations (credits, fines, and 
whether mfr is in compliance); 
  FALSE = do not include AC credits for compliance and effects calculations (the achieved 
CAFE in modeling reports will still show "CAFE w/o AC" as well as "CAFE with AC"). 

AC Adjustment number The AC adjustment factor in grams/mile of CO2. 
AC Cost ($) dollar The cost of AC adjustment in dollars per unit. 

Off-Cycle Cap number 
The maximum amount of credit a manufacturer may accrue from Off-Cycle technology 
improvements, specified in grams/mile of CO2. 
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FFV Cap number 
The maximum amount of credit a manufacturer may accrue from flex-fuel vehicles (FFVs), 
specified in vehcle-miles/gallon.  This option is not supported in this version of the model. 

SHEV Tax Credit dollar 
The amount of Federal tax credits a buyer receives for purchasing a strong hybrid/electric 
vehicle (SHEV). 

PHEV Tax Credit dollar 
The amount of Federal tax credits a buyer receives for purchasing a plug-in hybrid/electric 
vehicle (PHEV). 

EV Tax Credit dollar 
The amount of Federal tax credits a buyer receives for purchasing a pure electric vehicle 
(EV). 

TW Function integer The functional form to use for computing the vehicle's test weight. 

Payload Return percentage 

The percentage of curb weight reduction returned to payload capacity.  This setting applies 
whenever mass reduction technology is installed to a vehicle.  For example, if payload 
return is 0%, the vehicle's payload capacity remains the same; if payload return is 100%, 
the vehicle's reduction in curb weight goes entirely to payload. 

Towing Return percentage 

The percentage of GVWR reduction returned to towing capacity.  This setting applies 
whenever mass reduction technology is installed to a vehicle.  For example, if towing 
return is 0%, the vehicle's towing capacity remains the same; if towing return is 100%, the 
vehicle's reduction in GVWR goes entirely to towing. 
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Appendix B Model Outputs 
 
The system produces seven output files in comma separate values (CSV) format.  The system 
places all files in the “reports” folder, located in the user selected output path (ex: C:\cafe\demo-
run\demo\reports-csv).  Table 27 lists the available output types and their contents.  With this 
revision of the modeling system, the structure of all outputs generated has changed from earlier 
versions.  The “raw” modeling results are stored as plain text (without any additional 
formatting), in a “database-like” style.  Most of the modeling reports have been extended to 
include additional information, while some were scaled down to contain only the relevant 
portions.  As discussed earlier, the first scenario appearing in the scenarios file is assigned to 
Scenario 0 and is treated as the baseline.  The action alternatives are then assigned to Scenario 1, 
2, and so on, in order of appearance.  For all modeling reports, the baseline scenario always 
shows absolute values, while, for the majority of reports, the action alternatives include relative 
changes compared to the baseline, as discussed in the sections below. 
 

Table 27. Output Files 
Output File Contents 

Technology Utilization Report 

Contains manufacturer-level and industry-wide technology application and 
penetration rates for each technology, model year, and scenario analyzed.  
The results are disaggregated by regulatory class, as well as combined over 
the entire fleet. 

Compliance Report 
Contains manufacturer-level and industry-wide summary of compliance 
model results for each model year and scenario analyzed.  The results are 
disaggregated by regulatory class, as well as combined over the entire fleet. 

Societal Effects Report 

Contains industry-wide summary of energy and emissions effects for each 
model year and scenario analyzed.  The model produces two versions of 
this output file, where the results are disaggregated by either the vehicle 
class and fuel type or the regulatory class and fuel type, as well as 
combined across all fuels and over the entire fleet. 

Societal Costs Report  

Contains industry-wide summary of consumer and social costs for each 
model year and scenario analyzed.  The model produces two versions of 
this output file, where the results are disaggregated by either the vehicle 
class and fuel type or the regulatory class and fuel type, as well as 
combined across all fuels and over the entire fleet. 

Annual Societal Effects Report  
This output file is similar to the Societal Effects Report, except it further 
disaggregates the results by calendar year. 

Annual Societal Costs Report  
This output file is similar to the Societal Costs Report, except it further 
disaggregates the results by calendar year. 

Vehicles Report 
Contains disaggregate vehicle-level summary of compliance model results, 
providing a detailed view of the final state of each vehicle examined by the 
model, for each model year and scenario analyzed. 

 
The remainder of this section discusses the contents of the output files. 
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B.1 Technology Utilization Report 
 
The Technology Utilization Report contains manufacturer-level and industry-wide technology 
application and penetration rates for each technology.  The application rates represent the amount 
of technology that was applied by the modeling system during analysis while the penetration 
rates represent the amount of technology that was either on the vehicle initially at the start of the 
analysis, or applied by the modeling system during analysis.  If a technology was present on or 
applied to a vehicle, but later superseded during the modeling process by another technology (for 
example, DCP superseding ICP), the superseded technology on that vehicle will not count 
toward the penetration rate. 
 
When the Technology Utilization Report is generated, the modeling system combines the 
application and penetration rates of some of the discrete technologies into a single entry.  This 
merging occurs only for technology entries that represent the same technology, but are modeled 
separately given the differences in costs and fuel improvements attributed to different engine 
sizes.  For example, TRBDS1_SD, TRBDS1_MD, and TRBDS1_LD, all represent the same 
technology, and the application and penetration rates of these three technologies were summed 
and reported as TRBDS1.  Furthermore, some of the technologies which are present in the 
baseline fleet, but are not explicitly analyzed by the modeling system also appear in the report.  
An example of such technology is E85 FFV (ethanol-85 flex-fuel vehicles). 
 
The following table lists the contents of the Technology Utilization Report. 
 

Table 28. Technology Utilization Report 
Column Units Contents 
Scenario integer Unique index of the scenario, where 0 represents the baseline, while 1 and above represent the action alternatives. 
Scenario 
Name 

text A short name describing the key features of the scenario. 

Model Year 
model 
year 

Model years analyzed during the study period. 

Manufacturer text Manufacturers analyzed during the study period.  A value of "TOTAL" is used to represent industry-wide results. 

Reg-Class text 
The regulatory class for which the application and penetration rates are reported.  When multiple regulatory 
classes are present in the output, a value of "TOTAL" is used to represent the sum across all classes. 

Technology 
(abbreviation) 

text 

The technology for which the application and penetration rates are reported.  Some of the discrete technology 
entries, which represent the same technology, but are modeled separately given the differences in costs and fuel 
improvements attributed to different engine sizes, were merged in the output.  For example, TRBDS1_SD, 
TRBDS1_MD, and TRBDS1_LD, all represent the same technology, and the application and penetration rates of 
these three technologies were summed and reported as TRBDS1. 

App-Rate number 

The application rate of the technology, specified as a proportion of total sales.  The application rates represent the 
amount of technology that was applied by the modeling system during analysis.  If a technology was applied to a 
vehicle, but later superseded during the modeling process by another technology (for example, DCP superseding 
ICP), the superseded technology on that vehicle will not count toward the application rate. 

Pen-Rate number 

The penetration rate of the technology, specified as a proportion of total sales.  The penetration rates represent the 
amount of technology that was either on the baseline vehicle at the start of the analysis, or applied by the modeling 
system during analysis.  If a technology was present on or applied to a vehicle, but later superseded during the 
modeling process by another technology (for example, DCP superseding ICP), the superseded technology on that 
vehicle will not count toward the penetration rate. 

Incr.AR number 
The incremental application rate of the technology, which represents the difference between the action alternative 
and the baseline scenario. 

Incr.PR number 
The incremental penetration rate of the technology, which represents the difference between the action alternative 
and the baseline scenario. 
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B.2 Compliance Report 
 
The Compliance Report contains manufacturer-level and industry-wide summary of compliance 
model results for each model year and scenario analyzed.  The results are reported by regulatory 
class, as well as aggregated for the entire fleet.  Most of the metrics, which are reported 
independently by model year, are further summed (or averaged) over the entire analysis period.  
The report provides various cost values associated with the rule, represented as “totals” across all 
vehicle models, as well as “averages” per single vehicle unit.  The following table lists the 
contents of the Compliance Report. 
 

Table 29. Compliance Report 
Column Units Contents 

Scenario integer 
Unique index of the scenario, where 0 represents the baseline, while 1 and above represent the action 
alternatives. 

Scenario Name text A short name describing the key features of the scenario. 

Model Year 
model 
year 

Model years analyzed during the study period.  A value of "TOTAL" is used to represent the sums (or 
averages) across all model years for some of the outputs, where applicable. 

Manufacturer text 
Manufacturers analyzed during the study period.  A value of "TOTAL" is used to represent industry-wide 
results. 

Reg-Class text 
The regulatory class for which the compliance results are reported.  When multiple regulatory classes are 
present in the output, a value of "TOTAL" is used to represent the sums (or averages) across all regulatory 
classes for some of the outputs, where applicable. 

Sales units 
Total production of vehicles for sale for a specific model year, manufacturer, and regulatory class (as well as 
sum across any of the attributes, where applicable). 

k.Labor Hours hours (k) 
Thousands of employment hours associated with the production of vehicle models.  (The modeling system 
applies any employment hours specified in the input file; however, the system reflects no predetermined 
assumptions regarding the context for these inputs.) 

Prelim-Stnd mpg 
Preliminary value of the required CAFE standard (before the "alternative minimum CAFE standard", as 
outlined in the scenarios input section, is applied). 

Standard mpg The value of the required CAFE standard. 

CAFE (2-cycle) mpg 
The value of the achieved CAFE standard, using a 2-bag test cycle, not including the adjustment for 
improvements in air conditioning or off-cycle credits. 

CAFE mpg 
The value of the achieved CAFE standard, including the adjustment for improvements in air conditioning and 
off-cycle credits.  This value is used for compliance purposes. 

Average CW lbs. Average curb weight of analyzed vehicles. 
Average FP sq.ft. Average footprint of analyzed vehicles. 

Average WF lbs. 
Average work-factor of analyzed vehicles.  This value is reported only when the vehicles analyzed are subject 
to the work-factor based functional standards. 

CO2 Required 
grams 
per mile 

The value of the required CO-2 standard. 

CO2 Achieved 
grams 
per mile 

The value of the achieved CO-2 standard. 

Tech Cost dollars1 
Total amount of technology costs accrued by all vehicles for a specific model year, manufacturer, and 
regulatory class. 

Fines dollars1 Total amount of fines paid by a manufacturer for a specific model year and regulatory class. 

Reg-Cost dollars1 
Total amount of regulatory costs accrued by all vehicles for a specific model year, manufacturer, and regulatory 
class.  The regulatory costs are the sum of technology costs and fines. 

Disc Cost dollars1 

Total amount of technology costs accrued by all vehicles for a specific model year, manufacturer, and 
regulatory class.  If social discounting is used, the technology costs are discounted to the "Base Year for 
Discounting" value specified in the parameters file.  If private discounting is used, the discounted costs are the 
same as technology costs. 

Value Loss dollars1 Total loss in value to the consumer due to decreased range of pure electric vehicles. 
Rel. Value Loss dollars1 Total relative loss in value to the consumer due to due to decreased operating life of pure electric vehicles. 
Maint Cost dollars1 Total maintenance costs accrued due to application of additional technologies. 
Repair Cost dollars1 Total repair costs accrued due to application of additional technologies. 

Taxes/Fees dollars1 
Total amount of taxes & fees paid by the consumers for purchasing new vehicles for a specific model year, 
manufacturer, and regulatory class. 

Financing dollars1 
Total amount paid by the consumers for financing new vehicles for a specific model year, manufacturer, and 
regulatory class. 

Insurance dollars1 
Total amount paid by the consumers for insuring new vehicles for a specific model year, manufacturer, and 
regulatory class. 

Total Consumer 
Costs 

dollars1 
The total consumer costs accumulated by the manufacturer for a specific model year and regulatory class.  The 
consumer costs are the sum of:  discounted technology costs, fines, taxes & fees, financing costs, insurance 
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costs, maintenance costs, repair costs, loss of value, and relative loss of value. 

Total Social 
Costs 

dollars1 
The total social costs accumulated by the manufacturer for a specific model year and regulatory class.  The 
social costs are the sum of:  discounted technology costs, maintenance costs, repair costs, loss of value, and 
relative loss of value. 

Avg Tech Cost dollars1 Average technology costs per single vehicle unit. 
Avg Fines dollars1 Average fines paid per single vehicle unit. 
Avg Reg-Cost dollars1 Average regulatory costs per single vehicle unit. 

Avg Disc Cost dollars1 
Average technology costs per single vehicle unit.  If social discounting is used, the technology costs are 
discounted to the "Base Year for Discounting" value specified in the parameters file.  If private discounting is 
used, the average discounted costs are the same as average technology costs. 

Avg Value 
Loss 

dollars1 Average loss in value per single vehicle unit. 

Avg Rel. Value 
Loss 

dollars1 Average relative loss in value per single vehicle unit. 

Avg Maint Cost dollars1 Average maintenance costs per single vehicle unit. 
Avg Repair 
Cost 

dollars1 Average repair costs per single vehicle unit. 

Avg Taxes/Fees dollars1 Average taxes & fees per single vehicle unit. 
Avg Financing dollars1 Average financing costs per single vehicle unit. 
Avg Insurance dollars1 Average insurance costs per single vehicle unit. 
Avg Consumer 
Costs 

dollars1 Average consumer costs per single vehicle unit. 

Avg Social 
Costs 

dollars1 Average social costs per single vehicle unit. 

Credits Earned credits2 
Total credits accumulated by the manufacturer for a specific model year and regulatory class.  Manufacturers 
earn compliance credits whenever their achieved value of the CAFE standard is above the required value of the 
CAFE standard (in mpg). 

Credits Out credits2 
Total credits transferred out of a specific regulatory class (such as from domestic passenger automobiles to light 
trucks) or carried forward from a previous model year. 

Credits In credits2 Total credits transferred into a specific regulatory class or carried forward into the present model year. 

 
In the above table, note that: 

(1) For the baseline scenario, all costs are specified as absolutes; for the action alternatives, 
all costs are incremental and are specified as the difference between the action alternative 
and the baseline scenario. 

(2) For light duty vehicles (passenger cars, class-1 light duty trucks, and class-2a light duty 
trucks), one credit equates to one mile per 10 gallons. For medium duty vehicles (class-2a 
light duty trucks and class-3 light duty trucks), one credit equates to one gallon per 10k 
miles. 
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B.3 Societal Effects Report and Societal Costs Report 
 
The Societal Effects Report contains industry-wide summary of energy and emissions effects, 
while the Societal Costs Report contains corresponding industry-wide summary of consumer and 
social costs for each model year and scenario analyzed.  The modeling system generates two 
versions of each report, where in one, the results are reported by vehicle class (LDV, LDT12a, 
LDT2b3), while in the other, the results are reported by regulatory class (PC, LT, LT2b3).  In 
each case, the results are aggregated for the entire fleet as well.  Most of the metrics, which are 
reported independently by model year, are further summed (or averaged) over the entire analysis 
period. 
 
The Societal Effects Report also disaggregates energy and emissions effects by fuel type, as well 
as providing aggregate totals across all fuels.  The report contains calculated levels of energy 
consumed by fuel type in quads, thousands of gallons, and thousands of native units during the 
full useful life of all vehicles sold in each model year.  For liquid fuel types (gasoline, diesel, 
E85, and B20), amount of gallons consumed is specified in their native units (for example, 
gallons of E85).  For non-liquid fuel types (electricity, hydrogen, CNG), amount of gallons 
consumed is specified in gasoline equivalent gallons.  Additionally, energy consumption in 
native units is specified for electricity in mW-h, and for hydrogen and CNG in Mcf.  Full useful 
life travel (in thousands of miles) and average fuel economy levels are also presented to provide 
a basis for comparison.  The rated fuel economy levels reported are not comparable to the value 
of achieved CAFE standard shown in the compliance report.  The values contained in the 
Societal Effects Report are computed as total VMT divided by total gallons (with the effect of 
the on-road gap backed out), and do not incorporate some of the compliance credits. 
 
The Societal Effects Report also presents estimates of full fuel cycle carbon dioxide and criteria 
pollutant emissions by fuel type.  As shown in Table 30 below, carbon dioxide emissions are 
reported in million metric tons of carbon-equivalent emissions (one metric ton of carbon dioxide 
is equivalent to 12/44 of a metric ton of carbon), and all criteria pollutants are reported in metric 
tons. 
 
In the Societal Effects Report, for the baseline scenario, VMT, energy use, fatalities, and all 
emissions are specified as absolutes.  For the action alternatives, these values are incremental and 
are specified as the difference between the action alternative and the baseline scenario. 
 
The Societal Costs Report contains monetized consumer and social costs including fuel 
expenditures, travel and refueling value, economic and external costs arising from additional 
vehicle use, as well as owner and societal costs associated with emissions damage.  In all cases, 
these costs are calculated for the fleet of vehicles sold in each model year over their full useful 
lives, discounted using the rate specified in the benefits model parameters file, and reported in 
thousands of constant year-2012 dollars.  Chapter Three, Section 6 of the primary text discusses 
these types of costs and benefits in greater detail, and Appendix A (Model Inputs) discusses 
corresponding input assumptions. 
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In the Societal Costs Report, for the baseline scenario, all costs are specified as absolutes.  For 
the action alternatives, all costs are incremental and are specified as the difference between the 
action alternative and the baseline scenario. 
 
Table 30 below lists the full contents of the Societal Effects Report and Table 31 lists the full 
contents of the Societal Costs Report. 
 

Table 30. Societal Effects Report 
Column Units Contents 

Scenario integer 
Unique index of the scenario, where 0 represents the baseline, while 1 and above represent the action 
alternatives. 

Scenario 
Name 

text A short name describing the key features of the scenario. 

Model Year 
model 
year 

Model years analyzed during the study period.  A value of "TOTAL" is used to represent the sums (or averages) 
across all model years for some of the outputs, where applicable. 

Reg-Class text 
The regulatory class for which the societal effects are reported.  When multiple regulatory classes are present in 
the output, a value of "TOTAL" is used to represent the sums (or averages) across all regulatory classes for 
some of the outputs, where applicable. 

Veh-Class text 
The vehicle class for which the societal effects are reported.  When multiple vehicle classes are present in the 
output, a value of "TOTAL" is used to represent the sums (or averages) across all vehicle classes for some of 
the outputs, where applicable. 

Fuel Type text 
The fuel type for which the societal effects are reported.  A value of "TOTAL" is used to represent the sums (or 
averages) across all fuel types for some of the outputs, where applicable. 

Rated FE mpg 
The average fuel economy rating of vehicles.  Note, this value is not comparable to the value of achieved CAFE 
standard shown in the compliance report; this value is computed as total VMT divided by total gallons (with the 
effect of the on-road gap backed out), and does not incorporate some of the compliance credits. 

On-road FE mpg The average on-road fuel economy rating of vehicles. 
Fuel Share ratio The average fuel share, indicating the amount of miles driven by all vehicles on each fuel type. 
Curb Weight lbs. Average curb weight of analyzed vehicles. 
Footprint sq.ft. Average footprint of analyzed vehicles. 

Work Factor lbs. 
Average work-factor of analyzed vehicles.  This value is reported only when the vehicles analyzed are subject 
to the work-factor based functional standards. 

Sales units 
Total production of vehicles for sale for a specific model year, regulatory or vehicle class, and fuel type (as well 
as sum across any of the attributes, where applicable). 

kVMT miles (k) 
Thousands of miles traveled by all vehicles over their lifetime for a specific model year, regulatory or vehicle 
class, and fuel type. 

Quads quads 
Energy used by all vehicles over their lifetime for a specific model year, regulatory or vehicle class, and fuel 
type. 

kGallons 
gallons 
(k) 

Amount of gallons of liquid fuel consumed, or amount of gasoline equivalent gallons of fuel consumed (for 
non-liquid fuel types), by all vehicles over their lifetime for a specific model year, regulatory or vehicle class, 
and fuel type. 

kUnits varies 

Amount of energy consumed by all vehicles over their lifetime for a specific model year, regulatory or vehicle 
class, and fuel type, where the units of measure vary based on fuel type.  For liquid fuel types (gasoline, e85, 
diesel, b20, LNG, LPG), the units are specified in thousands of gallons; for electricity, the units are specified in 
mW-h; for hydrogen and CNG, the units are specified in Mcf. 

Fatalities units 
Amount of fatalities resulting from reduction in vehicle curb weight and increases in VMT due to the rebound 
effect, aggregated over the lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel 
type. 

CO (t) 
metric-
tons 

Amount of Carbon Monoxide emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated 
over the lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type. 

VOC (t) 
metric-
tons 

Amount of Volatile Organic Compounds emissions generated from domestic crude petroleum extraction, 
transportation, and refining, from gasoline transportation, storage, and distribution, and from vehicle operation, 
aggregated over the lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type. 

NOx (t) 
metric-
tons 

Amount of Nitrogen Oxides emissions generated from domestic crude petroleum extraction, transportation, and 
refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the 
lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type. 

SO2 (t) 
metric-
tons 

Amount of Sulfur Dioxide emissions generated from domestic crude petroleum extraction, transportation, and 
refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the 
lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type. 

PM (t) 
metric-
tons 

Amount of Particulate Matter (diameter of ~2.5 micrometers) emissions generated from domestic crude 
petroleum extraction, transportation, and refining, from gasoline transportation, storage, and distribution, and 
from vehicle operation, aggregated over the lifetime of all vehicles for a specific model year, regulatory or 
vehicle class, and fuel type. 

CO2 (mmt) million Amount of Carbon Dioxide emissions generated from domestic crude petroleum extraction, transportation, and 
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metric-
tons 

refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the 
lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type. 

CH4 (t) 
metric-
tons 

Amount of Methane emissions generated from domestic crude petroleum extraction, transportation, and 
refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the 
lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type. 

N2O (t) 
metric-
tons 

Amount of Nitrous Oxide emissions generated from domestic crude petroleum extraction, transportation, and 
refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the 
lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type. 

Acetaldehyde 
(t) 

metric-
tons 

Amount of Acetaldehyde emissions generated from domestic crude petroleum extraction, transportation, and 
refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the 
lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type. 

Acrolein (t) 
metric-
tons 

Amount of Acrolein emissions generated from domestic crude petroleum extraction, transportation, and 
refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the 
lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type. 

Benzene (t) 
metric-
tons 

Amount of Benzene emissions generated from domestic crude petroleum extraction, transportation, and 
refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the 
lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type. 

Butadiene (t) 
metric-
tons 

Amount of 1,3-Butadiene emissions generated from domestic crude petroleum extraction, transportation, and 
refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the 
lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type. 

Formaldehyde 
(t) 

metric-
tons 

Amount of Formaldehyde emissions generated from domestic crude petroleum extraction, transportation, and 
refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated over the 
lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type. 

DPM10 (t) 
metric-
tons 

Amount of Diesel Particulate Matter (diameter of ~10 micrometers) emissions generated from domestic crude 
petroleum extraction, transportation, and refining, from gasoline transportation, storage, and distribution, and 
from vehicle operation, aggregated over the lifetime of all vehicles for a specific model year, regulatory or 
vehicle class, and fuel type. 

MTBE (t) 
metric-
tons 

Amount of Methyl Tertiary Butyl Ether emissions generated from domestic crude petroleum extraction, 
transportation, and refining, from gasoline transportation, storage, and distribution, and from vehicle operation, 
aggregated over the lifetime of all vehicles for a specific model year, regulatory or vehicle class, and fuel type. 
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Table 31. Societal Costs Report 
Column Units Contents 
Scenario integer Unique index of the scenario, where 0 represents the baseline, while 1 and above represent the action alternatives. 
Scenario Name text A short name describing the key features of the scenario. 

Model Year 
model 
year 

Model years analyzed during the study period.  A value of "TOTAL" is used to represent the sums (or averages) 
across all model years for some of the outputs, where applicable. 

Reg-Class text 
The regulatory class for which the societal costs are reported.  When multiple regulatory classes are present in the 
output, a value of "TOTAL" is used to represent the sums (or averages) across all regulatory classes for some of 
the outputs, where applicable. 

Veh-Class text 
The vehicle class for which the societal costs are reported.  When multiple vehicle classes are present in the 
output, a value of "TOTAL" is used to represent the sums (or averages) across all vehicle classes for some of the 
outputs, where applicable. 

Fuel Type text 
The fuel type for which the societal costs are reported.  A value of "TOTAL" is used to represent the sums (or 
averages) across all fuel types for some of the outputs, where applicable. 

Disc-Rate number Social discount rate applied to future benefits.  A value of 0 indicates undiscounted costs. 
Pre-Tax Fuel 
Cost 

dollars 
(k) 

Total pre-tax fuel expenditures accumulated across all vehicles over their lifetime for a specific model year, 
regulatory or vehicle class, and fuel type. 

Fuel Tax Cost 
dollars 
(k) 

Total fuel tax revenues accumulated across all vehicles over their lifetime for a specific model year, regulatory or 
vehicle class, and fuel type. 

Retail Fuel 
Costs 

dollars 
(k) 

Total retail fuel expenditures (pre-tax fuel cost + fuel tax cost) accumulated across all vehicles over their lifetime 
for a specific model year, regulatory or vehicle class, and fuel type. 

Drive Surplus 
dollars 
(k) 

Benefits from the additional driving that results from improved fuel economy, accumulated across all vehicles over 
their lifetime for a specific model year, regulatory or vehicle class, and fuel type. 

Refuel Surplus 
dollars 
(k) 

Benefits from reduced refueling frequency due to the extended vehicle range and improved fuel economy, 
accumulated across all vehicles over their lifetime for a specific model year, regulatory or vehicle class, and fuel 
type. 

Market 
Externalities 

dollars 
(k) 

Economic costs of oil imports not accounted for by price, accumulated across all vehicles over their lifetime for a 
specific model year, regulatory or vehicle class, and fuel type. 

Congestion 
Costs 

dollars 
(k) 

Congestion costs from additional vehicle use, accumulated across all vehicles over their lifetime for a specific 
model year, regulatory or vehicle class, and fuel type. 

Accident Costs 
dollars 
(k) 

Accident costs from additional vehicle use, accumulated across all vehicles over their lifetime for a specific model 
year, regulatory or vehicle class, and fuel type. 

Noise Costs 
dollars 
(k) 

Noise costs from additional vehicle use, accumulated across all vehicles over their lifetime for a specific model 
year, regulatory or vehicle class, and fuel type. 

Fatality Costs 
dollars 
(k) 

Cost from additional fatalities resulting from reduction in vehicle curb weight, accumulated across all vehicles 
over their lifetime for a specific model year, regulatory or vehicle class, and fuel type. 

CO Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Carbon Monoxide damage, aggregated over the lifetime of all vehicles for a 
specific model year, regulatory or vehicle class, and fuel type. 

VOC Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Volatile Organic Compounds damage, aggregated over the lifetime of all 
vehicles for a specific model year, regulatory or vehicle class, and fuel type. 

NOx Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Nitrogen Oxides damage, aggregated over the lifetime of all vehicles for a 
specific model year, regulatory or vehicle class, and fuel type. 

SO2 Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Sulfur Dioxide damage, aggregated over the lifetime of all vehicles for a 
specific model year, regulatory or vehicle class, and fuel type. 

PM Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Particulate Matter damage, aggregated over the lifetime of all vehicles for a 
specific model year, regulatory or vehicle class, and fuel type. 

CO2 Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Carbon Dioxide damage, aggregated over the lifetime of all vehicles for a 
specific model year, regulatory or vehicle class, and fuel type. 

CH4 Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Methane damage, aggregated over the lifetime of all vehicles for a specific 
model year, regulatory or vehicle class, and fuel type. 

N2O Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Nitrous Oxide damage, aggregated over the lifetime of all vehicles for a 
specific model year, regulatory or vehicle class, and fuel type. 

Total 
Consumer 
Costs 

dollars 
(k) 

Total consumer costs accumulated by the industry for a specific model year, regulatory or vehicle class, and fuel 
type.  The consumer costs are the sum of:  retail fuel costs, drive surplus, and refueling surplus. 

Total Social 
Costs 

dollars 
(k) 

Total social costs accumulated by the industry for a specific model year, regulatory or vehicle class, and fuel type.  
The social costs are the sum of:  pre-tax fuel costs, drive surplus, refueling surplus, market externalities, 
congestion costs, accident costs, noise costs, fatality costs, and emissions damage costs (CO, VOC, NOx, SO2, 
PM, CO2, CH4, and N2O). 
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B.4 Annual Societal Effects Report and Annual Societal Costs Report 
 
The Annual Societal Effects Report and the Annual Societal Costs Report contain similar results 
as the Societal Effects Report and the Societal Costs Report, except these outputs further 
disaggregate the results by calendar year.  Table 32 lists the full contents of the Annual Societal 
Effects Report and Table 33 lists the full contents of the Annual Societal Costs Report.  The 
annual reports produce results as absolutes for the baseline and action alternatives. 
 

Table 32. Annual Societal Effects Report 
Column Units Contents 

Scenario integer 
Unique index of the scenario, where 0 represents the baseline, while 1 and above represent the action 
alternatives. 

Scenario Name text A short name describing the key features of the scenario. 

Model Year model year 
Model years analyzed during the study period.  When "Fleet Analysis" option is enabled during modeling, 
the range of years is extended to include historic and future model years. 

Age integer The vehicle's vintage, ranging from 0 to 39, where 0 corresponds to a vehicle's first year on the road. 

Calendar Year 
calendar 
year 

Calendar years analyzed for the effects calculations. 

Veh-Class text 
The vehicle class for which the societal costs are reported.  When multiple vehicle classes are present in the 
output, a value of "TOTAL" is used to represent the sums (or averages) across all vehicle classes for some 
of the outputs, where applicable. 

Fuel Type text 
The fuel type for which the societal costs are reported.  A value of "TOTAL" is used to represent the sums 
(or averages) across all fuel types for some of the outputs, where applicable. 

Fleet units Total on-road fleet for a specific model year, vehicle age, vehicle class, and fuel type. 

kVMT miles (k) 
Thousands of miles traveled by all vehicles for a specific model year, vehicle age, vehicle class, and fuel 
type. 

Quads quads Energy used by all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

kGallons gallons (k) 
Amount of gallons of liquid fuel consumed, or amount of gasoline equivalent gallons of fuel consumed (for 
non-liquid fuel types), by all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

kUnits varies 

Amount of energy consumed by all vehicles for a specific model year, vehicle age, vehicle class, and fuel 
type, where the units of measure vary based on fuel type.  For liquid fuel types (gasoline, e85, diesel, b20, 
LNG, LPG), the units are specified in thousands of gallons; for electricity, the units are specified in mW-h; 
for hydrogen and CNG, the units are specified in Mcf. 

Fatalities units 
Amount of fatalities resulting from reduction in vehicle curb weight and increases in VMT due to the 
rebound effect, aggregated for all vehicles for a specific model year, vehicle age, vehicle class, and fuel 
type. 

CO Upstream (t) 
metric-
tons 

Amount of Carbon Monoxide emissions generated from domestic crude petroleum extraction, 
transportation, and refining, from gasoline transportation, storage, and distribution, aggregated for all 
vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

VOC Upstream 
(t) 

metric-
tons 

Amount of Volatile Organic Compounds emissions generated from domestic crude petroleum extraction, 
transportation, and refining, from gasoline transportation, storage, and distribution, aggregated for all 
vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

NOx Upstream 
(t) 

metric-
tons 

Amount of Nitrogen Oxides emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific 
model year, vehicle age, vehicle class, and fuel type. 

SO2 Upstream (t) 
metric-
tons 

Amount of Sulfur Dioxide emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific 
model year, vehicle age, vehicle class, and fuel type. 

PM Upstream (t) 
metric-
tons 

Amount of Particulate Matter (diameter of ~2.5 micrometers) emissions generated from domestic crude 
petroleum extraction, transportation, and refining, from gasoline transportation, storage, and distribution, 
aggregated for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

CO2 Upstream 
(mmt) 

million 
metric-
tons 

Amount of Carbon Dioxide emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific 
model year, vehicle age, vehicle class, and fuel type. 

CH4 Upstream 
(t) 

metric-
tons 

Amount of Methane emissions generated from domestic crude petroleum extraction, transportation, and 
refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific 
model year, vehicle age, vehicle class, and fuel type. 

N2O Upstream 
(t) 

metric-
tons 

Amount of Nitrous Oxide emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific 
model year, vehicle age, vehicle class, and fuel type. 

Acetaldehyde 
Upstream (t) 

metric-
tons 

Amount of Acetaldehyde emissions generated from domestic crude petroleum extraction, transportation, and 
refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific 
model year, vehicle age, vehicle class, and fuel type. 

Acrolein metric- Amount of Acrolein emissions generated from domestic crude petroleum extraction, transportation, and 
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Upstream (t) tons refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific 
model year, vehicle age, vehicle class, and fuel type. 

Benzene 
Upstream (t) 

metric-
tons 

Amount of Benzene emissions generated from domestic crude petroleum extraction, transportation, and 
refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific 
model year, vehicle age, vehicle class, and fuel type. 

Butadiene 
Upstream (t) 

metric-
tons 

Amount of 1,3-Butadiene emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific 
model year, vehicle age, vehicle class, and fuel type. 

Formaldehyde 
Upstream (t) 

metric-
tons 

Amount of Formaldehyde emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, aggregated for all vehicles for a specific 
model year, vehicle age, vehicle class, and fuel type. 

DPM10 
Upstream (t) 

metric-
tons 

Amount of Diesel Particulate Matter (diameter of ~10 micrometers) emissions generated from domestic 
crude petroleum extraction, transportation, and refining, from gasoline transportation, storage, and 
distribution, aggregated for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

MTBE Upstream 
(t) 

metric-
tons 

Amount of Methyl Tertiary Butyl Ether emissions generated from domestic crude petroleum extraction, 
transportation, and refining, from gasoline transportation, storage, and distribution, aggregated for all 
vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

CO Tailpipe (t) 
metric-
tons 

Amount of Carbon Monoxide emissions generated from vehicle operation, aggregated for all vehicles for a 
specific model year, vehicle age, vehicle class, and fuel type. 

VOC Tailpipe (t) 
metric-
tons 

Amount of Volatile Organic Compounds emissions generated from vehicle operation, aggregated for all 
vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

NOx Tailpipe (t) 
metric-
tons 

Amount of Nitrogen Oxides emissions generated from vehicle operation, aggregated for all vehicles for a 
specific model year, vehicle age, vehicle class, and fuel type. 

SO2 Tailpipe (t) 
metric-
tons 

Amount of Sulfur Dioxide emissions generated from vehicle operation, aggregated for all vehicles for a 
specific model year, vehicle age, vehicle class, and fuel type. 

PM Tailpipe (t) 
metric-
tons 

Amount of Particulate Matter (diameter of ~2.5 micrometers) emissions generated from vehicle operation, 
aggregated for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

CO2 Tailpipe 
(mmt) 

million 
metric-
tons 

Amount of Carbon Dioxide emissions generated from vehicle operation, aggregated for all vehicles for a 
specific model year, vehicle age, vehicle class, and fuel type. 

CH4 Tailpipe (t) 
metric-
tons 

Amount of Methane emissions generated from vehicle operation, aggregated for all vehicles for a specific 
model year, vehicle age, vehicle class, and fuel type. 

N2O Tailpipe (t) 
metric-
tons 

Amount of Nitrous Oxide emissions generated from vehicle operation, aggregated for all vehicles for a 
specific model year, vehicle age, vehicle class, and fuel type. 

Acetaldehyde 
Tailpipe (t) 

metric-
tons 

Amount of Acetaldehyde emissions generated from vehicle operation, aggregated for all vehicles for a 
specific model year, vehicle age, vehicle class, and fuel type. 

Acrolein Tailpipe 
(t) 

metric-
tons 

Amount of Acrolein emissions generated from vehicle operation, aggregated for all vehicles for a specific 
model year, vehicle age, vehicle class, and fuel type. 

Benzene Tailpipe 
(t) 

metric-
tons 

Amount of Benzene emissions generated from vehicle operation, aggregated for all vehicles for a specific 
model year, vehicle age, vehicle class, and fuel type. 

Butadiene 
Tailpipe (t) 

metric-
tons 

Amount of 1,3-Butadiene emissions generated from vehicle operation, aggregated for all vehicles for a 
specific model year, vehicle age, vehicle class, and fuel type. 

Formaldehyde 
Tailpipe (t) 

metric-
tons 

Amount of Formaldehyde emissions generated from vehicle operation, aggregated for all vehicles for a 
specific model year, vehicle age, vehicle class, and fuel type. 

DPM10 Tailpipe 
(t) 

metric-
tons 

Amount of Diesel Particulate Matter (diameter of ~10 micrometers) emissions generated from vehicle 
operation, aggregated for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

MTBE Tailpipe 
(t) 

metric-
tons 

Amount of Methyl Tertiary Butyl Ether emissions generated from vehicle operation, aggregated for all 
vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

CO Total (t) 
metric-
tons 

Amount of Carbon Monoxide emissions generated from domestic crude petroleum extraction, 
transportation, and refining, from gasoline transportation, storage, and distribution, and from vehicle 
operation, aggregated for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

VOC Total (t) 
metric-
tons 

Amount of Volatile Organic Compounds emissions generated from domestic crude petroleum extraction, 
transportation, and refining, from gasoline transportation, storage, and distribution, and from vehicle 
operation, aggregated for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

NOx Total (t) 
metric-
tons 

Amount of Nitrogen Oxides emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated 
for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

SO2 Total (t) 
metric-
tons 

Amount of Sulfur Dioxide emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated 
for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

PM Total (t) 
metric-
tons 

Amount of Particulate Matter (diameter of ~2.5 micrometers) emissions generated from domestic crude 
petroleum extraction, transportation, and refining, from gasoline transportation, storage, and distribution, 
and from vehicle operation, aggregated for all vehicles for a specific model year, vehicle age, vehicle class, 
and fuel type. 

CO2 Total (mmt) 
million 
metric-
tons 

Amount of Carbon Dioxide emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated 
for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

CH4 Total (t) metric- Amount of Methane emissions generated from domestic crude petroleum extraction, transportation, and 
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tons refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated for 
all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

N2O Total (t) 
metric-
tons 

Amount of Nitrous Oxide emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated 
for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

Acetaldehyde 
Total (t) 

metric-
tons 

Amount of Acetaldehyde emissions generated from domestic crude petroleum extraction, transportation, and 
refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated for 
all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

Acrolein Total (t) 
metric-
tons 

Amount of Acrolein emissions generated from domestic crude petroleum extraction, transportation, and 
refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated for 
all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

Benzene Total (t) 
metric-
tons 

Amount of Benzene emissions generated from domestic crude petroleum extraction, transportation, and 
refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated for 
all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

Butadiene Total 
(t) 

metric-
tons 

Amount of 1,3-Butadiene emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated 
for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

Formaldehyde 
Total (t) 

metric-
tons 

Amount of Formaldehyde emissions generated from domestic crude petroleum extraction, transportation, 
and refining, from gasoline transportation, storage, and distribution, and from vehicle operation, aggregated 
for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

DPM10 Total (t) 
metric-
tons 

Amount of Diesel Particulate Matter (diameter of ~10 micrometers) emissions generated from domestic 
crude petroleum extraction, transportation, and refining, from gasoline transportation, storage, and 
distribution, and from vehicle operation, aggregated for all vehicles for a specific model year, vehicle age, 
vehicle class, and fuel type. 

MTBE Total (t) 
metric-
tons 

Amount of Methyl Tertiary Butyl Ether emissions generated from domestic crude petroleum extraction, 
transportation, and refining, from gasoline transportation, storage, and distribution, and from vehicle 
operation, aggregated for all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 
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Table 33. Annual Societal Costs Report 
Column Units Contents 

Scenario integer 
Unique index of the scenario, where 0 represents the baseline, while 1 and above represent the action 
alternatives. 

Scenario Name text A short name describing the key features of the scenario. 

Model Year 
model 
year 

Model years analyzed during the study period.  When "Fleet Analysis" option is enabled during modeling, the 
range of years is extended to include historic and future model years. 

Age integer The vehicle's vintage, ranging from 0 to 39, where 0 corresponds to a vehicle's first year on the road. 

Calendar Year 
calendar 
year 

Calendar years analyzed for the effects calculations. 

Veh-Class text 
The vehicle class for which the societal costs are reported.  When multiple vehicle classes are present in the 
output, a value of "TOTAL" is used to represent the sums (or averages) across all vehicle classes for some of the 
outputs, where applicable. 

Fuel Type text 
The fuel type for which the societal costs are reported.  A value of "TOTAL" is used to represent the sums (or 
averages) across all fuel types for some of the outputs, where applicable. 

Disc-Rate number Social discount rate applied to future benefits.  A value of 0 indicates undiscounted costs. 
Pre-Tax Fuel 
Cost 

dollars 
(k) 

Total pre-tax fuel expenditures accumulated across all vehicles for a specific model year, vehicle age, vehicle 
class, and fuel type. 

Fuel Tax Cost 
dollars 
(k) 

Total fuel tax revenues accumulated across all vehicles for a specific model year, vehicle age, vehicle class, and 
fuel type. 

Retail Fuel 
Costs 

dollars 
(k) 

Total retail fuel expenditures (pre-tax fuel cost + fuel tax cost) accumulated across all vehicles for a specific 
model year, vehicle age, vehicle class, and fuel type. 

Drive Surplus 
dollars 
(k) 

Benefits from the additional driving that results from improved fuel economy, accumulated across all vehicles 
for a specific model year, vehicle age, vehicle class, and fuel type. 

Refuel Surplus 
dollars 
(k) 

Benefits from reduced refueling frequency due to the extended vehicle range and improved fuel economy, 
accumulated across all vehicles for a specific model year, vehicle age, vehicle class, and fuel type. 

Market 
Externalities 

dollars 
(k) 

Economic costs of oil imports not accounted for by price, accumulated across all vehicles for a specific model 
year, vehicle age, vehicle class, and fuel type. 

Congestion 
Costs 

dollars 
(k) 

Congestion costs from additional vehicle use, accumulated across all vehicles for a specific model year, vehicle 
age, vehicle class, and fuel type. 

Accident Costs 
dollars 
(k) 

Accident costs from additional vehicle use, accumulated across all vehicles for a specific model year, vehicle 
age, vehicle class, and fuel type. 

Noise Costs 
dollars 
(k) 

Noise costs from additional vehicle use, accumulated across all vehicles for a specific model year, vehicle age, 
vehicle class, and fuel type. 

Fatality Costs 
dollars 
(k) 

Cost from additional fatalities resulting from reduction in vehicle curb weight, accumulated across all vehicles 
for a specific model year, vehicle age, vehicle class, and fuel type. 

CO Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Carbon Monoxide damage, aggregated for all vehicles for a specific 
model year, vehicle age, vehicle class, and fuel type. 

VOC Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Volatile Organic Compounds damage, aggregated for all vehicles for a 
specific model year, vehicle age, vehicle class, and fuel type. 

NOx Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Nitrogen Oxides damage, aggregated for all vehicles for a specific model 
year, vehicle age, vehicle class, and fuel type. 

SO2 Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Sulfur Dioxide damage, aggregated for all vehicles for a specific model 
year, vehicle age, vehicle class, and fuel type. 

PM Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Particulate Matter damage, aggregated for all vehicles for a specific 
model year, vehicle age, vehicle class, and fuel type. 

CO2 Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Carbon Dioxide damage, aggregated for all vehicles for a specific model 
year, vehicle age, vehicle class, and fuel type. 

CH4 Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Methane damage, aggregated for all vehicles for a specific model year, 
vehicle age, vehicle class, and fuel type. 

N2O Damage 
Costs 

dollars 
(k) 

Owner and societal costs arising from Nitrous Oxide damage, aggregated for all vehicles for a specific model 
year, vehicle age, vehicle class, and fuel type. 

Total 
Consumer 
Costs 

dollars 
(k) 

Total consumer costs accumulated by the industry for a specific model year, vehicle age, vehicle class, and fuel 
type.  The consumer costs are the sum of:  retail fuel costs, drive surplus, and refueling surplus. 

Total Social 
Costs 

dollars 
(k) 

Total social costs accumulated by the industry for a specific model year, vehicle age, vehicle class, and fuel 
type.  The social costs are the sum of:  pre-tax fuel costs, drive surplus, refueling surplus, market externalities, 
congestion costs, accident costs, noise costs, fatality costs, and emissions damage costs (CO, VOC, NOx, SO2, 
PM, CO2, CH4, and N2O). 
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B.5 Vehicles Report 
 
The Vehicles Report contains disaggregate vehicle-level summary of compliance model results, 
providing a detailed view of the final state of each vehicle examined by the model, for each 
model year and scenario analyzed.  The report includes basic vehicle characteristics (such as 
vehicle code, manufacturer, engine and transmission used, curb weight, footprint, and sales 
volumes), fuel economy information (before and after the analysis), final technology utilization, 
and cost metrics associated with application of additional technology. 
 
The vehicle’s fuel economy ratings prior to the start of the analysis as well as at the end of each 
compliance model year are presented.  The fuel economy values are specified per fuel type 
(wherever applicable) in addition to an overall value, which used for compliance purposes.  For 
multi-fuel vehicles, the multiple fuel economy ratings are combined according to the statutory 
requirements.  For flex-fuel vehicles (those that operate on gasoline and ethanol-85), only the 
gasoline fuel economy rating is considered for compliance.  For plug-in hybrid/electric vehicles 
(PHEVs operating on gasoline and electricity), the overall fuel economy rating is harmonically 
averaged based on the share of each fuel type.  The vehicle’s fuel share indicates the amount of 
miles driven by the vehicle on each fuel type.  For vehicles operating on a single fuel (e.g., 
gasoline, diesel, or electricity), the fuel share for that fuel type only is specified.  For vehicles 
operating on multiple fuels (FFVs and PHEVs), the fuel shares are specified for gasoline and 
ethanol-85 or for gasoline and electricity. 
 
The Vehicles Report provides initial and final sales volumes as well as initial and final MSRPs.  
The initial sales and MSRP represent the starting values as obtained from the input file, and do 
not reflect changes associated with the modeling analysis.  The final sales volumes are specified 
by model year and will typically match the initial values, unless modeling options for sales 
mixing are selected.  The final MSRPs are specified by model year as well, and incorporate 
additional costs arising from technology application or fine payment. 
 
Table 34 below list the full contents of the Vehicles Report. 
 

Table 34. Vehicles Report 
Column Units Contents 

Scenario integer 
Unique index of the scenario, where 0 represents the baseline, while 1 and above represent the action 
alternatives. 

Scenario Name text A short name describing the key features of the scenario. 

Model Year 
model 
year 

Model years analyzed during the study period. 

Manufacturer text Manufacturers analyzed during the study period. 
Veh Index integer Unique index assigned to each vehicle by the modeling system during runtime. 
Veh Code integer Index of the vehicle (unique per manufacturer), as read from the input file. 
Model text Vehicle model. 
Name Plate text Vehicle nameplate. 
Platform text Name of the platform used by a vehicle. 

Plt Version text 
Revision of the platform used by a vehicle.  This field lists the platform version as "baseline", if the vehicle is 
using an original and unmodified platform.  Alternatively, this field shows the model year, signifying the 
revision of the intial platform that the vehicle has inherited. 

Eng Code integer Index of the engine used by a vehicle. 

Eng Fuel Initial text 
Fuel used by the starting engine, before any modifications were made by the modeling system.  Available 
options are: G for gasoline, D for diesel, G+E85 for gasoline/E85 flex fuel vehicles, and D+B20 for diesel/B20 
flex fuel vehicles. 

Eng Type Initial text 
Brief information about the starting engine, before any modifications were made by the modeling system.  The 
field includes:  engine horsepower, displacement, configuration, number of cylinders, and aspiration. 



DRAFT 

77 

Eng Version text 
Revision of the engine used by a vehicle.  This field lists the engine version as "baseline", if the vehicle is using 
an original and unmodified engine.  Alternatively, this field shows the model year, signifying the revision of 
the intial engine that the vehicle has inherited. 

Eng Fuel text Fuel used by the engine in a specific model year. 

Eng Type text 
Brief information about the engine in a specific model year.  At present, only the aspiration of the engine is 
shown, since other attributes are assumed to remain unchanged. 

Trn Code integer Index of the transmission used by a vehicle. 

Trn Type Initial text 
Brief information about the starting transmission, before any modifications were made by the modeling system.  
This field includes:  transmission type (A=automatic, M=manual, CVT=continuously variable transmission, 
AMT=automated manual transmission, DCT=dual-clutch transmission) and number of gears (if applicable). 

Trn Version text 
Revision of the transmission used by a vehicle.  This field lists the transmission version as "baseline", if the 
vehicle is using an original and unmodified transmission.  Alternatively, this field shows the model year, 
signifying the revision of the intial transmission that the vehicle has inherited. 

Trn Type text 
Brief information about the transmission in a specific model year.  This field includes:  transmission type 
(A=automatic, M=manual, CVT=continuously variable transmission, AMT=automated manual transmission, 
DCT=dual-clutch transmission) and number of gears (if applicable). 

FE Initial (by 
Fuel Type1) 

mpg 
Vehicle's initial fuel economy rating when operating on a specific fuel type.  This represents the starting value 
as read from the input file. 

FE Initial mpg 

Vehicle's overall initial fuel economy rating, before any modifications were made by the modeling system.  For 
FFVs (gasoline/E85 and diesel/B20) and PHEVs (gasoline/electricity), the overall fuel economy rating may be 
harmonically averaged based on the share of each fuel type, according to the "Multi-Fuel" setting defined in the 
scenarios input file. 

FS Initial (by 
Fuel Type1) 

ratio 
Vehicle's initial fuel share, indicating the amount of miles driven by the vehicle on each fuel type.  This 
represents the starting value as read from the input file. 

Fuel Initial text All fuel types initially used by the vehicle, before any modifications were made by the modeling system. 

FE Rated (by 
Fuel Type1) 

mpg 
Vehicle's fuel economy rating when operating on a specific fuel type, in a specific model year, taking into 
account the effect of technology additions made by the modeling system.  This value does not include 
adjustment for improvements in air conditioning or off-cycle credits. 

FE Rated mpg 

Vehicle's overall fuel economy rating in a specific model year, taking into account the effect of technology 
additions made by the modeling system.  For FFVs (gasoline/E85 and diesel/B20) and PHEVs 
(gasoline/electricity), the overall fuel economy rating may be harmonically averaged based on the share of each 
fuel type, according to the "Multi-Fuel" setting defined in the scenarios input file.  This value does not include 
adjustment for improvements in air conditioning or off-cycle credits. 

FE Compliance 
(by Fuel Type1) 

mpg 
Vehicle's fuel economy rating when operating on a specific fuel type, in a specific model year, taking into 
account the effect of technology additions made by the modeling system, adjusted for improvements in air 
conditioning and off-cycle credits. 

FE Compliance mpg 

Vehicle's overall fuel economy rating in a specific model year, taking into account the effect of technology 
additions made by the modeling system, adjusted for improvements in air conditioning and off-cycle credits.  
For FFVs (gasoline/E85 and diesel/B20) and PHEVs (gasoline/electricity), the overall fuel economy rating may 
be harmonically averaged based on the share of each fuel type, according to the "Multi-Fuel" setting defined in 
the scenarios input file.  This value is used for compliance purposes. 

FS (by Fuel 
Type1) 

ratio 
Vehicle's fuel share, indicating the amount of miles driven by the vehicle on each fuel type in a specific model 
year. 

Fuel text All fuel types used by the vehicle in a specific model year. 

Veh Class text 
Vehicle's general classification (passenger vehicle:  LDV; light duty truck:  LDT1, LDT2a, LDT2b, LDT3; 
medium duty truck:  MDT4, MDT5, MDT6; heavy duty truck:  HDT7, HDT8).  Only the passenger vehicle 
and light duty truck classifications are supported by the modeling system. 

Reg Class text Vehicle's regulatory class (PassengerCar, LightTruck, or LightTruck2b3). 
Tech Class text Vehicle's technology class (used for technology selection and application). 

Safety Class text 
Vehicle's safety class (PC=Passenger Car, CM=CUV/Minivan, LT=Light Truck/SUV; used for safety 
calculations). 

Redesign State text Vehicle's redesign state, whether the vehicle is being redesigned in the current model year. 
Refresh State text Vehicle's refresh state, whether the vehicle is being refreshed in the current model year. 

Platform Leader text 

A flag indicating whether a vehicle serves as the leader of the engine (E), transmission (T), and/or platform (P) 
that it uses.  During modeling, engine, transmission, and platform technologies are first applied to a leader 
vehicle during the leaders redesign or refresh, and subsequently inherited on all other vehicles during their 
redesign/refresh years. 

Sales Initial units 
Vehicle's production volumes in a specific model year.  This represents the starting value as read from the input 
file. 

Sales units 
Vehicle's final production volumes in a specific model year.  If modeling options for sales mixing are used 
(such as the Dynamic Fleet Share Model), this value will differ from the initial production volumes; otherwise, 
this value will be the same the initial one. 

MSRP Initial dollars 
Vehicle's initial MSRP value in a specific model year.  This represents the starting value as read from the input 
file. 

MSRP dollars 
Vehicle's final MSRP value in a specific model year, including additional costs arising from technology 
application or fine payment. 

k.Labor Hours 
hours 
(k) 

Thousands of employment hours associated with the production of the vehicle models in a specific model year. 
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CW Initial lbs. Vehicle's initial curb weight.  This represents the starting value as read from the input file. 

CW lbs. 
Vehicle's final curb weight in a specific model year, taking into account any mass reduction technology applied 
by the modeling system. 

TW Initial lbs. Vehicle's initial test weight, before any modifications were made by the modeling system. 

TW lbs. 
Vehicle's final test weight in a specific model year, taking into account any mass reduction technology applied 
by the modeling system. 

GVWR Initial lbs. Vehicle's initial GVWR, before any modifications were made by the modeling system. 

GVWR lbs. 
Vehicle's final GVWR in a specific model year, taking into account any mass reduction technology applied by 
the modeling system. 

GCWR Initial lbs. Vehicle's initial GCWR, before any modifications were made by the modeling system. 

GCWR lbs. 
Vehicle's final GCWR in a specific model year, taking into account any mass reduction technology applied by 
the modeling system. 

Footprint sq.ft. 
Vehicle's initial footprint.  This represents the starting value as read from the input file.  The vehicle's footprint 
does not change during the analysis. 

Work Factor lbs. 
Vehicle's work factor in a specific model year.  This value is reported only for vehicles that are subject to the 
work-factor based functional standard. 

FE Target 
gallons 
per mile 

Vehicle's fuel economy target in a specific model year. 

CO2 Target 
grams 
per mile 

Vehicle's CO-2 target in a specific model year. 

CO2 Rating 
grams 
per mile 

Vehicle's CO-2 rating in a specific model year. 

Tech Cost dollars Unit costs accumulated by the vehicle model from technology application in a specific model year. 

Price Increase dollars 
Increase in vehicle price accumulated by the vehicle model from technology application and fine payment in a 
specific model year. 

Tax Credit dollars 
Amount of Federal tax credits a buyer receives for purchasing this vehicle.  Tax credits are specified for strong 
hybrid, plug-in hybrid, and electric vehicles, only when the applicable "Tax Credit" settings are defined in the 
scenarios input file. 

Value Loss dollars 
Loss in value to the consumer due to decreased range of pure electric vehicles.  This value does not apply if the 
vehicle is not an EV. 

Rel. Value Loss dollars 
Relative loss in value to the consumer due to due to decreased operating life of pure electric vehicles.  This 
value does not apply if the vehicle is not an EV. 

Maint Cost dollars 
Unit maintenance costs accumulated by the vehicle model from technology application in a specific model 
year. 

Repair Cost dollars Unit repair costs accumulated by the vehicle model from technology application in a specific model year. 
Taxes/Fees dollars Taxes & fees paid by the consumers for purchasing a new vehicle model in a specific model year. 
Financing dollars Financing costs paid by the consumers for purchasing a new vehicle model in a specific model year. 
Insurance dollars Insurance costs paid by the consumers for purchasing a new vehicle model in a specific model year. 
LUB1 

text 

The utilization of technologies on a vehicle model in a specific model year.  The following define the 
utilization codes used by the modeling system: 
  U = technology was initially in use on a base vehicle before modeling began 
  A = technology was applied to a vehicle by the modeling system 
  US = technology was in use on a base vehicle, but was later superseded when another technology was applied 
by the modeling system 
  AS = technology was applied to a vehicle by the modeling system, but was later superseded when another 
technology was applied 
  PA = technology has exceed its phase-in threshold in the current model year, however, it was still applied by 
the modeling system in order to satisfy backfilling constraints of another technology 
  P = technology has exceed its phase-in threshold in the current model year, and thus was not applied by the 
modeling system 
  X = technology is not available for application on a vehicle in the current model year 
  <blank> = technology is available for application on a vehicle in the current model year, but the modeling 
system has not yet applied it 

EFR1 
LUB2_EFR2 
CCPS 
DVVLS 
DEACS 
ICP 
DCP 
DVVLD 
CVVL 
DEACD 
SGDI 
DEACO 
VVA 
SGDIO 
TRBDS1 
SEGR 
DWNSP 
TRBDS2 
CEGR1 
CEGR2 
MILLER 
LGDI 
CNG 
LNG 
LPG 
DSL 
DTURB 
EFRD 
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DDOWN 
6MAN 

text (same as above) 

HETRANSM 
IATC 
NAUTO 
DCT 
8SPD 
HETRANS 
SHFTOPT 
EPS 

text (same as above) 

IACC1 
IACC2 
MHEV 
ISG 
SHEV1 
SHEV1_2 
SHEV2 
PHEV1 
PHEV2 
EV1 
EV2 
EV3 
EV4 
FCV 
MR1 

text (same as above) 

MR2 
MR3 
MR4 
MR5 
ROLL1 
ROLL2 
ROLL3 
LDB 
SAX 
AERO1 
AERO2 

 
In the above table, note that: 

(1) For each vehicle, fuel economies and fuel shares are reported independently for each of 
the following fuel types:  G for gasoline, E85, D for diesel, B20, E for electricity, H for 
hydrogen, CNG, LNG, and LPG.  If the vehicle does not use a specific fuel type, the 
associated fuel economy and fuel share values will be zero. 
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Appendix C Monte Carlo Analysis 
 
Probabilistic uncertainty analysis (for example, Monte-Carlo simulation) may be performed, 
such that all included scenarios are examined under varying technology costs and fuel 
consumption effects, pretax fuel prices, post-compliance payback periods, rebound effect, price 
shock costs, and vehicle on-road gaps.  Monte-Carlo analysis may be set up and run using 
directions provided in the CAFE Model Software Manual document.  While the modeling system 
could potentially be set up to analyze multiple alternative scenarios within a single run, given the 
resource restrictions associated with multiyear modeling, at present the system only supports one 
alternative scenario, along with a baseline scenario, per individual run.  Multiple modeling 
instances, however, may be set up to evaluate additional alternatives. 
 
The results of the analysis are located in the output folder selected during modeling.  During 
Monte-Carlo simulation, the CSV outputs that are typically produced with regular compliance 
modeling are omitted.  In their place, a unifying Monte-Carlo specific report is generated, 
summarizing the results of individual trials.  Multiple Monte-Carlo reports are created, one for 
each scenario analyzed, with the first scenario (Sn0) being the baseline to which all others are 
compared.  Additionally, plain text Monte-Carlo log files can be found under the “MC-logs” 
subdirectory.  The following outputs are produced at the end of the Monte-Carlo simulation: 

 MC_trials.csv:  Contains Monte-Carlo trials used as input to the analysis.  The contents 
of this file are summarized in Table 35 below. 

 MC_tech_costs.csv:  Specifies the sales-weighted average technology costs for each 
technology, adjusted by the randomized cost scales from the MC_trials.csv file. The 
average costs for a technology are computed across all model years and vehicle 
technology classes that were used during modeling as follows:  
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where SALESi represent the sales of vehicle i, COSTi,t is the base (unadjusted) cost of 
technology t as it applies to vehicle i, and SCALEt is the randomized value specifying the 
amount by which to scale the technology cost of technology t. 

 MC_tech_fcs.csv:  Specifies the sales-weighted average technology fuel consumption 
improvements for each technology, adjusted by the randomized fuel consumption scales 
from the MC_trials.csv file. The average fuel consumption improvements for a 
technology are computed across all model years and vehicle technology classes that were 
used during modeling as follows:  
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where SALESi represent the sales of vehicle i, FCi,t is the base (unadjusted) fuel 
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consumption improvement of technology t as it applies to vehicle i, and SCALEt is the 
randomized value specifying the amount by which to scale the technology fuel 
consumption improvement of technology t. 

 monte_carlo_report_sn*.csv:  Includes the results of pseudo-randomly generated Monte-
Carlo trials for all scenarios.  The report for the results of the baseline scenario (Sn0) 
provides the totals accrued during that scenario.  The report for the results of the non-
baseline scenario (Sn1) contains changes compared to the baseline.  The contents of the 
file are summarized in Table 36 below. 

 
C.1 Monte-Carlo Input Sampling 
 
In the past versions of the CAFE Model, the sampling of trials for Monte-Carlo analysis was 
performed internally by the modeling system.  Starting with the previous revision, the Monte-
Carlo trials are generated externally and are fed into the system in the form of an input file.  The 
“MC trials” file is provided as part of the current rulemaking analysis, and may be obtained to 
perform additional modeling by users.  Alternatively, users wishing to experiment with various 
distributions and sampling techniques may generate their own trials, provided the resulting input 
file is congruent with the original used for the analysis.  The sampling procedure employed for 
generating the Monte-Carlo trials is outlined Chapter 10 of the NHTSA Preliminary Regulatory 
Impact Analysis for the 2021–2027 CAFE standards. 
 
The CAFE model requires entries for each of the variables in Table 35 (below) for every trial, as 
well as the set of input files necessary to produce a normal run (i.e., those specifying technology 
and fleet inputs, economic assumptions, and regulatory scenarios).  For the “MC trials” file that 
was used in the final analysis of the 2017–2025 CAFE program, a number of different 
distributions and technology groupings were used to produce the set of trials. 
 

Table 35. Monte-Carlo Input Data 
Column Contents 
Index Unique index of the trial. 

FuelPriceScalar 
A randomized scalar used for adjusting the ratio of previous and present model year 
fuel prices. 

PaybackPeriod_OC 
Randomized value of the post-compliance payback period that manufacturers use 
with voluntary overcompliance. 

ReboundEffect Randomized value of the rebound effect. 
OnRoadGap_Gasoline Randomized value of the on-road gap for gasoline fuel. 
OnRoadGap_Diesel Randomized value of the on-road gap for diesel fuel. 

Cost_[Technology] 
Randomized value specifying the amount by which to scale the technology costs for 
each technology. 

FC_[Technology] 
Randomized value specifying the amount by which to scale the technology fuel 
consumption improvement for each technology. 

 
C.2 Monte-Carlo Output Data 
 
The modeling system produced two modeling reports as part of the Monte-Carlo analysis:  
monte_carlo_report_sn0.csv and monte_carlo_report_sn1.csv.  The former contains results of the 
baseline scenario (Sn0), which are specified as the totals accrued during analysis of the baseline, 
while the latter contains results of the alternative scenario (Sn1), which, for the most part, are 
presented as incremental changes over the baseline.  In both output files, results are provided for 
each trial, model year analyzed, and regulatory class (according to the regulatory classification of 
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vehicles), as well as aggregated across the entire industry (combining multiple regulatory 
classes) and all model years (providing a total cost of the program).  Some of the outputs 
reported do not apply to the baseline scenario.  In particular, since the “net benefits” is the direct 
result of improvements realized in the alternative scenario over the baseline scenario, this value 
would appear as “0” in the baseline’s output file. 
 
The following table lists the full contents of the Monte-Carlo Report. 
 

Table 36. Monte-Carlo Report 
Column Units Contents 
Trial integer Unique index of the trial. 
Model Year model year Model years analyzed during the study period. 

Reg-Class text 
The regulatory class for which the compliance results are 
reported. 

Standard mpg The value of the required CAFE standard. 
CAFE mpg The value of the achieved CAFE standard. 
Average CW lbs. Average curb weight of analyzed vehicles. 
Average WF lbs. Average work-factor of analyzed vehicles. 
Avg.Tech Costs dollars Average technology costs per single vehicle unit. 
Avg.Incr Costs dollars Average incremental technology costs per single vehicle unit. 
Avg.Payback years Average payback. 
Tech Costs dollars Incremental technology costs accrued by the industry (million-$). 

Disc Tech Costs dollars 
Incremental discounted technology costs accrued by the industry 
(million-$). 

Fines dollars Incremental fines owed by the industry (million-$). 

Total Tech Costs dollars 
Incremental compliance costs accrued by the industry including:  
discounted technology costs, maintenance costs, repair costs, loss 
of value, and relative loss of value (million-$). 

VMT miles 
Incremental billions of miles traveled by all vehicles over their 
lifetime for a specific model year and regulatory class. 

Fuel Consumption gallons 
Incremental billions of gallons of fuel consumed by all vehicles 
over their lifetime for a specific model year and regulatory class. 

CO2 Emissions million metric-tons 

Amount of incremental Carbon Dioxide emissions generated from 
domestic crude petroleum extraction, transportation, and refining, 
from gasoline transportation, storage, and distribution, and from 
vehicle operation, aggregated over the lifetime of all vehicles for a 
specific model year and regulatory class. 

Fatalities units 

Incremental fatalities resulting from reduction in vehicle curb 
weight and increases in VMT due to the rebound effect, 
aggregated over the lifetime of all vehicles for a specific model 
year and regulatory class. 

Pre-Tax Fuel Costs dollars 
Incremental pre-tax fuel expenditures accumulated across all 
vehicles over their lifetime for a specific model year and 
regulatory class (million-$). 

Social Costs dollars 

Incremental social costs accumulated by the industry for a specific 
model year and regulatory class including:  pre-tax fuel costs, 
drive surplus, refueling surplus, market externalities, congestion 
costs, accident costs, noise costs, fatality costs, and emissions 
damage costs (million-$). 

Net Benefits dollars 
Net benefits for a specific model year and regulatory class 
(million-$).  Net benefits are computed as:  -Social_Costs - 
Total_Tech_Costs 

Tech Use LGDI number The penetration rate of the technology, specified as a proportion 
of total sales.  The penetration rates represent the amount of 
technology that was either on the baseline vehicle at the start of 
the analysis, or applied by the modeling system during analysis.  
If a technology was present on or applied to a vehicle, but later 
superseded during the modeling process by another technology 
(for example, DCP superseding ICP), the superseded technology 
on that vehicle will not count toward the penetration rate. 

Tech Use ISG number 

Tech Use SHEV number 

Tech Use ROLL1 number 

Tech Use MR2 number 
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Appendix D CAFE Model Software Manual 
 
D.1 Warnings 
 
This software was developed for analysis by U.S. Department of Transportation staff of potential 
fuel economy requirements. 
 
This software uses input files containing detailed information regarding vehicles manufactured 
for sale in the United States and creates output files containing similarly detailed information 
regarding such vehicles.  If input files containing information in any way (e.g., based on 
entitlement under 5 U.S.C 552 to confidential treatment) protected from disclosure to the public 
are used, some output files created by this software must also be protected from disclosure to the 
public. 
 
D.2 Notice 
 
The CAFE Model software is a U.S. government work not subject to copyright pursuant to 17 
USC 105; however, some of the third-party works used by the software are subject to usage 
agreements, as described below. 
 
The button controls in the application toolbar of the CAFE Model use images from the Glaze 
Icon Set (version 0.4.6, released on 3/06/2006) obtained from http://www.notmart.org.  All icons 
and/or images within the Glaze Icon Set are distributed under the GNU Lesser General Public 
License (LGPL), version 2.1.  The version 2.1 of the GNU LGPL may be obtained from 
http://www.gnu.org/licenses/old-licenses/lgpl-2.1.html. 
 
If users of the CAFE model have any questions about this notice, please contact the current 
administrators of the CAFE Model project. 
 
D.3 Installation and System Requirements 
 
The CAFE Model runs on IBM-compatible computers using the Microsoft® Windows operating 
system.  Although the software does not have strict hardware requirements, beyond what is 
needed to run the operating system, a 1 GHz or faster Intel compatible processor, with at least 2 
GB of physical memory (RAM) is strongly recommended.  The software has been developed and 
tested on computers using Windows XP/7 and Windows Server 2003/2008, but may operate 
properly on machines using older versions of Windows (e.g., Windows 2000), or newer versions 
(e.g., Windows 8), as long as a compatible Microsoft® .NET Framework is installed. 
 
The CAFE Model software uses Microsoft® Excel to read input files needed for modeling.  As 
such, Excel must be installed on the system.  The software also uses the Microsoft® .NET 
Framework, version 3.5.  If the Framework is not already present, it must be installed.  
Instructions for downloading and installing the .NET framework are available on the Internet at 
http://www.microsoft.com/download/en/details.aspx?id=22. 
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Based on the characteristics of machines used in the development of this software, the following 
table provides a summary of system requirements: 
 

Table 37.  CAFE Model System Requirements 
Intel compatible processor (1 GHz or faster recommended) 
1 GB RAM (2 GB recommended) 
10 MB hard drive space for installation 
(additional disk space will be required during runtime) 
Microsoft® Windows XP/Vista/7/8 
Microsoft® Windows Server 2003/2008 
Microsoft® .NET Framework 3.5 
Microsoft® Excel 2010 or later 

 
Once the system requirements have been met, the latest version of the CAFE Model may be 
obtained by contacting NHTSA or Volpe Center staff. 
 
The current version of the software is packaged as a stand-alone executable and does not require 
installation.  To operate the model, place the “CAFE Model.exe” file on the desktop and execute 
it39. 
 
D.4 CAFE Model Graphical User Interface 
 
The CAFE Model Graphical User Interface (GUI) provides users with a set of tools necessary to 
set up and run multiple modeling test scenarios, which are commonly referred to as CAFE Model 
sessions.  Each CAFE Model session can be configured independently, each with its own set of 
model inputs and settings.  Once configured, the session may be saved for future runs, or 
executed immediately.40  When the model runs, the system displays the progress of the 
compliance modeling process in each session’s window. 
 
The model GUI consists of two primary screens:  the main CAFE Model window and the 
Modeling Settings window.  The CAFE Model window is used for managing the modeling 
sessions, while the Modeling Settings window is used to configure them. 
 
To run the modeling system, click on the CAFE Model executable file located on the desktop.  
When the application launches, a Warnings dialog box is displayed (Figure 7).  The user must 
read and understand the warnings listed prior to using the modeling system. 
 

                                                 
39 The CAFE Model files provided may be in a zip archive, which will need to be extracted using a zip utility such 
as WinZip (www.winzip.com) or 7Zip (www.7-zip.org). 
40 It is recommended that users save the sessions prior to running them in order to assign a meaningful title to each 
session. 
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Figure 7. Warnings Dialog Box 

 
After clicking the OK button in the Warnings dialog box, the main CAFE Model window, 
described below, opens. 
 
D.4.1 CAFE Model Window 
 
The main CAFE Model window (Figure 8) is used to create, configure, and manage CAFE 
modeling sessions.  The main window also controls the model operation, allowing users to start 
and stop modeling simulation. 
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Figure 8. CAFE Model Window 

 
When the model first starts up, most of the menu items and toolbar icons are disabled, until a 
new session is created, or an existing one is opened. 
 
The model GUI is operated using a simple, easy to use file-menu (Figure 9), with most 
commonly used shortcuts also available on the model toolbar (Figure 10).  For user convenience, 
most of the menu entries may also be controlled using keyboard shortcuts. 
 

 
Figure 9. CAFE Model File Menu 
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Figure 10. CAFE Model Toolbar 

 
Some of the most commonly used file menus are: 

 File > New Session:  Creates a new CAFE Model Session and displays the Modeling 
Settings window to the user. 

 File > Open Session:  Opens an existing CAFE Model Session. 

 File > Close Session:  Closes the active CAFE Model Session. 

 File > Save Session:  Saves the active CAFE Model Session. 

 File > Start Modeling:  Begins the modeling process for the active CAFE Model Session. 

 File > Stop Modeling:  Suspends the modeling process of the active CAFE Model 
Session. 

 File > Exit:  Exits the CAFE Model.  If any of the modeling sessions are still opened, 
they will be closed prior to exiting the model. 

 View > Modeling Settings:  Displays the Modeling Settings window, where all modeling 
options and settings may be configured. 

 View > Output Location:  Opens the Windows Explorer and browses to the location 
where the output files and reports of the active session are saved. 

 
D.4.2 Modeling Settings Window 
 
The Modeling Settings window contains multiple panels for configuring all of the runtime 
options available to the model.  The user can operate this window to set up a new session, or 
modifying an existing one, before starting the modeling process.  Each of the available 
configuration panels is outlined in the sections below. 
 
D.4.2.1 General Compliance Settings Panel 
 
The General Compliance Settings panel (Figure 11) is used to specify what type of modeling 
the user would like to run.  Each model is tailored to different type of analysis, using its own set 
of assumptions and configuration settings.  Presently, two model types are available: 

 Standard Compliance Model:  The Standard Compliance Model is the default mode of 
operation for the CAFE modeling system.  This model type is used to evaluate 
technology costs and benefits in response to the required CAFE standards defined in the 
modeling scenarios. 
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 Monte-Carlo Model:  The Monte-Carlo Model is a specialized CAFE modeling type, 
which is used for running customized Monte-Carlo simulations necessary for uncertainty 
analysis. 

 

 
Figure 11. General Compliance Settings Panel 

 
D.4.2.2 Input Settings Panel 
 
On the Input Settings panel (Figure 12), the user can select the input data files for use with the 
modeling system. 
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Figure 12. Input Settings Panel (1) 

 
When selecting input files, the model will attempt to verify if an appropriate file was used.  If 
incorrect file path is entered, an error message will be displayed (Figure 13). 
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Figure 13. Input Settings Panel (2) 

 
D.4.2.3 Output Settings Panel 
 
The Output Settings panel (Figure 14) is used to configure the location where modeling results 
will be saved. 
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Figure 14. Output Settings Panel 

 
The modeling system automatically generates the following eight output files (in CSV format) 
during runtime: 

 Technology Utilization Report:  Provides manufacturer-level and industry-wide 
technology application and penetration rates for each technology, model year, and 
scenario analyzed.  The results are disaggregated by regulatory class, as well as combined 
over the entire fleet. 

 Compliance Report:  Provides manufacturer-level and industry-wide summary of 
compliance model results for each model year and scenario analyzed.  The results are 
disaggregated by regulatory class, as well as combined over the entire fleet. 

 Societal Effects Report:  Provides industry-wide summary of energy and emissions 
effects for each model year and scenario analyzed.  The model produces two versions of 
this output file, where the results are disaggregated by either the vehicle class and fuel 
type or the regulatory class and fuel type, as well as combined across all fuels and over 
the entire fleet. 

 Societal Costs Report:  Provides industry-wide summary of consumer and social costs for 
each model year and scenario analyzed.  The model produces two versions of this output 
file, where the results are disaggregated by either the vehicle class and fuel type or the 
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regulatory class and fuel type, as well as combined across all fuels and over the entire 
fleet. 

 Annual Societal Effects Report:  This output file is similar to the Societal Effects Report, 
except it further disaggregates the results by calendar year. 

 Annual Societal Costs Report:  This output file is similar to the Societal Costs Report, 
except it further disaggregates the results by calendar year. 

 Vehicles Report:  Provides a detailed view of the final state of each vehicle examined by 
the model, for each model year and scenario analyzed. 

 
D.4.2.4 Runtime Settings Panel 
 
The Runtime Settings panel (Figure 15) provides additional modeling options to further 
customize the model behavior, beyond what is available in the input files: 

 Fuel Price Estimates:  Specifies whether to use the low, average, or high fuel price 
estimates from the parameters input file.  By default, average fuel price estimates are 
used. 

 CO2 Price Estimates:  Specifies whether to use low, average, high, or very-high carbon 
dioxide cost estimates from the parameters input file.  By default, average CO2 price 
estimates are used. 

 Scale Consumer Benefits:  Specifies whether the model should scale the private 
consumer benefits by a specific percentage during the effects calculations.  Valid values 
are between 0 and 100. 

 Perform Fleet Analysis Calculations:  Specifies whether the model should perform fleet 
analysis calculations, evaluating modeling effects for historic and forecast model years 
(before the first compliance model year as well as after the last compliance model year). 
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Figure 15. Runtime Settings Panel 

 
D.5 CAFE Model Usage Examples 
 
This section provides examples for configuring and running the CAFE Model sessions using 
various model types. 
 
D.5.1 Example 1 – Configuring for Standard Compliance Modeling 
 
This example demonstrates the steps necessary for configuring the modeling system to perform a 
regular Compliance Model run. 

 Run the CAFE Model by clicking on the CAFE Model executable located on the 
desktop.  Read through the Warnings dialog box, and then click the OK button. 

 Select File > New Session to create a new modeling session.  The Modeling Settings 
window appears.  Note the errors at the bottom of the window; these indicate that the 
input files have not been selected. 

 On the General Compliance Settings panel, select the Standard Compliance Model as 
shown in Figure 16 below. 
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Figure 16. Select Standard Compliance Model 

 Click on the Input Settings panel to select the input files to use for modeling (Figure 17).  
Note that once all the input files have been selected appropriately, the error messages 
disappear. 
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Figure 17. Select Input Files 

 On the Output Settings panel, select the location for output files (Figure 18). 
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Figure 18. Select Output Location 

 The Runtime Settings panel is not used for this exercise. 

 Click the Save button to save the modeling settings and load the input files (Figure 19). 
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Figure 19. Save Modeling Settings 

 Once loading completes, click the Close button to return the main CAFE Model 
window.  A new Compliance Model session, titled “Session 1” has now been created 
(Figure 20). 
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Figure 20. New Compliance Model Session Created 

 Save the new session by selecting File > Save Session As....  Enter “demo.cmsd” in the 
dialog box that appears, and click the Save button (Figure 21). 
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Figure 21. Save New Session 

 After the session has been saved, notice the title of the session has changed to “demo” 
(Figure 22). 
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Figure 22. “demo” Session Saved 

 Select File > Start Modeling to start the compliance modeling process.  As the model 
runs, the progress of the Compliance Model is displayed in the session window (Figure 
23). 
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Figure 23. Modeling Progress from the Compliance Model 

 After modeling has completed, the “Modeling Completed!” message appears at the 
bottom of the main CAFE Model window (Figure 24). 
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Figure 24. Compliance Model Completed 

 Select View > Output Location to open Windows Explorer and browse to the location 
where model outputs for the “demo” session are saved. 

 Exit the session by selecting File > Close Session. 

 Exit the CAFE Model by selecting File > Exit, or proceed to the next example. 
 
D.5.2 Example 2 – Configuring for Monte-Carlo Modeling 
 
This example demonstrates how to take an existing session created in Example 1 – Configuring 
for Standard Compliance Modeling, and modify it to run the Monte-Carlo Model. 

 Run the CAFE Model by clicking on the CAFE Model executable located on the 
desktop.  Read through the Warnings dialog box, and then click the OK button. 

 Select File > Open Session to open an existing modeling session.  Select “demo.cmsd” 
in the dialog box that appears, and click the Open button (Figure 25). 
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Figure 25. Open “demo” Session 

 Once the session has been loaded, select View > Modeling Settings to bring up the 
Modeling Settings window.  There select the Monte-Carlo Model as in Figure 26. 
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Figure 26. Select Monte-Carlo Model 

 Under the Input Settings panel, select a Monte-Carlo trials file (Figure 27). 
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Figure 27. Select Monte-Carlo Trials File 

 The Output Settings and Runtime Settings panels are not used for this exercise. 

 Click the Save button to save the updated modeling settings; then click Close, once 
saving completes. 

 To prevent overwriting results from the “demo” session, select File > Save Session As... 
to save the modified session with a new name.  For this example, the Monte-Carlo 
session was saved as “demo-mc.cmsd”. 

 Select File > Start Modeling to start the Monte-Carlo modeling process.  As the model 
runs, the progress of the Monte-Carlo Model is displayed in the session window (Figure 
28). 
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Figure 28. Modeling Progress from the Monte-Carlo Model 

 After Monte-Carlo modeling has completed, the “Modeling Completed!” message 
appears at the bottom of the main CAFE Model window.  Select File > Exit to exit the 
model. 
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